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Notices

BioTek Instruments, Inc.

Highland Park, P.O. Box 998

Winooski, Vermont  05404-0998  USA

All Rights Reserved

© 2012, BioTek® Instruments, Incorporated.  No part of this publication may be 
reproduced, transcribed, or transmitted in any form, or by any means electronic 
or mechanical, including photocopying and recording, for any purpose other 
than the purchaser’s use without written permission of BioTek Instruments, Inc.

Trademarks

BioTek® is a registered trademark and EL406™ Microplate Washer Dispenser is 
a trademark of BioTek Instruments, Inc. 

Microsoft®, Internet Explorer®, Windows®, Windows 7, Windows Vista®,  
Windows XP, and Excel® are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries. 

All other trademarks are the property of their respective holders.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a 
commitment by BioTek Instruments, Inc. Changes made to the information in 
this document will be incorporated in new editions of the publication.  No 
responsibility is assumed by BioTek for the use or reliability of software or 
equipment that is not supplied by BioTek or its affiliated dealers.
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Contact Information

BioTek Instruments, Inc.
Highland Park, P.O. Box 998

Winooski, Vermont  05404-0998  USA

Customer Service and Sales

Internet: www.biotek.com

Phone: 888-451-5171 (toll free in the U.S.)

802-655-4740 (outside the U.S.)

Fax: 802-655-7941

E-Mail: customercare@biotek.com

Service/TAC

Phone: 800-242-4685 (toll free in the U.S.)

802-655-4740 (outside the U.S.)

Fax: 802-654-0638

E-Mail: tac@biotek.com

European Coordination Center/Authorized European Representative 

BioTek Instruments GmbH

Kocherwaldstrasse 34

D-74177 Bad Friedrichshall

Germany

Internet: www.biotek.de

Phone: +49 (0) 7136 9680

Fax: +49 (0) 7136 968 111

E-Mail: info@biotek.de
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Document Conventions

This manual uses the following typographic conventions:

 n This note format calls attention to important information.

Warnings are presented in this style to call attention to potential hazards and other 
safety concerns.

 

This icon calls attention to important safety information.

 Tips and suggestions for improving performance are formatted this way.

 n Water: Daily maintenance is the key to keeping the liquid handler performing 
to specifications. In the maintenance procedures provided in this manual, the 
requirement to use distilled (dH2O) or deionized (DI) water can be met by 
numerous water purification methods, including MilliQ™. A minimum water 
purity of 2mOhm is expected.

Revision History

Rev Date Changes

A 10/2008 First Issue

B 4/2009 Full keypad control was added to EL406 and documented in this manual. 
Chapter 3, Operations includes complete instructions for operating the 
instrument using the keypad.

  1536-well plate processing capability is available with required hardware. 
Operating instructions and physical descriptions were updated where 
applicable throughout the manual.

  New 1536-well hardware includes 128-tube aspirate manifold and two 32-
tube Syringe dispenser manifolds. Installation instructions, Specifications, 
operation and maintenance sections were updated accordingly.

  AutoPrime functionality was changed:

EL406™ Microplate Washer Dispenser
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Rev Date Changes

• Submerge tips, also known as soaking, capability was added;
• First-use control to trigger function was removed. AutoPrime, when 
enabled, always runs regardless of whether the device has been used since 
startup.

C 5/2010 Added content where applicable throughout the manual to support new 
hardware options: single 96-tube wash manifold, and dual 8-tube Syringe 
dispenser manifold.

  Noted the absence of some features on certain models where applicable, 
i.e. the Peri-pump, Buffer Switching, and Ultrasonic Advantage are no 
longer standard on all models.

  Added description of new keypad feature to manually control the vacuum 
pump: Shift+1/2 in the Quick menus.

  Maintenance: Removed warning about predefined maintenance protocols 
for those using the BioStack under keypad control. The EL406 no longer 
delivers plates during prime routines and maintenance protocols.

D 10/2010 Content throughout this manual was changed, where applicable, to 
correspond to the new basecode, PN 7180207. This manual no longer 
supports previously released instruments with basecode PN 7180200. 
Changes include the keypad main menu and other menus.

  Added content where applicable to describe two new accessory kits, 
Vacuum Filtration and Syringe Dispenser Buffer Switching

  Where applicable, content about the LHC was revised to describe new 
behavior and procedures for LHC 2.

E 9/2012 Added support for 0.5 µL dispensing. Added more precise instructions for 
handling 1536-well flanged plates (153F). Added warning about the effects 
of exposing silicone tubing to DMSO and Acetonitrile to the chemical 
compatibility table. Revised the Syringe dispenser performance 
specifications to correct for minor mismatches with BioTek's published 
specifications. Defined the water purity expectations for maintenance 
procedures and changed all references to "DI water" to "deionized or 
distilled water." Updated IVD notice.

Intended Use Statement

 l The EL406™ Microplate Washer Dispenser provides microplate priming, washing,  and 
dispensing for ELISA™, fluorescence and chemiluminescence immunoassays, cellular 
and agglutination assays.

BioTek Instruments, Inc.
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 l The EL406™ Microplate Washer Dispenser can operate as a stand-alone instrument or 
with standard robotic systems, such as BioTek’s BioStack™ Microplate Stacker.  

 l If the instrument has an "IVD" label it may be used for clinical and non-clinical purposes, 
including research and development. If there is no such label the instrument may only be 
used for research and development and non-clinical purposes.

Quality Control

It is considered good laboratory practice to run laboratory samples according to 
instructions and specific recommendations included in the assay package insert for 
the test to be conducted. Failure to conduct Quality Control checks could result in 
erroneous test data.

Warranty and Product Registration

Please take a moment to review the Warranty information that shipped with your 
product. Please also register your product with BioTek to ensure that you receive 
important information and updates about the product(s) you have purchased. 

You can register online through BioTek’s Customer Resource Center (CRC) at 
www.biotek.com or by calling 888/451-5171 or 802/655-4740.

Repackaging and Shipping

If you need to ship the instrument to BioTek for service or repair, contact BioTek 
for a Return Materials Authorization (RMA) number and use the original packing 
materials. Other forms of commercially available packaging are not recommended 
and can void the warranty. If the original packing materials have been damaged or 
lost, contact BioTek for replacement packing.

Warnings

Use the instrument on a level, stable surface away from excessive humidity.
When operated in a safe environment, according to the instructions in this 
manual, there are no known hazards associated with the EL406. However, the 
operator should be aware of certain situations that could result in serious 
injury:  Do not reach into the instrument during operation, as the washer 
manifold or peristaltic pump (Peri-pump) pump barrel may pinch your fingers. 
Do not reach for the microplate carrier until it is in its home position.

 Strict adherence to instrument maintenance and qualification procedures is 
required to ensure accurate dispense volumes and risk-free operation. 

EL406™ Microplate Washer Dispenser
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Hazards and Precautions

Hazards

The following hazards are provided to help avoid injury:

 
Warning! Power Rating. The instrument’s power supply or power cord must 
be connected to a power receptacle that provides voltage and current within the 
specified rating for the system. Use of an incompatible power receptacle may 
produce electrical shock and fire hazards.

  Warning! Electrical Grounding. Never use a two-prong plug adapter to 
connect primary power to the external power supply. Use of a two-prong 
adapter disconnects the utility ground, creating a severe shock hazard. Always 
connect the power cord directly to an appropriate receptacle with a functional 
ground.

  Warning! Internal Voltage. Always turn off the power switch and unplug the 
power supply before cleaning the outer surface of the instrument  or removing 
its top case.

  Warning! Liquids. Avoid spilling liquids on the instrument; fluid seepage into 
internal components creates a potential for shock hazard or instrument 
damage. If a spill occurs while a program is running, abort the program and 
turn the instrument off. Wipe up all spills immediately. Do not operate the 
instrument if internal components have been exposed to fluid.

Warning! Potential Biohazards. Some assays or specimens may pose a 
biohazard. Adequate safety precautions should be taken as outlined in the 
assay’s package insert. This hazard is noted by the symbol shown here. Always 
wear safety glasses and appropriate protective equipment, such as chemically 
resistant rubber gloves and apron. 

  Warning! Unspecified Use. Failure to operate this equipment according to 
the guidelines and safeguards specified in this manual could result in a 
hazardous condition.

  Warning! Ultrasonic Energy. Ultrasonic energy is present in the ultrasonic 
cleaner reservoir (if equipped) when AUTOCLEAN programs are running. Avoid 
putting your fingers in the bath. Ultrasonic energy can be destructive to human 
tissue.

Warning! Pinch Hazard. Some areas of the instrument or its components can 
present pinch hazards when the instrument is operating. These areas are 
marked with the symbol shown here. Keep hands/fingers clear of these areas 
when the instrument is operating.

  Warning! Software Quality Control. The operator must follow the 
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manufacturer’s assay package insert when modifying software parameters and 
establishing reading, washing, or dispensing methods. Failure to conduct 
quality control checks could result in erroneous test data.

  Warning! Service. Only qualified technical personnel should perform service 
procedures on internal components.

  Warning! Accessories. Only accessories which meet the manufacturer’s 
specifications shall be used with the instrument.

Precautions

The following precautions are provided to help avoid damage to the instrument:

Caution: Service. The instrument should be serviced by BioTek authorized 
service personnel. Only qualified technical personnel should perform 
troubleshooting and service procedures on internal components.

  Caution: Environmental Conditions. Do not expose the instrument to 
temperature extremes. For proper operation, ambient temperatures should 
remain within the range listed in the Specifications section. Performance may 
be adversely affected if temperatures fluctuate above or below this range. 
Storage temperature limits are broader.

  Caution: Sodium Hypochlorite. Do not expose any part of the instrument to 
the recommended diluted sodium hypochlorite solution (bleach) for more than 
20 minutes. Prolonged contact may damage the instrument surfaces. Be certain 
to rinse and thoroughly wipe all surfaces. 

  Caution: Buffer Solution. Although many precautions have been taken to 
ensure that the instrument is as corrosion-proof as possible, the instrument is 
not sealed and liquids can seep into sensitive components. Make sure that any 
spilled buffer solution is wiped off the instrument. Prolonged exposure to salt 
solution may corrode parts of the microplate carrier, movement rail, springs, 
and other hardware.

  Caution: Chemical Compatibility. Some chemicals may cause irreparable 
damage to the instrument. The following chemicals have been deemed safe for 
use in the instrument: buffer solutions (such as PBS), saline, surfactants, 
deionized water, 70% ethyl, isopropyl, or methyl alcohol, 40% formaldehyde, 
and 20% sodium hydroxide. Never use acetic acid, DMSO, or other organic 
solvents. These chemicals may cause severe damage to the instrument. 
Contact BioTek  prior to using other questionable chemicals.

  Caution: Bovine Serum Albumin. Solutions containing proteins, such as 
bovine serum albumin (BSA), will compromise the instrument’s performance 
over time unless a strict maintenance protocol is adhered to. See 
Maintenance procedures regarding BSA.

  Caution: External Power Supply. Only use the power supply shipped with 
the instrument. Operate this power supply within the range of line voltages 
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listed on it.

  Caution: Disposal. This instrument contains printed circuit boards and wiring 
with lead solder. Dispose of the instrument according to Directive 2002/96/EC, 
“on waste electrical and electronic equipment (WEEE),” or local ordinances.

  Caution: Warranty. Failure to follow preventive maintenance protocols may 
void the warranty.

  Caution: Shipping Hardware. All shipping hardware (e.g., shipping bracket 
etc.) must be removed before operating the instrument and reinstalled before 
repackaging the instrument for shipment.

  Caution: High Flow Pump Installation. DO NOT plug the High Flow vacuum 
pump cable into a wall outlet!  Use the adapter provided with the pump to 
connect the pump to the accessory outlet on the back of the washer. See the 
Installation instructions. 

  Caution: Waste Sensor Port on EL406.  (For customers who have 
purchased the BioStack Microplate Stacker.) Although the waste sensor port on 
the back of the EL406 is the same type as the 24-VDC power connector on the 
back of the BioStack, if an external 24-VDC power supply is plugged into the 
EL406’s port, it will permanently damage internal components.

  Caution: Do not run the Peri-pump without a cassette installed on the pump.

Caution: Electromagnetic Environment.  Per IEC 61326-2-6 it is the user’s 
responsibility to ensure that a compatible electromagnetic environment for this 
instrument is provided and maintained in order that the device will perform as 
intended.

  Caution: Electromagnetic Compatibility. Do not use this device in close 
proximity to sources of strong electromagnetic radiation (e.g., unshielded 
intentional RF sources), because these may interfere with the proper operation.

 Caution: Spare Parts. Only approved spare parts should be used for 
maintenance. The use of unapproved spare parts and accessories may result in 
a loss of warranty and potentially impair instrument performance or cause 
damage to the instrument.

CE Mark

Based on the testing described below and information contained 
herein, this instrument bears the CE mark.

 n Note: See the Declaration of Conformity for specific information.

BioTek Instruments, Inc.
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Directive 2004/108/EC: Electromagnetic Compatibility

Emissions—Class A

The system has been type-tested by an independent, accredited testing 
laboratory and found to meet the requirements of EN 61326-1: Class A for 
Radiated Emissions and Line Conducted Emissions. 

Verification of compliance was conducted to the limits and methods of EN 55011 
(CISPR 11) Class A. In a domestic environment it may cause radio interference, 
in which case, you may need to mitigate the interference.

Immunity

The system has been type-tested by an independent, accredited testing 
laboratory and found to meet the requirements of EN 61326-1 and EN 61326-2-6 
for Immunity. Verification of compliance was conducted to the limits and 
methods of the following:

EN 61000-4-2, Electrostatic Discharge

EN 61000-4-3, Radiated EM Fields

EN 61000-4-4, Electrical Fast Transient/Burst

EN 61000-4-5, Surge Immunity

EN 61000-4-6, Conducted Disturbances from RFI

EN 61000-4-8 Power Frequency Magnetic Field Immunity Test

EN 61000-4-11, Voltage Dips, Short Interruptions and Variations

Directive 2006/95/EC Low Voltage (Safety)

The system has been type-tested by an independent testing laboratory and was 
found to meet the requirements of this Directive. Verification of compliance was 
conducted to the limits and methods of the following:

EN 61010-1,  “Safety requirement for electrical equipment for measurement, 
control and laboratory use. Part 1, General requirements.”

Directive 2002/96/EC: Waste Electrical and Electronic Equipment

Disposal Notice: This instrument contains printed circuit boards and wiring with 
lead solder. Dispose of the instrument according to Directive 2002/96/EC, “on 
waste electrical and electronic equipment (WEEE)” or local ordinances.

EL406™ Microplate Washer Dispenser
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Directive 2002/95/EC: Reduction of Hazardous Substances (RoHS)

This instrument is exempt from RoHS requirement per Article 2, Category 8.

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use)

 l Product registration with competent authorities.
 l Traceability to the U.S. National Institute of Standards and Technology (NIST).

EN 61010-2-101 Particular requirements for in vitro diagnostic (IVD) medical 
equipment.

Electromagnetic Interference and Susceptibility

USA FCC CLASS A

RADIO AND TELEVISION INTERFERENCE

NOTE: This equipment has been tested and found to comply with the limits 
for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference, in which case the user 
will be required to correct the interference at their own expense.

In order to maintain compliance with FCC regulations shielded cables must be 
used with this equipment. Operation with non-approved equipment or 
unshielded cables is likely to result in interference to radio and television 
reception.

Canadian Department of Communications Class A

This digital apparatus does not exceed Class A limits for radio emissions from 
digital apparatus set out in the Radio Interference Regulations of the Canadian 
Department of Communications.

Le present appareil numerique n'émet pas de bruits radioelectriques depassant 
les limites applicables aux appareils numerique de la Class A prescrites dans 
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le Reglement sur le brouillage radioelectrique edicte par le ministere des 
Communications du Canada.

User Safety

This device has been type-tested by an independent laboratory and found to meet 
the requirements of the following:

 l Underwriters Laboratories UL 61010-1 “Safety requirements for electrical 
equipment for measurement, control and laboratory use; Part 1: general 
requirements.”             

 l Canadian Standards Association CAN/CSA C22.2 No. 61010-1 “Safety 
requirements for electrical equipment for measurement, control and 
laboratory use; Part 1: general requirements.”

 l EN 61010 Standards, see CE Mark on page xv.

EL406™ Microplate Washer Dispenser
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Safety Symbols

Some of these symbols appear on the instrument or accessories:

Alternating current
Courant alternatif
Wechselstrom
Corrientealterna
Correntealternata

Both direct and alternating current
Courant continu et courant alternatif
Gleich - und Wechselstrom
Corriente continua y corrientealterna
Corrente continua e 
correntealternata

Direct current
Courant continu
Gleichstrom
Corriente continua
Corrente continua

Earth ground terminal
Borne de terre
Erde (Betriebserde)
Borne de tierra
Terra (difunzionamento)

On (Supply)
Marche (alimentation)
Ein (VerbindungmitdemNetz)
Conectado
Chiuso

Protective conductor terminal
Borne de terre de protection
Schutzleiteranschluss
Borne de tierra de protección
Terra diprotezione

Off (Supply)
Arrêt (alimentation)
Aus (TrennungvomNetz)
Desconectado
Aperto 
(scon-
nessionedallaretedialimentazione)

Caution (refer to accompanying 
documents)
Attention (voir documents 
d’accompanement)
AchtungsieheBegleitpapiere
Atención (vease los 
documentosincluidos)
Attenzione, consultare la doc annessa

Warning, risk of electric shock
Attention, risque de choc électrique
Gefährlicheelektrischeschlag
Precaución, riesgo de 
sacudidaeléctrica
Attenzione, rischiodiscossaelettrica

 

Warning, risk of crushing or pinching
Attention, risqued’écrasement et 
pincement
Warnen, Gefahr des Zerquetschens 
und Klemmen
Precaución, riesgo del 
machacamiento y sejeción
Attenzione, 
rischiodischiacciareedintrappolarsi

Warning, hot surface
Attention, surface chaude
Warnen, heißeOberfläche
Precaución, superficiecaliente
Attenzione, superficiecalda

Warning, potential biohazards
Attention, 
risquesbiologiquespotentiels
Warnung! 
MoeglichebiologischeGiftstoffe
Atención, riesgosbiológicos
Attenzione, rischiobiologico

In vitro diagnostic medical device
Dispositif médical de diagnostic in 
vitro 
Medizinisches In-Vitro-Diagnostikum
Dispositivo médico de diagnóstico in 

Separate collection for electrical and 
electronic equipment 
Les équipements électriques et 
électroniques font l’objet d’une 
collecte sélective
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vitro
Dispositivo medico diagnostico in 
vitro

Getrennte Sammlung von Elektro- 
und Elektronikgeräten
Recogida selectiva de aparatos 
eléctricos y electrónicos 
Raccolta separata delle 
apparecchiature elettriche ed 
elettroniche

Consult instructions for use
Consulter la notice d’emploi
Gebrauchsanweisung beachten
Consultar las instrucciones de uso
Consultare le istruzioni per uso
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Introducing the EL406™ Washer Dispenser

The EL406 offers up to three devices in one instrument: a microplate Washer, a 
peristaltic pump dispenser called the Peri-pump, and a dual Syringe pump 
dispenser. One or both dispensers are provided with every EL406.

 Device/Component Description

1 Washer manifold 96- or 192-tube devices aspirate and dispense fluid; or 128-
tube manifold aspirates fluid from 1536-well plates.

2 Peri-pump Dispenser Peristaltic, 8-channel dispenser with entirely visible fluid 
path.

3 (Optional) Syringe 
Dispenser

Two distinct syringe-pump dispensers, each with an 8-, 16- or 
32-tube manifold.

A Ultrasonic cleaning and 
priming trough

Most models support AutoClean ultrasonic cleaning of the 
washer.

EL406™ Microplate Washer Dispenser
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 Device/Component Description

B Dispense arm Holds the Peri-pump’s Tip Holder and the Syringe dispensers’ 
manifolds.

C Priming trough Waste reservoir for collecting priming fluid for the Peri-pump 
and Syringe dispensers.

D Plate Carrier Holds standard microplates for processing.

E Keypad One of two ways to control the instrument; the other way is 
LHC.

 n The valve on the left side of some instrument models (not shown in 
photograph) is for the optional Vacuum Filtration Accessory Kit.

 Features of the EL406

 l Supports all microplate-based assays, including ELISA, fluorescence, 
chemiluminescence, RIA, DNA probes, and cellular assays.

 l A variety of solutions, including buffered saline and reagents can be dispensed.

 l The intuitive onboard software allows you to create and store up to 99 wash and dispense 
protocols. BioTek provides numerous predefined protocols for maintenance and 
instrument qualification purposes.

 l Compatible with BioTek’s BioStack™ Microplate Stacker for automated plate processing.

 l A robot-accessible carrier that can be interfaced into some robotic systems.

 l Computer control using BioTek’s Liquid Handling Control™software (“LHC”).

 l A low-maintenance design, the result of BioTek’s long history with liquid-handling 
instruments. 

Washer 

 l Programmable dispense volumes, and a wide range of wash options, from gentle 
washing for cellular assays to vigorous washing for ELISA.

 l A “bottom washing” routine to lower the background absorbance and “crosswise” or 
secondary aspiration to reduce residual volumes, except in 1536-well plates.

 l Supports Wash, Prime, Dispense, and Aspirate steps (except dispensing to 1536-well 
plates, which is performed with the dispensers). 

 l An optional buffer-switching module with four supply bottles supports complex assays by 
allowing one protocol to automatically draw reagent from up to four distinct reservoirs. 

BioTek Instruments, Inc.
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 l Built-in fluid, flow,  and vacuum detection provide complete confidence for unattended 
operation.

 l Several predefined protocols are provided to simplify preventative maintenance, which 
should be performed regularly to ensure optimum washer performance.

 l BioTek’s patent-pending Ultrasonic Advantage™ (ultrasonic cleaner) provides extra 
cleaning power by using ultrasonic pulses in a water bath to remove residue on the 
manifold tubes. A stainless steel cleaning reservoir with an ultrasonic transducer bonded 
to the bottom of the reservoir is mounted on the washer. An AutoClean function enables 
the user to run ultrasonic cleaning routines.

Peri-pump Dispenser

 l A peristaltic pump with eight individual tubes transfers fluid from a supply bottle, or up 
to eight different supply bottles, to various vessels. The pump has four rollers over which 
the tubing is stretched. 

 l The tubing is contained in an easy to load and unload cassette that is attached to the 
pump head. The pump’s protective cover must be in place to run a dispense routine.

 l Three cassette sizes are available: 1 µL, 5 µL, and 10 µL for the most precise dispensing 
of volumes from 1 to 3000 µL and 0.5 µL dispenses with certain models using a 1 µL 
cassette.

 l Autoclavable tubing (steam temperatures and pressures of 121° C and 1 bar 
(750 mmHg)) is compatible with 70% ethyl or isopropyl alcohol and 0.5% sodium 
hypochlorite (bleach) solution for easy maintenance.

Syringe Dispensers

 l The Syringe dispenser has a long-lasting seal that ensures precise and accurate fluid 
delivery, as well as reproducibility for repeated dispenses.

 l Two syringes support distinct fluid sources:
 o 16-channel: one tube per well for 384-well plates and two tubes per well for 96-

well plates.

 o 32-channel: one tube per well for 1536-well plates,

 o 8-channel (two manifolds in one block): one tube per well for both 96- and 384-
well plates.

 l Autoclavable components can be used with organic solvents and provide easy 
maintenance.

 l Does not require recalibration.

EL406™ Microplate Washer Dispenser
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Liquid Handling Control™ (LHC) Software

BioTek’s Liquid Handling Control (LHC) software lets you control the instrument 
from your computer. You’ll enjoy the convenience of programming assay-specific 
wash and dispense protocols in a familiar Windows environment (Microsoft® 
Windows® 7, Vista, and Windows XP). 

For high-throughput applications, the LHC supports BioStack™ integration.

Please refer to the LHC Installation Guide and Help system to learn about:
 o Installing the LHC software on the controlling computer

 o Running Maintenance protocols

 o Running Qualification protocols

 o Special considerations when operating with the BioStack Microplate Stacker

BioTek Instruments, Inc.
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EL406 Dispenser Comparison

Counting the washer as a potential dispenser, the EL406   offers three distinct 
dispensers to choose from. Here is a comparison   of the devices:

 n For precious reagents use the Peri-pump   to preserve unused fluids. It has 
the shortest, most visible fluid path,   and a Purge capability to reverse the fluid 
flow and recover fluid from   the tubing. Another advantage is the ability to 
dedicate usage of a dispense cassette   to one reagent only, reducing the 
amount of priming required   prior to use.

Device
Volume 
range 
µL/well

Precision Accuracy Approximate Dead
volume

Peri-pump 0.5‡, and 
1-3000*
 

<10% CV 
@ 1 
µL/well  
(typical 
<3% CV)

+/-10% 
(typical 
+/-3%) @ 
1 µL/well

Cassette Type:

1 µL 1.20 mL

5 µL 4.23 mL

10 µL 7.36 mL

Syringe 8-tube 10-3000 <5% CV @ 
20 µL/well

±2 µL @ 
10 
µL/well

For all manifold types:
12 mL without Buffer 
Switching. The Buffer 
Switching module adds 5 
mL per fluid path.Syringe 16-tube 5-3000 <10% CV 

@ 5 
µL/well

±2 µL @ 
10 
µL/well 

Syringe 32-tube 3-3000 <12% CV 
@ 6 
µL/well 

±5% @ 6 
µL/well   

Washer 
Dual/Single 96-
tube 

50-3000 <3.0% CV 
@ 300 
µL/well

300 µL: 
±5% 

125 mL without Buffer 
Switching. The Buffer 
Switching module adds 45 
mL to the fluid path.
 Washer 192-

tube
25-5000 <4.0% CV 

@ 80 
µL/well

80 µL: 
±5%

*1 µL cassettes' maximum recommended dispense volume is   50 µL/well. 
‡ 0.5 µL dispensing is supported by some late-model instruments using a 1 µL cassette.

EL406™ Microplate Washer Dispenser
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BioTek recommends priming a dispenser with three times its dead volume to 
prepare it for accurate dispensing.

Processing Time §  

Protocols were optimized for speed to obtain the following   processing times, 
including the fastest flow and travel rates. Some of   these parameters are listed in 
the Parameters column of the table. 

Device Plate 
Type

Volume 
(µL/well)

Parameters Time in 
seconds
   ¥

Peri-pump - 5 µL 96 10 High flow rate 3 
Peri-pump - 1 µL 384 1 High flow rate 6 

1536 1 High flow rate 21
Syringe 8-tube 96 20 Flow rate 1 6.5
Syringe 16-tube 96 20 Flow rate 1 5.25 

384 20  Flow rate 1 14
Syringe 32-tube 1536 3 One SB manifold 16.5

1536 14 Both SB manifolds 27
Washer 
Dual/Single 96-
tube 

96 300 3 cycles < 30 

Washer Dual 96-
tube 

384 100 3 cycles < 80 

Washer 192-
tube

384 400 1 cycle < 20 

1536 Wash: 128-
aspirate tubes,   
32-dispense 
tubes

1536 10 1 cycle, Plate Clearance = 90; 
Both   SB manifolds. 

< 32 

1536 10 1 cycle, Plate Clearance = 60; 
one SB manifold.

< 46 

§ Review the Specifications   for more details.

¥ Excluding plate carrier and manifold homing movements.

SB = small bore Syringe manifold

BioStack Compatibility

The EL406   is compatible with BioTek’s BioStack Microplate Stacker.  The BioStack 
can rapidly transfer microplates one-at-a-time to and from the instrument, and 
includes: 

BioTek Instruments, Inc.
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 l Removable stacks (one input and one output).

 l Optional restacking of plates to maintain correct sequencing.

 l The ability to continue processing plates following the aborting/failure of 
one plate.

 l The ability to pause processing to allow the user to add more plates to the 
input stack or to remove some from the output stack.

If you have purchased the BioStack to operate with the EL406, refer to the BioStack 
Operator’s Manual for instructions on configuring the EL406 to run with the 
BioStack. To help you get started: See  Operating with the BioStack on page 82.

If you are interested in purchasing the BioStack, contact your local BioTek dealer 
for more information or visit our website at www.biotek.com.

EL406™ Microplate Washer Dispenser
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Package Contents

 n Part numbers and package contents are subject to change and vary according 
to instrument model. Please contact BioTek Customer Care if you have any 
questions.

Description                     PN

Power cord (part numbers vary   by country of use)                     Varies                     

RS-232 serial cable                     75034                     

USB cable (USB Virtual COM Port   Driver Software & instructions)                     75108                     

Microplate carrier                      7180501                    

Priming trough insert (1) for   Peri-pump                     7182043                    

Priming trough insert (2) for   Syringe dispensers                    7182044                    

Mist shield and thumbscrews   (2) ~ installed 7182042                    

Strip plate (12x1)                     98265                     

Screwdriver, Phillips                      98268                     

Stylus: for cleaning   washer manifold aspirate tubes                      7102108

Stylus: for cleaning   washer and Syringe manifold dispense tubes 
and 128-tube aspirate manifold tubes

2872304                    

Stylus: for cleaning 192-tube dispense manifold 7102139  

10 cc syringe and tubing for   Peri-pump cassette maintenance                     49919                     

Shipping brackets (2)                   7182005 
7182073                   

Hex wrench: 9/64”                          48434                     

Hex wrench: 3/32”   for removing syringe pumps                    48570                     

Hex wrench: 1/16”        for removing magnets from syringe dispense 
manifolds      

48713      

Spare fuses (5)                     46055                     

EL406™ Getting Started Guide   (and Operator’s Manual on CD - PN 
7181009)                     

7181010                     

BioTek Instruments, Inc.
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 n Some components are model specific, they ship only with certain instrument 
models. 

Optional Accessories

 n Part numbers and package contents are subject to change and vary according 
to instrument model. Please contact BioTek Customer Care if you have any 
questions.

General Instrument Accessories 

Description PN       

BioTek liquid testing solutions for        
instrument qualification tests      

Wetting 
Agent                     

7773002      

Blue Test 
Dye                     

7773001      

Large size priming trough insert 7182109

Liquid Handling Control™       Software LHC2

BioStack™ Microplate Stacker and integration kit                 Biostack      

Installation-Operational-Performance        Qualification (IQ-
OQ-PQ) package      

7180527 

Washer Accessories

Description PN                     

Complete dispense/waste system,  4 Liter bottles                    115 volts                    7100547                     

230 volts                    7100548                     

Complete dispense/waste system   with High Flow vacuum 
pump (recommended for use with 384-well microplates), 4L 
bottles                    

115 volts                     7100565                     

230 volts                      7100566                     

Auxiliary power cord for vacuum   pump connection                     75096                     

Vacuum tubing set 7100533                  

Dispense tubing set 7100538                   

Buffer Switching module with 4   supply bottles                     7100540                     

EL406™ Microplate Washer Dispenser
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Description PN                     

10-liter dispense bottle                     7100559                     

Waste bottles                     10 liter                     7100557                     

20 liter                     7100556                     

Vacuum pump standard                    115 volts                     7100562                     

230 volts                     7100561                     

High Flow vacuum pump:   used when washing 384-well 
microplates with buffers not containing surfactants   or where 
strong aspiration is required                     

115 volts                     7100563                     

230 volts                     7100564                     

Magnetic Bead Assay Accessories

Accessory PN

Magnet Adapter Kit 7180011

Magnets:

384-well Flat Magnet 7103017

384-well  Ring Magnet 7102215

96-well Flat Magnet 7103016

96-well Ring Magnet 7102216

Vacuum Filtration Kit

Description PN

Vacuum Filtration Kit 7180029

-- 96-well Only 1170008

-- 96- and 384-well 1170009

Peri-pump Optional Accessories

 n Part numbers and package contents are subject to change and vary according 
to instrument model. Please contact BioTek Customer Care if you have any 
questions.

Dispense cassettes and accessories:

BioTek Instruments, Inc.
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Cassette Type Cassette Tips Replacement 
tubing kit*

Tubing 
extension 

kit

1 µL plastic tips 7170012 7172150

7170009
 
 
 

7170022
 
 
 

1 µL 1536-well, plastic tips 7170018 7172150

1 µL sapphire jeweled 
stainless steel tips*

7170015 48692

1 µL 1536-well, sapphire 
jeweled stainless steel tips*

7170016 48692

5 µL plastic tips 7170011 7172059 7170008
 
 

7170021
 
 

5 µL  stainless steel tips 7170014 7172128

5 µL plastic, large bore tips 7170024 7172039

10 µL plastic tips 7170010 7172059 7170007
 
 

7170020
 
 

10 µL stainless steel tips 7170013 7172128

10 µL plastic, large bore tips 7170024 7172039

*Save your stainless steel tips for reuse with a replacement kit, they ship with plastic tips.

Accessory PN

Cassette Calibration Kit 7170017

Peri-pump Reservoir Holder 7210509

40 mL Priming Trough Insert 7182109

Syringe Dispenser Optional Accessories

 n Part numbers and package contents are subject to change and vary according 
to instrument model. Please contact BioTek Customer Care if you have any 
questions.

Accessory PN

Autoclavable Syringe Dispenser Module: 16-Tube Manifold (2) 7180006S

Buffer Switching Module 7180028

Stylus – for cleaning 8-/16-tube dispense manifold tubes 2872304

Stylus – for cleaning 32-tube LB dispense manifold tubes 7182095

Stylus – for cleaning 32-tube SB dispense manifold tubes 7182102

EL406™ Microplate Washer Dispenser
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Accessory PN

Inline Filters (2) 48705

Spare tubing sets (2 - 1/dispenser), autoclavable 7183006

DMSO- & Acetonitrile-safe tubing sets (2 - 1/dispenser) 7183002

Special large-bore 8-tube manifold for 96-well plates 7180549S

 

Physical Specifications

Labware

Microplates 96-well, 384-well, and 1536-well that   comply with SBS microplate 
standards 1-2004, 2-2004, 3-2004, and 4-2004. 

Microstrips                     1 x 8, 1 x 12                     

Microwells                     Flat, round, "V” bottom                     

Hardware & Environmental

User Interface                     2-line x 24 character LCD screen,                                                  26 alphanumeric soft keys 

Power   Supply                     The instrument uses two internal power supplies:   24-volt 60 watt and 
48-volt 60 watt. These supplies are compatible with   100-240 V~; 50-
60 Hz.                     

Accessory Outlet ≤ 5.0 A, used for vacuum   pump                      

Dimensions                    
(W x D x H)

16½ x 12 5/8 x 18 inches (42 cm x 32 cm x 46   cm)

Weight  (≤)                32 lb (14.5 kg)                         

Operating 
Conditions                     

10° - 40°C (50° - 104°F)                     

Relative Humidity
                     

The instrument should be operated in a non-condensing humid 
environment having a maximum relative   humidity of 80% at 
temperatures up to 31°C decreasing   linearly to 50% relative humidity 
at 40°C.                     

BioTek Instruments, Inc.
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Washer

Manifold Type  

96-tube                     Single or Dual manifold   with 96 sets of aspirate and dispense tubes 
arranged in an 8x12 array. Single manifolds can only process 96-well 
microplates; dual manifolds can process 96- and 384-well plates.

192-tube                     Dual manifold   with 192 sets of aspirate and dispense tubes arranged 
in a 16 x 12 array   can only process 384-well plates.

128-tube                                                                      Aspirate-only manifold with 128-tubes in 32 x 4 array to process 
1536-well   plates. One dispense pin in the manifold fills the priming 
trough for   maintenance procedures.

Waste bottle volume                     4, 10, or 20 liters, depending on the accessory package, (2 
bottles, one with sensor)                     

Supply bottle volume                     2 4L  or 10L bottles (4 bottles w/ Buffer Switching)

Peri-Pump

Peristaltic pump: Positive-displacement peristaltic pump with 4 rollers that stretch 
the 8 tubes   (one per channel) to deliver fluid.        

Cassette 
Types

Dispense range
                     Cassette Life                     Dead Volume

1 µL                     0.5, 1 - 3000 µL 1000 384-well   plates @ 5 µL/well                     1.2 mL                    

5 µL                     5 - 3000 µL 1000 96-well   plates @ 50 µL/well                     4.2 mL                     

10   µL                    10 - 3000   µL 1000 96-well   plates @ 100 µL/well                     7.4 mL                     

Syringe Dispenser

Two external positive-displacement syringe pump dispensers which support 
various manifold types.

Manifold   Type

8-Tube                     2 x 8-channel non-autoclavable manifold with replaceable stainless 
steel   tubes to process 96- and 384-well plates.

16-Tube 1 x 16-channel autoclavable manifold with replaceable stainless steel
   tubes to process 96- and 384-well plates.                     

16-Tube 7° 1 x 16-channel autoclavable manifold with replaceable stainless steel 
tubes to process 96- and 384-well plates. Tubes are angled 7 degrees 

EL406™ Microplate Washer Dispenser
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Manifold   Type

to minimize turbulence in the wells when dispensing.

32-Tube                     1 x 32-channel manifold cannot be autoclaved, and does not support 
non-factory   tube replacement. An inline 90-micron filter is included 
to minimize clogs. For 1536-well plates only.

Performance Specifications

Washer 

Average Residual Volume (Evacuation   Efficiency) 

96-Tube   Manifold 
(Single and Dual)

Average residual volume in the   microwells is ≤ 2 µL per well after a 
3-cycle wash, when 300 µL of deionized water with 0.1% Tween 20®, 
or buffer   equivalent, is dispensed per well into a Costar® 96-well   
flat-bottom plate. The aspirate height adjustment is optimized for the
   plate prior to testing. 

192-Tube   
Manifold

Average   residual volume in the microwells is ≤2 µL per well after   a 3-
cycle wash, when 100 µL of deionized water with 0.1% Tween 20, or   
buffer equivalent, is dispensed per well into a Costar 384-well flat-
bottom   plate. The aspirate height adjustment is optimized for the 
plate prior   to testing. 

128-Tube 
Manifold                     

Average residual volume in the wells shall be ≤ 0.1   µL per well when 
10 µL of deionized water with 0.1% Tween 20 solution   is dispensed 
per well into a 1536-well flat-bottom Nunc®   plate.

Vacuum Filtration Evacuation Efficiency

96-Well Filter Plates Average increased weight of the plate is ≤ 1.2 grams after 
dispensing 300 µL of deionized water per well into a Millipore® 
MSHVN4450 96-well 0.45µm plates (PN 98258) and vacuum 
aspirated for 30 seconds at vacuum pressure 2.5 Hg (+/- 0.5 Hg) 
and blotted on a paper towel.

384-Well Filter Plates Average increased weight of the plate is ≤ 4.0 grams after 
dispensing 80 µL of deionized water per well into a Millipore® 
MZFCN0W10 384-well 1.2µm plates (PN 98287) and vacuum 
aspirated for 10 seconds at vacuum pressure 2.5 Hg (+/- 0.5 Hg) 
and blotted on a paper towel.

BioTek Instruments, Inc.
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Dispense Accuracy                     

96-Tube Manifold ± 5% when dispensing   300 µL per well of deionized water with 0.1% 
Tween 20, with FD&C #1   blue dye at a rate of 300 µL per well per 
second into a Costar 96-well   flat-bottomed plate. The weight of the 
fluid dispensed shall be measured   gravimetrically. 

192-Tube 
Manifold

±5% when dispensing 80 µL per well of deionized water with 0.1% 
Tween 20, with FD&C #1 blue   dye at a rate of 102 µL per well per 
second into a Costar 384-well flat-bottomed   plate. The weight of the 
fluid dispensed shall be measured gravimetrically. 

Dispense Precision 

96-Tube Manifold ≤   3.0% CV  when dispensing 300 µL per well of deionized water with 
0.1% Tween 20,   with FD&C #1 blue dye at a rate of 300 µL per well 
per second into   a Costar 96-well flat-bottomed plate. The absorbance 
of the solution is   read at 630 nm and 450 nm reference. 

192-Tube   
Manifold

≤   4.0% CV when dispensing 80 µL per well   of deionized water with 
0.1% Tween 20, with FD&C #1 blue dye at a rate of 102 µL per well 
per second into a Costar 384-well flat-bottomed   plate. The 
absorbance of the solution is read at 630 nm and 450 nm reference. 

 

EL406™ Microplate Washer Dispenser
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Peri-Pump Dispenser

Precision is measured for a whole 96-well or 384-well plate using room-temperature 
deionized or distilled water with 0.1% Tween 20 with FD&C #1 blue dye. Precision is 
measured for 1536-well plates by dispensing to 384 wells, 12 columns with a 15% isopropyl 
alcohol solution. The absorbance of the solution is read at 630 nm and 450 nm reference. 
Specifications apply to volumes that are full unit increments for the cassette to which they 
apply, except the 1 µL cassette also supports 0.5 µL increments when dispensing this volume. 
For example: the precision specification for a 10 μL cassette is valid at 10, 20, 30, ..., 3000 
μL; the 1 µL cassette precision specification is valid at 0.5, 1, 2, 3, ..., 3000 µL.

Accuracy is measured   gravimetrically when dispensing room-temperature deionized water. 
Specifications   apply to volumes that are full unit increments for the cassette to which   they 
apply. For example: the accuracy specification for a 10 µL cassette is valid at 10, 20, 30, ... 
3000 µL.

Cassette Precision Accuracy

1 µL
 

10%CV  @ 1 µL per well ± 10% @ 1 µL per well 

5%CV  @ 2 µL per well* ± 5% @ 2 µL per well*                     

10%CV  @ 0.5 µL per well n/a

5 µL
 

5%CV  @ 5 µL per well                     ± 4% @ 5 µL per well                    

2.5%CV  @ 10 µL per well*                     ± 2% @ 10 µL per well*                     

10 µL                    
 

4%CV  @ 10 µL per well                    ± 4% @ 10 µL per well                     

2%CV  @ 20 µL per well*                     ± 2% @ 20 µL per well*                     

* These specifications   are for these dispense volumes and higher.                     

Cassette Expected Lifetime

Cassette Types Cassette Life Total Volume

1 µL 1000 384-well plates @ 5 µL/well 2,000 mL

5 µL 1000 96-well plates @ 50 µL/well 5,000 mL

10 µL 1000 96-well plates @ 100 µL/well 10,000 mL

With strict adherence to best practices and maintenance recommendations, this is 
the typical longevity of the dispense cassettes.

BioTek Instruments, Inc.
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Syringe Dispensers

Precision is measured   for a whole 96-well or 384-well plate using room-temperature 
deionized or distilled water with 0.1%   Tween 20 with FD&C #1 blue dye. Precision is 
measured for 1536-well plates by dispensing to 384 wells, 12 columns with a 15% isopropyl 
alcohol solution. The absorbance of the solution shall   be read at 630 nm and 450 nm 
reference. 

Accuracy is measured   gravimetrically when dispensing room-temperature deionized water. 

Dispense   Precision                       

8-Tube: ≤   2% CV   when dispensing 100 µL/well                            
≤ 5% CV precision at 20 µL/well
≤ 5% CV precision at 40 µL/well **
**  Tested in-house to <4.0% CV.

16-Tube: ≤   2% CV   when dispensing 100 µL/well
≤ 2.5% CV   precision at 80 µL/well***                    
≤ 5% CV precision at 20 µL/well                           
≤ 10% CV   precision at 5 µL/well*
*unspecified for non-autoclavable syringe pumps.
*** Tested in-house to <1.6% CV.

32-Tube: < 12% CV when dispensing 6 µL per tube 

Dispense   Accuracy                     

8-Tube For all volumes 2 µL or 1%, whichever is greater, at flow rate 2.

16-Tube: For all volumes 2 µL or  1%, whichever is greater,                    at flow rate 2.

32-Tube: ± 5% when dispensing 6 µL/well at flow rate 3. 

EL406™ Microplate Washer Dispenser
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BioTek's Customer Resource Center

BioTek's Customer Resource Center (CRC) continues our tradition   of superior 
service and support. After an easy registration process, you   can access lots of 
useful information about your BioTek microplate instrumentation   and software. On 
the secure CRC website, you can:

 l Track   orders              

 l Access   warranty information, user manuals and software updates             

 l Download   technical and application information             

 l Maintain   equipment inventory (product registration)             

 l Request   service and technical support             

 l View   service history             

 l And   much more!             

Register at https://customer.biotek.com

 n Dispense cassette data sheets are available for download at the CRC.

BioTek Instruments, Inc.
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Chapter 2

Installation        

This chapter provides detailed installation instructions. 
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Remove the Shipping Hardware 23
Set Up the Washer 25
Setting Up the EL406 27
Set Up the Peri-pump Dispenser 38
Install the Syringe Dispenser Component 43
Syringe Dispenser Buffer Switching Module 47
Install Software/Connect to Computer 49
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Define Instrument Settings 51
Define Startup Preferences (LHC users only) 54
Verify Performance 55
Repacking the EL406 57
EL406 Repacking 59
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Unpack and Inspect the Instrument

Important: Save all packaging materials. If you need to ship the instrument or 
accessories to BioTek for repair or replacement, you must use the original packaging. 
Using other forms of commercially available packaging is not recommended and can void 
the warranty. Improper packaging that results in damage to the instrument  may lead to 
additional charges. Refer to the operator's manual for repacking instructions.

Inspect the shipping box, packaging, instrument, and accessories for signs of 
damage.

If the EL406™ Microplate Washer Dispenser is damaged, notify the carrier and 
your BioTek representative. Keep the shipping cartons and packing material for the 
carrier’s inspection. BioTek will arrange for repair or replacement of your 
instrument immediately, before the shipping-related claim is settled.

 1. Unpack the boxes containing the instrument and other equipment:

 l EL406™ Microplate Washer Dispenser and accessories

 l Vacuum Pump and accessories

 l Buffer switching valve module and accessories

 l Vacuum Filtration Accessory Kit

 l Dual Syringe Dispenser and accessories

 l Additional 192-tube washer manifolds for 384-well plate processing or 128-
tube wash and 32-tube dispense manifolds for 1536-well plate processing.

 2. Place all packing materials back into the shipping boxes for reuse if necessary.

Refer to the Package Contents on page 9 to make sure you have all expected 
equipment.
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Remove the Shipping Hardware

Supplies

A Phillips-head screwdriver is needed to remove the shipping   brackets.

Keep   in mind that you will have to reinstall the shipping hardware and use   the 
original shipping material if it is necessary to return the instrument   to BioTek for 
service or repair.

Remove the   rubber band

 1. Carefully   remove the rubber band that holds the pump cover in place around 
the Peri-pump, if present.             

Store the rubber band in the small plastic storage   pouch for future use.

Attach the plastic storage pouch to the rear panel

 2. Use the Velcro strips to attach the plastic storage pouch to the rear panel of the 
instrument. Select a position that does not block the vent holes.

BioTek Instruments, Inc.
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Remove the manifold shipping bracket

 1. Use the Phillips   screwdriver to 
remove the
8 screws and washers holding the 
bracket in   place. First remove the 4 
screws from the manifold, then 
remove the   screws from the 
instrument.              

 2. Slide the bracket towards   you and 
remove.             

 3. Store the bracket, screws   and 
washers with the other shipping 
material. 

 n Single 96-tube manifolds have two spacers on top of the manifold under the 
shipping bracket, to make it fit. Be sure to save these spacers with the 
shipping materials or in the pouch on the back of the instrument. They must be 
reinstalled prior to shipping.

Remove the dispense arm shipping bracket

The bracket holds in place both the dispense arm   and plate carrier rail during 
shipping.

 1. Use   the screwdriver to remove the 2 
screws holding the bracket   in place.             

 2. Gently   lift the dispense arm slightly to 
release the bracket and remove it.             

 3. Reinsert   the screws into the 
instrument’s base plate for safe 
keeping.             

 4. Store   the bracket with the other 
shipping material.              

EL406™ Microplate Washer Dispenser



Set Up the Washer |  25

Set Up the Washer 

Install the Microplate Carrier

The   Y-axis carrier arm attached to the Transport rail   holds the plate carrier. It moves the plate during 
processing to allow the dispensers   to address high density plates.

 1. Locate the microplate   carrier in the accessories box.              

 2. Slide   the plate carrier transport rail all the way to the right, and then back   to the 
left about 1-2 inches (3-4 cm). The transport rail was being held   in place by the 
dispense-arm shipping bracket.              

 3. Look   at the underside of the carrier to visualize how it fits in place: its   two legs 
will be positioned on the left and the curved hollow fits over   the transport rail 
on the right. Note the small slit adjacent to the top   of the curved hollow. This 
slit fits into the Y-axis Carrier Arm.             
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 4. Aligning   the curved hollow with the transport rail, place the carrier on the rail   
so it fits into the slot on the Y-axis Carrier Arm. If necessary,   release the spring-
loaded microplate clamp in the back left corner of   the carrier to level the carrier 
on the instrument.             

 n If a 401 Instrument Error is displayed   at startup, recheck the plate carrier 
position. Make sure the plate carrier   is seated in the Y-axis Carrier Arm 
next to the transport rail.             
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Setting Up the EL406

Important: Avoid excessive humidity.  Condensation directly on the sensitive 
electronic circuits can cause the instrument to fail internal self checks.  

Install the instrument on a level, stable surface in an area where ambient 
temperatures between 10°C (50°F) and 40°C (104°F) can be maintained.

The instrument should be operated in a non-condensing humid environment 
having a maximum relative humidity of 80% at temperatures up to 31°C 
decreasing linearly to 50% relative humidity at 40°C.

Connect the Vacuum Pump, Tubes, and Bottles

For optimal operation of the EL406, all tubing, cables, and fittings for the fluid 
supply and waste systems must be properly connected. This image illustrates 
the rear panel of the instrument and the locations of the ports and connections 
for the fluid supply and waste systems.  

Rear Panel

Waste System

Caution! Pump Installation. Do not plug the vacuum pump cable into a wall outlet! 
Use the adapter provided with the pump to connect it to the Accessory Outlet on the 
back of the instrument. This allows the EL406 to regulate the pump, turning it on and off 
as specified by the protocol.
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When using a standard pump (rather than the high flow pump), set the instrument’s 
Vacuum Dissipation Delay to prevent the pump from drawing excess current and 
blowing the 5-amp fuse.  See Define Instrument Settings  on page 51 

 n Note: The waste tubes have colored bands that match similarly colored dots 
next to the inlet/outlet ports on the waste bottle caps to ensure the correct 
connection of the tubing.

Waste System

Three lengths of tubing are shipped with the waste module:

Tubing:   Connects:
Short tube with yellow and green bands g The two waste bottles to each other

Long tube with green bands on both ends g Bottle without sensor to vacuum port

Long tube with yellow and orange bands g Bottle with waste sensor to the vacuum 
pump

 1. Locate the quick-release caps shipped inside the waste bottles and attach the 
tubing to them as follows:
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 2. Connect the waste bottles to each other using the shortest length of tubing, 
matching the colored bands on the tubing to colored dots on the caps.

 3. Attach the waste sensor cable to the Waste Sensor port on the back of the 
washer. 

 4. Attach the tube from the waste bottle with the waste sensor in its cap to the 
vacuum pump.

 5. Attach the tube from the waste bottle that does NOT have the waste sensor 
in its cap to the Vacuum port on the back of the instrument.

 6. Important! When installing BioTek’s vacuum pump, connect the pump’s AC 
power cable to the vacuum pump Accessory Outlet on the back of the 
instrument  (Use the accessory outlet adapter provided, if applicable.)

 7. Place the waste bottles and vacuum pump on the same horizontal plane as the 
instrument or below it, such as the floor beneath the work surface. This will 
help optimize performance.

 8. Make sure the waste bottle’s caps are well sealed. 

 n BioTek strongly recommends installing the vacuum line filter to protect your 
vacuum pump.

Install the Vacuum Line Filter

The optional vacuum line filter (PN 48294) can be installed halfway between the 
last waste bottle (overflow bottle) and the vacuum pump. 

To do this, cut the tubing and insert the filter, noting the direction of flow. The flow 
arrow on the filter should point toward the vacuum pump. 

In the event of a fluid overflow, the filter should prevent the destruction of the 
vacuum pump’s internal components. If an overflow does occur, check the filter for 
trapped fluid. If fluid is found in the filter, remove the filter and drain using the 
small white nut on top of the filter. Tighten the white nut and reinstall the filter.

 

BioTek Instruments, Inc.



30 | Chapter 2: Installation

Fluid Supply System

Install the Buffer Switching         module

Buffering Switching System

 1. Place the four supply bottles and valve module on the same surface as the 
instrument to optimize performance.

 2. Connect the cable from the Valve Control port on the module to the Valve Control 
port on the back of the instrument.

 3. Connect the tubing from one of the supply bottles to “A” Buffer in the valve 
module.

 4. Repeat step 3 with the other three supply bottles for “B,” “C,” and “D” Buffers.

 5. Connect the 6-foot (1.83 Meter) tubing from the valve box Fluid Out port to the 
Dispense Fluid In port on the instrument’s rear panel. This tubing can be cut to 
the optimal length required for the installation. 

Important: Instruments that specify Buffer Switching ("B"  models) are configured at the 
factory to use the module to supply fluid. If you choose not to use the module and instead 
connect a supply bottle directly to the instrument, be sure to change the washer's buffer 
switching setting: Change the Washer Buffer Switching Setting on page 160.
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 n Important: Only one buffer switching unit can be installed at a time, either 
the washer's buffer switching module or the Syringe's. Thus, the instrument's 
settings for these devices work like a toggle, when one is enabled, the other is 
disabled, if applicable.

Install the Fluid Supply without Buffer Switching

 1. There is one supply tube. Connect one end to the Dispense Fluid In port and the 
other end to the supply bottle.

 2. Place the supply bottle on the same horizontal plane as the instrument.

Set up the Vacuum Filtration Accessory

If applicable, complete these steps to prepare the instrument to perform vacuum 
filtration assays. Otherwise, skip this step.

The Vacuum Filtration Accessory Kit includes:

 1. Special vacuum filtration plate carrier

 2. Pressure regulator

 3. Evacuation tubing

 4. Two wrenches: 3/8” (10 mm) and 5/16" (7.94 mm)

 5. Foot Adjustment tool for measuring plate carrier leveling feet

 6. Adjustment tool for positioning the manifold stop screw 
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You must provide a standard microplate with a cover.

To set up vacuum filtration:

 l Measure your factory-installed plate carrier and adjust the vacuum filtration 
carrier to match its dimensions;

 l Level the vacuum filtration plate carrier and set the height of the manifold 
stop screw;

 l Adjust the pressure regulator.

Adjust the Vacuum Filtration Carrier

Every plate carrier is customized in the BioTek factory for a specific instrument. 
The plate carrier’s leveling feet are adjusted to precisely fit its EL406. You must 
imitate this process to customize the new vacuum filtration carrier supplied in the 
kit to precisely fit your instrument.  

Use the Foot Adjustment Tool to measure your standard plate carrier’s dimensions 
and adjust the leveling feet of the vacuum carrier to match them:

 1. Remove the carrier from your instrument and place it upside down on the 
bench. 

 2. Unscrew the "manifold stop screw" on the  vacuum filtration carrier and place it 
upside down on the bench in the same orientation as your original carrier.

 3. Put the foot adjustment tool on your 
carrier, aligned with the front nylon 
foot, to measure its height from the 
surface of the carrier. Obtain as 
precise a measurement as possible.

 4. Put the foot adjustment tool in the 
same position next to the front foot 
on the vacuum filtration carrier.

 5. Use the 3/8” wrench to loosen the 
locking nut of the nylon foot on the 
vacuum carrier. Turn the nylon foot 
until its top hits the adjustment tool 
pin. You should not be able to see 
light between the foot and the pin.
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 6. Use the 5/16” wrench  to hold the 
nylon foot at the desired height and 
simultaneously use the 3/8” wrench 
to tighten the locking nut.

 n Important: The threads on the nylon feet are easily damaged. Do not over 
tighten the locking nut.

 7. Verify the foot is still at the proper 
height after tightening the nut using the 
Foot Adjustment tool. Loosen the nut 
and readjust the foot if necessary, for 
example, if there is light between 
adjustment tool pin and the top of the 
foot.

 8. Repeat these steps for the other foot.

Level the Vacuum Filtration Plate Carrier

Make sure the vacuum filtration carrier sits perfectly level on the instrument and 
does not rock back and forth when one side or the other is pressed down. Readjust 
the leveling feet to correct any imbalance.

 1. Install the vacuum carrier on the instrument and place a microplate with a cover 
on the carrier. (Remember to seat the carrier in the Y-axis arm.)

 2. Use the Adjust Utility to lower the wash manifold onto the plate to assess 
uniformity; to make sure the plate carrier is perfectly level:

LHC Keypad

 1. Select Tools> Instrument Utilities> 
Run the Adjust Utility.

 2. Send the Washer to its Aspirate Location. 

 1. UTILS > ADJST

 2. Select the  plate type.

 3. Select Washer and DISP 
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LHC Keypad

The manifold will rest on top of the 
plate cover.

 3. Set the Location Adjustment to Z axis and 
enter 130 in the Go to now field.    The 
manifold will rise a few steps above the 
plate cover.

 4. Click the Down button to move the 
manifold one step at a time onto the 
plate cover.

position.    The manifold will 
rest on top of the plate 
cover.

 4. Select MAN and press t 
(left arrow) to lower the 
manifold, one step at a 
time, onto the plate cover. 

 3. Closely observe the bottoms of the aspirate tubes looking for differences in the 
gap between the manifold and the plate.  The gap between the surface of a 
covered microplate and the ends of the aspirate tubes must be uniform across 
the plate. If not, adjust the front and rear leveling feet.

Important: Do not adjust the foot on the transport rail.

 4. If adjustments are needed:

 1. Use the Adjust Utility to lift the manifold so that none of the tubes touch the 
plate cover.

 2. Use the 3/8” wrench to loosen both locking nuts.

 3. Use the 5/16” wrench to adjust both the front and back feet so that the gap is 
greater on the left hand side of the plate than on the right hand side.

 4. Beginning with the front foot on the carrier, use the 5/16” wrench to adjust 
the front foot on the carrier until the left and right sides of the plate are an 
equal distance from the ends of the tubes.

 5. Use the 5/16” wrench to adjust the rear foot. Adjust the rear foot to remove 
twist from the carrier and eliminate any rocking of the plate on the carrier.

 5. When the gap between the ends of the tubes and the surface of the plate cover 
is even across the plate and the plate does not rock on the carrier, tighten the 
locking nuts: Begin with the front foot using the 5/16” wrench to keep the foot 
from rotating and the 3/8” wrench to secure the locking nut. Do not over 
tighten the nut. Then, use the wrenches to tighten the locking nut on the rear 
foot.

 6. LHC users: use the Adjust Utility to the Home All devices. Keypad users: press 
the Main Menu button to home all the axes.
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 7. With the carrier in the home position, confirm the carrier does not rock on the 
platform.

Set the height of the manifold stop screw:

Use the Adjustment jig provided in the kit to set the height of the manifold stop 
screw.

 1. Remove the plate cover from the 
plate.

 2. Place the adjustment jig on top of 
the plate to ascertain the required 
height of the manifold stop screw. 

 3. Turn the thumbscrew to raise or 
lower it, as needed, until it touches 
the bottom of the adjustment jig.

 4. When the height is correct, use the 
5/16" wrench to tighten the lock 
nut on the carrier.

 5. Verify the height with the 
adjustment jig and readjust if 
necessary.

Adjust the Pressure Regulator
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Lastly, connect the tubing from the regulator to the plate carrier and from the 
regulator to the side valve (left side) and perform these final steps to adjust the 
pressure regulator:

 1. Connect the tubing without the 
quick release valve to the 
vacuum filtration carrier and to 
the right side of the regulator. 
Apply a little alcohol to the ends 
of the tubing to make the task 
easier.                         

 2. Connect the tubing with the 
quick release connector to the left 
side of the regulator and to the 
valve on the left side of the 
instrument. 

 3. Create an aspiration-only vacuum filtration protocol:

LHC Keypad

 1. Click  W-
Aspirate. Enable 
Vacuum Filtration and 
keep the default time: 
30 seconds.

 1. Select DEFINE>CREATE and assign a 
name, e.g. 30V.

 2. Press ENTER to accept the plate type.

 3. Select ADD>WASHR>g>ASPIR

 2. Save the file with a 
unique name, if 
desired.

 4. Select VAC and keep the default time: 
30 seconds.

 n LHC users: If the Vacuum Filtration option is grayed out, click Settings and 
"get settings" from the instrument. Then, create the protocol.

 4. Change the plate carrier setting to run this vacuum filtration protocol: 
 l Change the Plate Carrier Setting (Keypad) on page 125 or Change the Plate Carrier 

Setting (LHC) on page 124

 5. Put a standard (non-filter) plate on the vacuum carrier and RUN the protocol 
you just created. 
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 6. While the protocol is running, adjust the regulator, turning clockwise to increase 
the pressure, counterclockwise to reduce the pressure. Set the regulator to 2.5 
inches mercury (inHg), this is the default pressure rating.

This completes the set up procedure. Now you are ready to run vacuum filtration 
assays. 

 

Final Check

 l Verify that the tubing was not crimped during installation.

 l Ensure that there are no loose fittings or cable connections.

Attach the Mist Shield

 1. Loosen   the two thumbscrews in 
the front base of the instrument, 
directly in front   of the washer 
manifold and priming trough.             

 2. Position   the mist shield so the 
gaps align with the 
thumbscrews. One side of the   
mist shield rests on the 
instrument base.   

 3. Finger-tighten   the two 
thumbscrews to hold the shield 
in place. 

Always lift the mist shield straight 
up, not towards you, when 
removing it.

BioTek Instruments, Inc.
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Set Up the Peri-pump Dispenser

Install these items to use the Peri-pump dispenser:
 l Dispense cassette

 l Fluid supply vessel

 l (Optional) Prime trough insert

Dispense Cassette Diagram

Tubing Cassette Diagram

 1. Tip   Holder: The cassette’s easiest   part to identify, the tip holder fits into the 
dispense arm to the right   of the pump for positioning above the plate.              

 2. Center   Holder: The center holder is labeled   to identify the size of the cassette 
tubing. It also has a serial number   for tracking purposes. It fits in between the 
tip holder and the tube   tensioner and fixes the tubes in place. It slides into 
grooves on the   underside of the pump.             

 3. Tube   Tensioner:   The transparent 5-mm scale on its front surface identifies the 
tube tensioner.   It has 8 internal screws for stretching the tubing, one for each 
tube.   The tube tensioner’s scale is useful when calibrating the cassette.             

 4. Tube   Organizer: At the opposite end of   the cassette from the tip holder, the 
tube organizer holds the 8 tubes   together for inserting into the fluid vessel. 

 5. Tip Guard: Remove the tip guard before installing the cassette. The tip guard 
protects the tips during shipping. It is not a permanent part of the cassette.
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Install the Dispense Cassette

Prerequisites:
 o Review the Dispense Cassette Diagram on previous page to learn the names

   of the components.             

 o Move the Pump Cover away from the pump   to its OFF position.             

 o Release the pump’s   stainless steel plate: Use your right hand to release the 
spring-loaded cassette  latch (on the right side of the caution symbol on the pump) 
and use   your left hand to lift the stainless steel plate up and out.             

 n Note: The BioTek logos on the Tip Holder and Center Holder face each other 
when installed properly. Similarly, the 1µL 1536 cassettes' steel plate on the 
front of the Tip Holder faces the pump.
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 1. Slide the Tip Holder   into the 
dispense arm. The Tip Holder’s 
front plate with the BioTek   logo 
or steel plate faces the pump. 
Make sure the tip holder is level 
and snapped into   place.

 2. Extend the rest of the cassette   
under the Peri-pump, so you 
can slide the   Center   Holder into 
its slot on the underside of the 
pump. A tab on the   back of the 
center holder fits into a notch 
on the pump. The label   on the 
center holder faces down. 

 3. Align the Tube Tensioner with   
the stainless steel plate as it 
wraps around and up against 
the pump.   Be sure the knobs on 
top of the tensioner fit correctly 
into the grooves   in the stainless 
steel plate as you move both 
parts up and around the   pump 
and click the steel plate into 
place.              
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 4. Return the Pump   Cover to its RUN   position covering the pump.             

 5. Lift the Tube   Organizer over the pump cover. Place it in the fluid vessel, when   
you’re ready.             

 n Make sure the instrument's Cassette Type setting matches the installed 
cassette. See Change the cassette   type setting below.

Change the cassette   type setting

The Peri-pump Cassette   Type setting must be correct. The current setting is 
displayed on the   keypad's Main Menu: PER-(#). 

LHC Keypad

 1. Select   Tools>Instrument 
Utilities

 2. Select   the Peri-pump tab.             

 3. Select   the correct button for the 
Cassette Type   installed.             

 4. Click   Send to update the 
instrument.             

 1. Press   Setup Menu.             

 2. Select   PERI.             

 3. Select PUMP.

 4. Select   CASS. 

 5. Select   the matching setting. 
Optionally, use the Prime and 
Purge buttons to prepare the 
cassette for dispensing.                    

 6. Press   Main Menu to verify the 
change.           

 Tip: You may want to employ the Cassette Requirement Mode feature (as described on 
page 138) to automatically update the instrument's Cassette Type setting when you run a 
protocol. For advanced users with well organized procedures, the EL406 provides the ability 
to change the cassette type setting on-the-fly.   It uses the "Require a specific cassette" 
parameter in  a Peri-pump step to automatically change the cassette type setting if it does 
not match the required   cassette.    
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Prime Trough Inserts

The EL406 ships with special reservoirs that fit into the dispensers’ priming trough 
to capture expensive reagent after priming, rather than discarding it. 

Up to three Prime Trough Inserts are provided:

 l PN 7182043 for the Peri-pump dispenser holds approximately 12 mL

 l PN 7182044 (2) for the Syringe dispensers holds approximately 6.5 mL

 n Without the prime trough insert, the priming trough empties into the regular 
waste bottle.
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Install the Syringe Dispenser Component

The Syringe dispenser is an optional component and ships   separately. Inspect and 
unpack the shipping   container. Skip this part of the installation process if it is not 
applicable.

Install the Syringe Pumps

 1. Place the unit containing the syringe pumps on top of   the EL406 in the hollow 
designed to hold it (top left, with special indentations   for the unit’s feet). 
Alternatively, place the unit on the same   surface as the instrument.             

 2. Plug the interface   cable into the back panel of the EL406 in the port labeled 
Syringe Pump Dispenser. Plug   the other end into the syringe pump unit.             

Install Inline Filter for 32-Tube Dispensers

BioTek ships two 90-micron inline filters with the 32-tube dispense manifolds to 
reduce the chances of clogging the dispense tubes. It is especially important for the 
SB – small bore models.

To install the filters:

 1. Locate and layout the length of tubing that goes between the supply bottle and 
the Syringe pump; it has the Luer fitting on one end. 

 2. Cut the tubing approximately one to two inches (3-5 cm) above the Luer fitting.
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 3. Slide the filter’s nozzle ends into the two ends of the tubing, reconnecting it.

Install Tubing and Manifolds for Syringe Dispenser

For each dispense pump, a set of two tubes with check    valves and two supply 
bottles are provided. The 32-tube dispense manifolds also ship with an optional 
inline filter.

 n The supply bottles have Luer fittings.     Finger-tighten only!

 l Rinse all bottles with deionized or distilled water before use to eliminate 
particles that may have entered during packing or unpacking.

 l Place the supply bottles on the same horizontal plane as the instrument. This 
ensures optimum pump performance.

 l Make sure the tubing is not crimped during installation.

 l Review instructions for installing the Buffer Switching module in place of the 
standard supply bottles on page 47, if you purchased this accessory.

Perform these steps twice, first for Syringe A and then for Syringe B:

 1. First install the inline filter for 32-
tube dispensers, if applicable, (as 
described on page 43). Locate the 
tubing with a      Luer fitting on one 
end. Gently screw the Luer fitting 
into the top of      the supply bottle. 
Finger-tighten only.     

 2. Attach the other end of      the tubing 
from the supply bottle to the bottom 
port of one of      the Syringe pumps.    

EL406™ Microplate Washer Dispenser



Install the Syringe Dispenser Component |  45

 n Make sure the flow-direction arrows      point in the direction that the fluid moves.
    

 3. With the check valve’s      flow-direction arrows pointing away from the pump, 
connect the other tube (without fittings) to the      top port of the Syringe pump.    

 4. Slide the manifold onto      the 
two posts on the dispense 
arm with the tubing end 
closest to the instrument.      
Except for the dual 8-
channel manifold that has 
two manifolds in one 
block, install Syringe A’s 
manifold first. Syringe B’s 
manifold must      be installed 
after Syringe A’s. 

 5. Connect the supply tube  to 
the dispense manifold.   

 n Images of syringes on the instrument, labeled A and      B,  indicate the placement 
of each dispenser’s manifold:      A slides on first, then B.    
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 n Special procedure required for magnetic bead assays! A magnet holds 
the two manifolds in place on the dispense arm. You can remove the magnet 
when necessary for certain assays (as described on page 145).

 

 6. Make sure the manifold has enough slack in the tubing to move down to the 
priming trough and then press the tubing into the black tubing bracket attached      
to the instrument just above the wash manifold and below the Peri-pump (if 
present) to keep the tubing out-of-the-way. 

 7. Repeat the      tubing and manifold installation for Syringe B.

 n Important! If the       dual Syringe Dispenser       was purchased separately from 
the instrument, e.g., at a later date,      you must tell the EL406 that the Syringe 
dispenser is installed. See Update the Instrument to use the Syringe 
Dispenser on page 52.

Syringe Dispenser Check Valves

Note the flow direction arrows on the check valves. Some   are harder to see than 
others. The valves are made of a translucent plastic,   in which the flow direction 
arrows are engraved.
 l PN 68083 — Autoclavable   valves for use with non-organic substances. The direction 

arrows are difficult   to see.              

 l PN 68073 — Check   valves recommended for use with organic substances. They cannot be 
autoclaved.   Direction arrows are easy to see.             

EL406™ Microplate Washer Dispenser



Syringe Dispenser Buffer Switching Module |  47

 n Note: If the check valves are replaced,   it may be necessary to recalibrate the 
syringe backlash to achieve optimum   accuracy performance. See Calibrate 
the Backlash for Syringe Dispenser on page 212 for instructions. 

Make sure the flow-direction arrows on the check valves   point toward the pump 
from the supply vessel, and towards the dispense   manifold from the pump.  

Syringe Dispenser Buffer Switching Module

An optional accessory for the Syringe dispenser, this buffer switching module 
doubles the fluid supply capacity. It lets you set up two supply vessels for each 
syringe pump.

The kit includes:
 l Syringe Buffer Switching Module valve box

 l 4 supply bottles and 4 tubes with Luer fittings

 l Connection cable
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About Buffer Switching

Two distinct Buffer Switching kits are available for the EL406. A washer buffer 
switching module is supplied with certain instrument models ("B" models). In 
addition, a module for the Syringe dispensers can be purchased as an accessory to 
the EL406. However, only one Buffer Switching module can be used at a time. 

When installed, you will define the fluid source in a protocol to match the valve 
label of the supply bottle, A1 or A2 for Syringe A, and B1 or B2 for Syringe B, or 
both. The Quick  Dispense options are limited, SYR-A uses valve A1 and SYR-B 
uses valve B1.

After installing the module, change the instrument settings to enable the feature.

Install the Buffer Switching Module

 n Both the washer's Buffer Switching module and the Syringe dispenser's 
module use the same connection port.

 n First install the inline filter for 32-tube dispensers, if applicable, (as described 
on page 43).

 1. Place the four supply bottles and valve box on the same surface as the 
instrument to optimize performance.

 2. Connect the tubing from one of the supply bottles to “A1” Bottle in the valve 
module.

 3. Repeat step 3 with the other three supply bottles for “A2,” “B1,” and “B2” 
Buffers.

 4. Connect Syringe dispenser A's supply tubing (with a check valve and      Luer 
fitting on one end) to the Fluid Out to Syringe port A on the valve module. 
Gently screw the Luer fitting into the valve. Finger-tighten only.

 5. Attach the other end of      the tubing  to the bottom port of the Syringe A pump.
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 6. Repeat steps for Syringe B.

 7. Connect the valve cable from the Valve Control port on the module to the Valve 
Control port on the back of the instrument.

 8. Change the instrument's  buffer switching setting.   

 The approximate dead   volume for each Syringe dispenser system is 12 mL without 
Buffer Switching. The Buffer Switching unit adds 5 mL per fluid path. Generally, three times
   the dead volume completely primes the system. BioTek recommends modifying the 
predefined prime protocols when using Buffer Switching to account for the difference in 
fluid paths, e.g. increase the number of prime cycles. When using precious fluids,   e.g., 
expensive reagents, you can change the prime parameters: reduce   the volume or number 
of cycles specified in the predefined protocols or create your own protocols. Use the 
priming trough inserts to capture expensive reagents when priming.

Change the instrument's Buffer Switching setting

After installing the Syringe Buffer Switching kit (and whenever it is uninstalled), 
change the setting to tell the instrument its current state:

LHC Keypad

 1. Select Tools>Instrument 
Utilities>Syringe Dispenser

 2. Select the applicable button, 
Installed or not, for the Buffer 
Switching Module.

 3. Click Send  to update the 
instrument. 

 1. Press Setup Menu (button in center 
of keypad).

 2. Select SYR and then BUFMOD.

 3. Select Yes when the buffer switching 
module is installed, otherwise, select 
No.

 n Important: Only one buffer switching unit can be installed at a time, either 
the washer's buffer switching module or the Syringe's. Thus, the instrument's 
settings for these devices work like a toggle, when one is enabled, the other is 
disabled, if applicable.

Install Software/Connect to Computer 

If you purchased BioTek's Liquid Handling Control™ (LHC) Software to control the 
EL406 using your personal computer (PC), please refer to the LHC Installation 
Guide for complete installation and setup instructions.
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Connect to Host Computer

Two cables are shipped with the EL406:

If using the serial cable: Plug one end into the RS232 serial port on  the 
instrument and the other end into an available port on the computer.

If using the USB cable: Plug one end into the USB port on the instrument and 
the other end into an available port on the computer. 

 l If the computer is connected to the Internet, turn on the instrument. Let 
Windows® automatically locate and install the necessary USB drivers (follow 
the online instructions), if applicable or open the link below to download the 
drivers. 

 l Virtual Com Port (VCP) drivers for all Windows operating systems are 
available at http://www.ftdichip.com/Drivers/VCP.htm

 l If the computer is NOT connected to the Internet, install the drivers using the 
supplied “Virtual USB Com Port” driver software CD. 

 n The keypad must be displaying its “Main Menu” for the LHC to communicate 
with the instrument.

Technical Note: Only one of the two communication ports (COM port) on the  
instrument can be used at a time. They cannot be used simultaneously. You 

can use USB  to connect the EL406 to the computer or the RS232 serial port to 
connect to a BioStack or similar robotic device. But you cannot use both ports 
simultaneously, i.e. make sure only one cable is plugged in at a time.

Connect to Power

Warning! Power Rating. The EL406 must be connected to a power receptacle that 
provides voltage and current within the specified rating for the system. Use of an 
incompatible power receptacle may produce electrical shock and fire hazards.

Warning! Electrical Grounding. Never use a two-prong plug adapter to connect 
primary power to the EL406. Use of a two-prong adapter disconnects the utility ground, 
creating a severe shock hazard. Always connect the system power cord directly to a 
three-prong receptacle with a functional ground.

 

The EL406 supports voltage in the range of 100-240 V~ at 50-60 Hz.  
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 1. Plug the power cable into the power cable socket in the rear panel of the 
EL406.

 2. Insert the three-prong plug into an appropriate receptacle. 

Define Instrument Settings

LHC Users Only

When using the LHC to control the EL406, an important first step is 
defining your instrument’s settings. After installing the LHC, you can use the 
desktop icon or the Windows Start button to launch the LHC:

 > All Programs> BioTek> Liquid Handling Control

 1. Click the Name link on the main page and, if required, select the EL406.

 2. Specify the COM Port used to connect the EL406 to the computer (use the 
drop-down list to select the port) and click Test Communication. 
 o Pass: proceed to the next step.

 o Fail: check the Com Port setting. See “About Com Ports” in the LHC Help.

 3. In the Target Instrument Settings dialog that opens, click Get actual settings now, 
and click OK.

Standard Vacuum Pump Users

 n Do not perform this step when using the High Flow vacuum pump (PN  
7100754). High flow pumps are recommended when aspirating 384-and 1536-
well plates with non-surfactant wash buffers  (e.g., pure deionized or distilled 
water). 

Perform this step ONLY if you are using the “standard” vacuum pump (PN 
7103024): increase the Vacuum Dissipate Delay to match your waste container: 1 
second per liter.  For example, if you have a 10 L waste bottle, set the delay to 
10 seconds.

Using the LHC Using the Keypad

 1. Select Tools > Instrument Utilities.

 2. Under “General Settings,” increase 
the Vacuum Dissipate Delay to 
match your waste container: 1 

 1. Press Setup Menu.

 2.  à  Select the arrow (for more 
options) twice.
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Using the LHC Using the Keypad

second per liter. 

 3. Click Send to download this new 
setting to the instrument.

 4. Click Exit to return to the main 
screen.

 3. Select VACDIS.

 4. Use the number pad to set the 
Vacuum Dissipate Delay to match 
your waste container: 1 second 
per liter.

 5. Press Main Menu upon 
completion.

Update the Instrument to use the Syringe Dispenser

If the dual Syringe Dispenser component was purchased separately from the 
instrument, you must update the EL406’s internal basecode. Conversely, when 
the Syringe dispenser is ordered with the instrument, BioTek updates the 
basecode at the factory. Find the calibration data to enter on a label on the 
bottom of the Syringe pump unit.

LHC Keypad

 1. Connect the syringe pump 
unit to the instrument with its 
serial cable. 

 2. Turn on the instrument, 
launch the LHC  and make 
sure it is communicating with 
the EL406 (define the correct 
COM port).

 3. Select Tools>Instrument 
Utilities>Syringe Dispenser.

 4. Under Syringe Dispenser 
Assembly, specify the type of 
pump and the installed 
manifold type and click Send 
to download the data to the 
instrument.

 5. In the Calibration Data section, 
enter the data points on the 
label in the corresponding 
fields, including the Serial 

 1. Connect the syringe pump unit to 
the instrument with its serial 
cable. 

 2. Turn on the instrument, and press 
Setup Menu.

 3. Select SYR > MAN and specify the 
installed manifold type.

 4. Select SYR > CAL.

 5. Press ENTER to skip over the 
Checksum. (You will check this 
code at the end of the procedure.)

 6. Enter the Serial Number (SN) and 
all the data points by pressing 
ENTER after each value. Make sure 
the CAL VOL number onboard 
the instrument matches the Cal Pt 
number on the label.

 7. At the Syringe Setup Menu, select 
TYPE and identify the type of 
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LHC Keypad

Number and click Send. 

 6. Wait for the confirmation 
message and verify the 
Checksum displayed matches 
the Checksum on the label. 
This ensures the data was 
input correctly.

 l Click Retrieve at any time to 
check the Checksum.

syringe pump, Autoclavable or 
Non-autoclavable. 

 8. When finished, select CAL again at 
the Syringe setup menu and 
confirm that the Checksum 
displayed onboard matches the 
Checksum on the label.  This 
ensures the data was input 
correctly.

 n Important: If the Checksum does not match there was a data input error and 
dispense accuracy will be compromised. Redo the procedure, carefully 
comparing the data points on the label to the values entered. 
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Define Startup Preferences (LHC users only)

You can save enormous time creating protocols by following these steps to define a 
New Protocol template and use it at startup.

Create a protocol template

 1.  Click the New button or select File>New. 

 2. Click Name. Select the EL406 and define its Port and Settings.

 3. Optionally, select the Plate Type, fill in the text fields, and add any steps that 
you want all new protocols to include.

 4.  Click Save and assign a unique name, e.g. Template.LHC.

 5. Select Tools>Preferences>New Protocol.

 6.  Select the button for Protocol selected below to use as a template.

 7. Click selected and select the protocol you created as a template.

Define startup behavior:

 8. After completing the steps above, select the Startup Options tab.

 9. Select the button for New Protocol.

 10. Click OK to save your new preferences.
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Verify Performance

Before using the EL406 for the first time, verify that it is operating properly. 
 l When using the LHC, make sure the EL406 is connected to the PC and both are powered 

up. 

 l When running standalone, turn on the EL406.

Using the keypad:

 1. Select UTILS at the main menu.

 2. Select TESTS >       SLFCHK.

Using the LHC:

 1. Click the Name link on the main page and, if required, select the EL406.

 2. Define the COM Port used to connect the EL406 to the computer and Test 
Communication. 

 3. In the Target Instrument Settings dialog that opens, click Get actual settings now, 
and click OK.

 4. Select Tools>Instrument Utilities

 5. On the General Settings tab, click the Perform Self-Check link.

Test results:
 l Pass: no error message is  displayed. 

 l Fail: an error message is displayed. If this happens, note the error code and refer to 
Troubleshooting on page 272 to determine its cause. If the problem is something you can 
fix, turn off the instrument, fix the problem, and then turn the instrument back on. 
Otherwise, contact BioTek’s Technical Assistance Center.

The Qualification Chapter in the operator’s manual provides Installation and 
Operational Qualification procedures to perform after the instrument is installed 
and before the instrument is used in a laboratory environment.  

 n Note: An instrument qualification package (PN 7180527) for the EL406 is 
available for purchase from BioTek. The package contains thorough 
procedures for performing Installation Qualification, Operational Qualification 
and Performance Qualification (IQ/OQ/PQ) and preventive maintenance (PM). 
Extensive Checklists and Logbooks are included for recording results. 
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 n Important! Before operating the instrument, review Optimize Performance 
on page 65. The guidelines include necessary steps to perform before running 
a protocol,  and issues to consider when creating or editing protocols.
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Repacking the EL406

Prior to sending your instrument to us for repair, log into the Customer Resource 
Center (www.biotek.com) to submit a Service Request for a Return Material 
Authorization (RMA). Your serial number is needed to process an RMA.

 n Failure   to comply with the following instructions will void the instrument’s   
warranty. If you have lost the original packing materials, contact BioTek 
TAC to order Part Numbers 7183000, and if applicable, 7183005 for the 
Syringe dispenser module, and 7180031 for the vacuum filtration kit.             

 n Decontaminate the instrument before returning it: See Decontamination on 
page 199.

Prepare the instrument for shipping bracket   installation: 

LHC: Keypad:

 1. Select Tools>Instrument 
Utilities>Washer

 2. Click the shipping bracket link 
under Service Functions.             

 1. Press Setup Menu.

 2. Select WASH >           PARK.

 3. Remove the Peri-pump’s   cassette and the Syringe dispensers’ manifolds, if 
applicable.          

 4. Remove the plate carrier and put it in the   accessories box.              

 5. Uninstall and repack separately the Syringe pump and its accessories, if 
applicable.

 6. Slide the transport rail   into position next to the dispense arm. It will be secured 
in place by   one of the shipping brackets. 

View the illustrations provided:
 l Reverse the steps described   to Remove the Shipping Hardware.             

 l Repacking   illustration 1: install the shipping brackets.             

 l Repacking   illustration 2: put the instrument into shipping boxes. 

 l Repacking the Syringe Dispenser (if applicable) 

 l Repacking the vacuum filtration accessories (if applicable)
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Obtain an RMA number:
 l Contact BioTek TAC to obtain a Return Materials Authorization number,

 l Write "RMA" on the shipping box in large, clear letters,
 l And, include the RMA number in the shipping address label:

BioTek Instruments, Inc.
ATTN: RMA# xxxxx 
15 Tigan Street
Winooski, Vermont  05404  USA

EL406™ Microplate Washer Dispenser



EL406 Repacking |  59

EL406 Repacking 

 n The instrument’s   packaging design is subject to change over time. If the 
instructions in   this section do not appear to apply to the packaging materials 
you are   using, please contact BioTek’s Technical Assistance Center for 
guidance.             
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Repacking the Syringe Dispenser

After preparing the instrument for shipping, and reversing the installation steps, 
pack the Syringe dispenser as shown here:

Fill the foam tray with 
the Syringe dispenser 
accessories and place 
the tray on top of the 
inner foam box 
containing the pump 
and supply bottles.                         
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Repacking the Vacuum Filtration component

Reuse the original shipping container to transport the vacuum filtration equipment.

Put the cardboard panel on top of the 
components and tape the box closed.
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Basic Operation

Two ways to control the EL406

You can control the EL406 using its built-in keypad or with BioTek's Liquid 
Handling Control™ (LHC) software. 

To use the LHC to control the instrument, it must be attached to and 
communicating with your personal computer (PC), and its main menu must be 
displayed. Basic protocols can be created or modified using the LHC, and then 
downloaded to the instrument for stand-alone operation. Learn about 
transferring protocols from the LHC to the instrument in the LHC Help system: 
select the Help menu or click a Help button in a window.

 l Find instructions for using the LHC beginning page 96.

 l Keypad instructions begin on  page 84.

Two ways to wash a plate

The EL406 offers two ways to wash a plate:
 l Quick Wash: using the keypad you can wash a plate by defining a few parameters like 

fluid volume and number of wash cycles and rely on default parameters for the more 
advanced options. See  Quick Wash (Keypad only) on page 86.

 l Run a Wash Protocol: using either the keypad or the LHC you can run a wash protocol 
to wash a plate. You can run a predefined protocol or define your own protocol to specify 
the optimal parameters for your assay. See RUN: Running Predefined Protocols on 
page 67.

Two ways to dispense fluid to a plate

The EL406 offers two ways to dispense fluid:
 l Quick Dispense: using the keypad you can dispense to a plate by defining the fluid 

volume and relying on default parameters for the more advanced options. See Quick 
Dispense (Keypad only) on page 88.

 l Run a Protocol: using either the keypad or the LHC you can run a dispense protocol to 
fill a plate. You can run a predefined protocol or define your own protocol to specify the 
optimal parameters for your assay. See RUN: Running Predefined Protocols on 
page 67.
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Optimize Performance

Here are some guidelines to ensure optimal performance and to prevent problems.

Keep the devices clean and the tubing wet

The most critical factor for ensuring optimal performance is to adhere to the 
Recommended Maintenance Schedule on page 167. Enable AutoPrime to keep tubes 
from clogging.

Prime the tubing to remove air bubbles
 l See Recommendations for Priming the Washer on page 114 

 l See Recommended priming volumes for the Peri-pump on page 135

 l See Recommended prime volumes for the Syringe dispensers on page 141

Peri-pump
 l See Release the tension on the dispense cassette on page 136

Best Practices for all EL406 Devices
 l Fill the supply bottles with sufficient fluid.

 l Note: To avoid spilling fluid when refilling bottles or changing reagents, first release 
the Quick Connector from the bottle cap, use a paper towel to sop up the few drops 
in the cap. Then, refill the bottle.

 l Make sure the bottles, solutions, and tubing are clean and do not contain any particles or 
mold. Solutions that are recycled over several days will grow algae, bacteria, molds, or 
other undesirable organisms.

 l Prime before dispensing. Priming the tubing is the most critical factor in assuring optimal 
performance.

 l Empty the waste bottles and firmly seat the bottles’ caps and quick release connectors. 
To make sure fluid does not back up into the vacuum pump during operation keep the 
waste sensor cable installed and the waste detection sensor activated. If fluid collects in 
the overflow bottle, thoroughly rinse the fluid-level switch and bottle.

 l Check the external tubing connections for kinks and clogs.

 l Put microplates on the carrier with well A1 in the left rear corner as you face the 
instrument, and firmly seat the plate in the carrier.

Before using the Peri-pump
 l For top performance and to preserve precious fluids, Purge the fluid at the end of a 

dispense run and Prime the tubing before dispensing. The tubing is permeable to air. 
When 20 minutes or more have elapsed between dispenses, or less than 20 minutes 
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when using 1 µL cassettes, it is important to thoroughly prime the tubing before 
dispensing.

 l Use the priming trough insert to capture expensive reagents for reuse. The Peri-
pump’s insert can hold up to 12 mL.

 l Filter the dispense fluid to 50 microns before dispensing with the 1 µL cassettes. The 
dispense tips are very small. Filtering the fluid helps prevent clogging.

 l Select the right cassette for the job: match your desired dispense volume to the 
recommended cassette. The smallest recommended volume for a cassette type is one 
aliquot. An aliquot matches the cassette type, 1 µL for the 1 µL cassette, 5 µL for the 5 µL 
cassette, and 10 µL for 10 µL cassette.

 l Dedicate cassettes for specific fluids or applications. Reserving specific cassettes 
for specific uses avoids contamination.

 l When the dispenser is idle, release the Tube Tensioner element of the cassette from 
its place on the pump to minimize unnecessary stretching of the tubing. This is especially 
true for the 1 µL tubing. The best practice is to unload the 1 µL cassette when dispensing 
is completed.

 l To more quickly dispense to 384- and 1536-well plates, use the Instrument Utilities to 
change the Dispense Pattern to Row. If precision is more important than speed, keep 
the pattern set to Column.

Before using the Syringe Dispenser
 l Sufficiently prime the Syringe dispenser to ensure precision and accuracy: increase the 

number of prime cycles to adequately remove all air bubbles from the tubing.

 l Use the priming trough insert to capture expensive reagents for reuse. Each Syringe 
dispenser’s insert can hold up to 6 ½ mL.

Also see:
 l Recommendations for 1536-well hardware on page 114
 l Optimize protocols to improve evacuation below
 l Cell Wash on page 117

Optimize protocols to improve evacuation

When a wash protocol leaves too much residual fluid in the wells, optimize the 
protocol with these recommendations:
 l Add a secondary aspiration to a wash cycle on page 115, including Final Aspirate,

 l Decrease the aspirate Travel Rate,

 l Add a Delay to the Aspirate and/or Final Aspirate step ,

 l Lower the aspirate height (Z-axis position).
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RUN: Running Predefined Protocols

BioTek provides numerous predefined protocols for maintaining the instrument 
in top condition and for qualifying its performance. Review  the Predefined 
Protocols on page 69.

To run a defined protocol:

LHC Keypad

 1.  Select Open and locate the 
EL406 folder.

 2. Open the EL406 folder to access 
the more folders.

Important: Be sure to Customize the 
Predefined Protocols below

 1. At the main menu, press RUN.

 2. Press Options to scroll to the 
desired protocol or use the arrow 
and number keys to enter its 
number.

 3. Press ENTER and follow the 
prompts.

Creating Protocols: Washing, Aspirating and Dispensing Fluid

In addition to the quick routines available from the keypad’s main menu, you can 
define and run protocols. Protocols offer more parameters, giving you the ability to 
fine-tune instrument performance, and perform more complex processing. 

Keypad Control    

  Find instructions for creating and modifying protocols using the keypad 
beginning  page 89.  

Liquid Handling Control™ (LHC) Software

 Launch the LHC software to create or modify protocols,  see page 96.

 Select Help>Help Topics to learn about the LHC.

LHC Users Only: Customize the Predefined Protocols

BioTek provides predefined protocols for maintenance   routines and instrument 
qualification tests. You can quickly customize the   protocols for regular use. 
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  The LHC keeps track of the  last-used COM port for an instrument type. For example, 
when an EL406 runs a protocol, the LHC logs the COM port used and the next time an EL406 
is used, the LHC applies the same COM port setting. You can disable this feature by defining 
your Ports preference: select Tools>Preferences>Ports. 
To correct the COM port for the current protocol, click the Port link  and use the drop-down 
list to select the correct value. The LHC stores the COM port value in the protocol file. 

With the EL406 connected to and communicating   with the host computer (i.e. 
make sure the instrument is turned on and not busy):

 1. Click   the Open button, locate the EL406   folder and click Open.             

 2. Open   the Maintenance or other folder   and select the desired protocol.             

 3.  Change the COM port   if necessary: click Port and enter the   correct value 
or select from the drop-down list.             

 4.    Click Settings, which opens the Instrument   Settings dialog.             

 5. Under   Get settings from: click the instrument   link.             

 6.  Click Validate.              

A "Validation successful"   message is displayed unless the protocol cannot be 
run on your instrument.   See LHC Protocols Explained on page 99.

 7.  Save the protocol.             
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Predefined Protocols Listing

Maintenance Protocols

Daily 
Maintenance Description

W-DAY_
RINSE

Simple one-step protocol to fully flush the system with water or reagent   to 
keep the manifold tubes clog-free. Defined for use with Buffer A; 500   mL 
total volume.

S-DAY_
RINSE_A&B

Two-step protocol to flush tubing for both syringe pumps (A & B).   40 mL 
per syringe.

P-#UL_CASS_
RINSE 

Where # matches the cassette in use. Simple one-step protocol to flush   
Peri-pump tubing. 

W-
OVERNIGHT_
LOOP

Protocol designed to keep the manifold in a wetted condition overnight   or 
for a long downtime period; manifold tubes are submerged in fluid for   4-
hour intervals between primes in this virtually endless loop. Defined   to use 
Buffer A.

W-RINSE_
AND_SOAK

Identical to W-DAY_RINSE with one addition, the manifold tubes are 
submerged   and soaked for 5 minutes in the fluid.

Periodic Maintenance

W-Decontaminate
W-DECON 
(onboard)

Aids implementation of the recommended decontamination routine. 
When using the LHC, this protocol includes   prompts for first running 
disinfectant from Buffer A and later running   water through the system 
from Buffer B.  

S-Decontaminate
S-DECON 
(onboard)

This protocol includes prompts for first running disinfectant and later   
running water through the system; for Syringe A only. It can be easily   
modified to suit any major cleaning effort.

W-LONG_
SHUTDOWN

Helps implement the routine recommended   for preparing the 
instrument for storage. This protocol includes prompts   for running 
disinfectant from Buffer A, then water from Buffer B, and   lastly, air 
through the system - remove bottle from Buffer C valve.

S-LONG_
SHUTDOWN

Prepares the instrument for long-term storage. This protocol includes   
prompts for running disinfectant, then water, and lastly, air through   
the system. Defined to use Syringe A. 

S-DAY_RINSE Identical to S-DAY_RINSE_A&B except only Syringe A is defined.

W-CLEAN_w-
BUFFER

Combines priming and AutoClean steps to clean and rinse the 
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Periodic Maintenance

W-CLEAN_no-
BUFFR

manifold.   For units with the Buffer Switching module it is defined to 
obtain cleaning   fluid from Buffer B, and rinse fluid from Buffer A. Units 
without Buffer   Switching are prompted to change fluids.

W-PRIME_200 Simple prime routine; defined for Buffer valve A only.

W-PRIME_ALL_
BUFFRS

Consecutively primes each of the Buffer Switching valves beginning 
with   D. Designed for use in the annual instrument verification test of 
the Buffer Switching module.

QC (Quality Control) Protocols

Manifold-Specific  

W-96_DISP_TEST Dispense precision test protocol for 96-tube manifold.

W-96_EVAC_TEST Evacuation efficiency test protocol for 96-tube manifold.

W-192_DISP_TEST Dispense precision test protocol for 192-tube manifold. 

W-192_EVAC_TEST Evacuation efficiency test protocol for 192-tube manifold.

W-1536_EVAC_
TEST

Evacuation efficiency test protocol for 128-tube manifold.

SA-1536_DISP_
TEST

Dispense precision test protocol for 32-tube Syringe A manifold.

SB-1536_DISP_
TEST

Dispense precision test protocol for 32-tube Syringe B manifold.

P-1536_DISP_TEST Dispense precision test protocol for Peri-pump 1 µL cassette and 
1536-well       plate. 

W-96_VAC30_TEST Vacuum filtration evacuation efficiency test for 96-well filter plates 
and also recommended for use in maintenance procedures.

W-384_VAC10_
TEST

Vacuum filtration evacuation efficiency test for 384-well filter 
plates and also recommended for use in maintenance procedures.
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Predefined Sample Protocols

The "Sample" protocols are provided to facilitate   learning. Some samples are model 
specific.

LHC users: You may need to customize the protocols (as described on page 67) to 
match your instrument's settings. 

Serial dilutions

P-96_
DILUTION

Peri-pump serial dilution protocol dispenses 20 µL to 240 µL in 20 µL        
increments to each column of the plate. 20 µL to column 1; 40 µL to 
column       2; 60 µL to column 3; and so on till 240 µL to column 12.

P-384_
DILUTION

Serial dilution protocol dispenses 2 µL to 94 µL in 2 µL increments        to 
each column of the plate. 2 µL to column 1; 4 µL to column 2; and so       on 
till 94 µL to column 24.

S-96_
DILUTION

Syringe dispenser serial dilution protocol dispenses 240 µL to 20        µL in 
20 µL increments to each column of the plate. 240 µL to column 1;        220 
µL to column 2; 200 µL to column 3; and so on till 20 µL to column       12. 
Defined for Syringe A.

S-384_
DILUTION

Serial dilution protocol dispenses 98 µL to 6 µL in 4 µL increments        to 
each column of the plate. 98 µL to column 1; 94 µL to column 2; 90        µL 
to column 3; and so on till 6 µL to column 24. Defined for Syringe       A. 

Cell Wash

W&P-96_CELL_
WASH

Cell wash-dispense protocol uses the special low-flow tubing, optimal        
dispense and aspirate heights, and vacuum delay during the wash step.       
Following the wash, the Peri-pump dispenses 200 µL to each well.

W-CELLWASH_
96

Cell wash protocol designed to minimize cell layer disturbance in 96-
well plates. Aspirate height increased to 50 steps (6.35 mm above plate 
carrier) resulting in increased residual, approximately 100 µL.

W-CELLWASH_
384

Cell wash protocol designed to minimize disturbance to cells  in 384-well 
plates. Aspirate height increased to 50 steps (6.35 mm above plate 
carrier) will cause increased residual volume but help to preserve the 
cell monolayer.

Microplate Manufacturers

W-
COSTARFLAT

Standard wash protocols modified to best position the manifold tubes        
for dispensing and aspirating to Corning Costar flat-bottomed and 
round-bottomed       wells. 

W-COSTAR_
ROUND
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W-NUNC_384 Standard wash protocols modified to best position the manifold tubes        
for dispensing and aspirating to Nunc® flat-bottomed wells, round-
bottomed       wells, and 384-well plates.W-NUNC_FLAT

W-NUNC_
ROUND
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Protocol Parameters Tables

For Wash step parameters see Wash Step Parameters Table on page 77.

Peri-pump Parameters

Step Option Description/Values range Default 
values

Prime  To remove air from the tubing.  

  Volume: 1-3000 µL 300

 Duration: 1-300 seconds 3

Dis-
pense

   

 Volume The per-well volume to dispense: 10

    1 µL cassette = 1 - 50 µL and 0.5 µL (HLF-D) for 
some models*

 

    5 µL cassette = 5 - 2500 µL  

    10 µL cassette = 10 - 3000 µL  

 Flow rate: The rate, μL/second/tube, that fluid is dispensed for 
each cassette type:

Cassette Type 1 μL 5 μL 10 μL
 (μL/sec/tube)
Low 50         120 140
Medium 60 140 160
High 64 160 180

When dispensing 0.5 µL with the 1 µL cassette 
the average flow rate values are:

1 μL Cassette 0.5 μL Dispense
 (μL/sec/tube)
Low 52         
Medium 54       
High 56       

High

 Cassette 
type 
required?:                   

To require a specific cassette type for this protocol. If 
yes, select the type, if no, select ANY. See Peri-
pump Settings to learn more.

ANY
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Step Option Description/Values range Default 
values

 Plate type: Select the plate type, and optionally, limit the 
columns dispensed to. For high density plates, 
skipping certain "Rows" sections is supported, see 
Peri-pump Dispense Pattern on page 109. 

96

 Posi-
tioning:

X- and Y- horizontal axes, Z- height (vertical) axis 
can be adjusted to improve performance. X- and Y-
axes default to 0 steps for all plate types.

Z = plate 
type 
depend-
ent

 Pre-
dispense:

Also called "tip priming," pre-dispense normalizes the 
tips to ensure precise fluid distribution. It dispenses 
into the priming trough immediately before filling the 
plate. Pre-dispense is recommended for most 
applications.  Set volume and number of pre-
dispenses, except, when dispensing 0.5 µL, the 
volume is preset: 0.5 µL for 4 cycles by default.

10 µL
2 cycles

Purge  To preserve fluid in the tubing by pumping it back into 
the supply vessel, i.e. reverses the flow direction.

 

  Volume: 1-3000 µL 300

 Duration: 1-300 seconds 3

Note: *Half-microliter (0.5 µL) dispensing requires a 1 µL cassette. The Cassette 
Requirement Mode behavior is implemented whenever a 0.5 µL volume is requested. 
Make sure a 1 µL cassette is installed and the Cassette Type setting matches it. 
When supported, only a 0.5 µL dispense volume can be requested, not 1.5 or 2.5 µL, for 
example. Perform two dispense steps, one for the half microliter and another at a full 
increment to achieve these volumes.

Syringe Dispenser Parameters

Step Option Description/Values range Default 
values

Prime    

 Flow rate: 1-5 (See dispense step description below) 5

 Volume: 80-8000 µL. To remove air from the tubing. 5000

 Syringe: A or B A

 Cycles: Number of prime cycles to perform 2
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Step Option Description/Values range Default 
values

 Pump 
delay:

0-5000 msec. 0

  When dispensing highly viscous fluids, the tubing's 
check   valves perform more slowly. Delaying the 
syringe pump sufficiently to   allow the specified 
amount of fluid to pass through the check valves 
before   being pumped into the syringe has been shown 
to improve dispense accuracy.   
Begin by setting the delay to 500 msec. Experiment 
with   different settings to determine the optimal value 
for your fluid.

 

 Submerge 
tips:

To soak dispense tubes in the priming fluid for a 
specified duration for cleaning or maintenance 
purposes. If yes, set duration, up to 24 hours, in 
minutes. See Syringe Prime Step to learn more.

0

Dispense    

 Flow rate: Rates 1-5 are dependent on the volume and plate 
type, except for 1536-well plates. See below.

2

 Dispense 
Volume:

5-3000 µL depending on the plate type. 10

 Syringe: A or B or Both A

  With Buffer Switching installed, buffer valves A1 
and A2 supply Syringe A, valves B1 and B2 supply 
Syringe B. When both dispensers are used 
simultaneously a combination of valves is offered.

A1

 Columns: Select the plate type, and optionally, limit the columns 
dispensed to.

96

 Pump 
delay:

(Same as Prime step description above.)  

 Positioning: X- and Y- horizontal axes, Dispense height (Z- or 
vertical) axis can be adjusted to improve 
performance. Default values plate type dependent; 1 
mm higher than the plate height.

 

 Pre-
dispense:

When enabled, dispenses into the priming trough 
immediately before filling the plate. Pre-dispense is 
recommended for most applications. It normalizes the 
tips to ensure precise fluid distribution. Set volume 

10 µL
2 cycles
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Step Option Description/Values range Default 
values

and number of pre-dispenses.

Syringe Dispenser Flow Rates:

Rates are volume and plate-type dependent:

For example, rate 1 must be   used when dispensing between 10-19 µL to a 96-well 
plate. When dispensing   20-49 µL to a 96-well plate, you can use rates 1 or 2. And, 
when dispensing   50-59 µL to a 96-well plate, you can use rates 1, 2, or 3. And so 
on,   as shown in these tables.

96-well plate 16-Tube 8-Tube

Volume 
(µL)

Rate µL/sec/well

10-19 1 450 140
20-49 1-2 600 209
50-59 1-3 750 279
60-79 1-4 900 350

80-3000 1-5 1000 420

384-well plate

Volume 
(µL)

Rate µL/sec/well

5 -9 1 225
10-24 1-2 300
25-29 1-3 375
30-39 1-4 450

40-1500 1-5 500

 n Note:   For 16-channel syringes the µL/sec/well rate accounts for   2 tubes/well 
when addressing 96-well plates and one tube/well for 384-well plates.             

1536-well plate

Volume (µL) 3-3000
The 32-tube manifold flow rates do 
not have minimum   volumes.
The µL/sec/well for each type of 
manifold, Small Bore (SB) and Large 
Bore (LB), is shown:

Rate SB LB

1 56 125
2 58 150
3 60 162
4 62 174
5 64 187

The default rate is 3. 
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See Plate Types Table on page 103 for default Z-axis values or dispense heights.

Wash Step Parameters Table

See Protocol Parameters Tables on page 73 for Peri-pump and Syringe Dispenser 
parameters. See Plate Types Table on page 103 for default Z-axis values or 
dispense heights.

Minimally, a wash step includes an aspirate step followed by a dispense step. 
Select and define each option to customize the parameters for your assay.

Keypad 
name Option Description/Values range Default 

values

CYCLES Number of 
wash cycles:

Each wash cycle first aspirates and then 
dispenses fluid to and from the plate.

3

ASPIR Aspirate Vacuum Filtration: Select standard 
aspiration (Top) or Vac for filtration.

 

 Filtration 
Time:

When applicable, specify duration of 
vacuum filtration in seconds. 5-999

30

 Travel Rate: The rate at which the washer manifold 
travels down into the wells. The selection 
range is 1 to 5 for non-cell-based assays, 
from slowest to fastest. With these rates, 
the tubes slow their descent as they 
approach the defined aspirate height (Z 
Position) to aid complete evacuation of 
the well.

3

  For delicate, cell-based assays, the range 
is 1CW (cell wash) to 4CW and 6CW. 
These rates minimize turbulence in the 
wells. The tubes descend at a constant 
rate to the specified height. Rate 6CW 
creates the least disturbance and 
performs fastest.

 

 Delay: Amount of time the tubes stay at the 
aspirate height before lifting out of the 
wells. Define a delay between 0 - 5000 
ms. Increasing the delay may improve 
evacuation of the wells.

0

 Positioning: X- and Y- horizontal axes, Z- height 
(vertical) axis can be adjusted to 
improve performance. Default Z-axis for 

Z = 29 for 
96-well 
plates;
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Keypad 
name Option Description/Values range Default 

values

384-well plates is 22 steps, 2 for 384-well 
PCR plates, 1536-well plates is 40 steps.

X & Y = 0

 Secondary 
aspirate: 
(except 128-
tube 
manifold)

Also called Crosswise Aspiration. First 
the wells are aspirated using the position 
defined above. The aspirate tubes rise 
and then descend to the secondary 
position to aspirate again. This option is 
not available for 1536-well plates.

No

DISP Dispense   

 Flow Rate:
96-tube & 
192-tube 
manifolds

The rate at which the fluid is dispensed 
from the tubes. For cell-based assays, 
use rate 1 or 2 for gentle washing with 
the 96-tube manifold only. For normal 
dispensing, the range is 3-11, 3 is 
slowest and 11 is fastest.

7

 32-tube 
dispenser:

For 1536-well plate processing, the 
Syringe dispenser flow rates 1-5.

3

 Volume: µL/well dispensed range:
96-tube manifold: 50-3000
192-tube manifold: 25-3000
1536-well (32-tube dispenser): 03-3000

µL/well: 
96= 300
384= 100
1536= 10

 Buffer: Buffer bottle selection. A-D A

 Positioning: X- and Y- horizontal axes, Z- height 
(vertical) axis can be adjusted to 
improve performance. Default Z-axis for 
384-well plates is 120 steps; 83 for 384-
well PCR plates.

Z = 121 for 
96-well plate            
 

 Vacuum 
Delay

Suspends the vacuum pump until a 
certain volume is dispensed. This feature 
is critical to cell wash operations. It 
delays normal aspiration until the 
specified volume has been dispensed to 
the wells. The range is 10 to 350 µL/well.

10

OPTS Options   

 PRE Pre-wash options: Pre-dispense, Bottom 
wash (if applicable)
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Keypad 
name Option Description/Values range Default 

values

 MIDCYC Mid-cycle options: Shake, Soak, Pre-
dispense between cycles,

 

 POST Post-wash option: Final Aspirate  

 FORM Format for washing 384- and 1536-well 
plates: Plate or Sector

 

PRE Pre-wash Actions performed before the wash 
cycles begin

 

 Pre-dispense Quick, small prime to condition the tips 
before dispensing.

No

 Flow Rate: 96-tube & 192-tube manifolds: The range 
is 3-11, 3 is slowest and 11 is fastest.

9

 Volume: µL/tube dispensed range:
96-tube manifold: 50-3000
192-tube manifold: 25-3000
1536-well (32-tube dispenser): 03-3000

µL/tube:
96 = 50
192 = 25
32 = 10

 Number: For 1536-well- 32-tube dispenser: the 
number of pre-dispenses to perform.

2

 Bottom wash Bottom washing adds an initial wash 
cycle to the specified number of cycles. 
Fluid is simultaneously dispensed and 
aspirated to create cleaning turbulence 
(at the specified height). The manifold 
descends to aspirate again and ends with 
a final dispense to fill the wells. Not 
available for 1536-well plates.

No

 Rate: Valid range is 3-11. The cell wash rates, 
1 CW and 2 CW, which use low-flow 
tubing, are available but not 
recommended. Cell wash options are 
designed for gentle washing, while 
bottom wash is designed for vigorous 
washing.

 

 Wash 
Volume:

25-3000 µL/well dispense 250

 Positioning: X- and Y- horizontal axes, Z- height 
(vertical) axis can be adjusted. 
Repositioning the tubes to harder-to-
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Keypad 
name Option Description/Values range Default 

values

reach areas of the wells may the improve 
results.

MIDCYC Between 
cycles

  

 Shake To mix the contents of the plate. No

 Duration From one second to one hour. 5 sec.

 Intensity Intensity Hertz
Slow 7
Medium 13
Fast 19

Medium

    

 Soak Delays wash for the duration to allow 
fluids in the plate to steep or incubate.

No

 Duration From one second to one hour. 30

 Home carrier To perform the shake or soak in the 
home position or not. But, the plate 
carrier is moved home when the total 
duration of the shake and/or soak 
exceeds 1 minute. The vacuum pump is 
turned off in this scenario. Moving the 
plate home prevents contaminating it 
with drops from the manifold.

No

 Pre-dispense 
between 
cycles

To wet or condition the manifold tubes 
between cycles, which is only needed 
after a long soak. Same parameters as 
regular pre-dispense.

No

POST Post wash When all cycles are completed.  

 Final Aspirate A final aspiration is performed to 
completely evacuate the wells. Same 
parameters as regular aspirate step.

Yes

FORM Wash format Manner of processing large-format plates Plate

 Sector Performs the entire wash step on one 
sector of the plate before it moves to the 
next sector.
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Keypad 
name Option Description/Values range Default 

values

 Plate Performs each cycle to the entire plate 
before it starts the next cycle.
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Operating with the BioStack

If you purchased BioTek’s BioStack Microplate Stacker to operate with the 
EL406, here is some important information about running it:

LHC Control:         

 l LHC users: connect both the BioStack and the EL406 to the computer and control them 
with the LHC.

 l The LHC lets you design protocols that integrate BioStack controls with EL406 steps. LHC 
protocols must contain a BioStack loop.

 l In the LHC, select Help>Tutorials, click Sections in the toolbar for a drop-down menu, 
select Controlling the Bio-Stack with LHC. It only takes a couple minutes to 
complete this interactive demo. It is a great way to learn about the special BioStack 
features offered with the LHC.

Keypad Control:

 l The Quick Wash and Quick Dispense options do not function with the BioStack, i.e. the 
BioStack will not deliver a plate. You must create a protocol to process plates using the 
BioStack.

 l You can use the Quick Wash and Quick Dispense Prime options. This is recommended 
especially prior to processing plates, to remove air from the tubing. 

 n Only one of the EL406's communication ports can be used at a time: you can 
plug in either the USB cable to connect it to the PC or the serial cable to 
connect it to the BioStack (but not to both at the same time).

Install and Align the BioStack:

 1. Set up the BioStack according to instructions in your BioStack Operator’s 
Manual to interact with the EL406. Connect it to the:

 o Host computer (PC) when using the LHC to control the EL406.

 o EL406 when using the keypad to control the instrument. 

 2. Align the BioStack’s gripper with the EL406’s plate carrier: 

LHC: Keypad:

 1. Select Tools> BioStack 
Utilities.

 2. Use the Alignment Utility.

Click the Help button for 
detailed instructions.

 1. Press Setup Menu.

 2. Select à

 3. Select BIOSTK.

 4. Select ALIGN.
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 3. Set the BioStack operating mode:

LHC: Keypad:

 1. Press Setup Menu.

 2. Select à

 3. Select BIOSTK.

 4. Select CONF.

 5. Select BIOSTACK.

Fill the BioStack checkbox in the 
main view to enable the BioStack 
action buttons and use them to 
design a protocol that delivers and 
retrieves plates. 

Important: When using LHC to 
control the EL406 and the BioStack, 
the instrument's BioStack 
configuration setting must be set to                           
MANUAL, not "BIOSTACK."

 n To Restack or not? Yes: to keep plates in the same order. No: to save time 
when the plate sequence is unimportant.

 5. Verify the setup: perform a protocol with 1 or 2 plates. 

 At the start of the day, power up the BioStack first, and then the EL406. BIOSTACK2WR: 
Lift the BioStack’s gripper before turning it on.

Robotics integrators: CAD drawings of the  physical dimensions of the EL406 are available 
upon request. Contact BioTek customer service. 

Technical Note: Only one of the two communication ports (COM port) on the  
instrument can be used at a time. They cannot be used simultaneously. You 

can use USB  to connect the EL406 to the computer or the RS232 serial port to 
connect to a BioStack or similar robotic device. But you cannot use both ports 
simultaneously, i.e. make sure only one cable is plugged in at a time.

Keypad Control: When the BioStack is connected to your  EL406, you are 
controlling both instruments using the keypad. Before connecting the EL406 to 
your computer to download basecode or for other reasons, you must first 
disconnect the BioStack from the EL406 and change the Instrument Setting for the 
BioStack:  Press Setup Menu> g> BIOSTK> CONF>MANUAL.
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Introducing the EL406 Keypad

The keypad on the EL406™ Microplate Washer Dispenser features 26-keys and a 
2 x 24-character LCD. The main menu is shown below.

Starting at the top of the keypad, note the main menu and the Soft-keys. Use the 
Soft-keys to make selections. To return to the main menu, press the Main Menu key.

At the main menu, the top line displays AP when AutoPrime is enabled.

 l RUN - to run a previously defined protocol. Use the Options key to select a 
protocol or enter its number. See Predefined Protocols Listing on page 69.

 l QUICK – leads to the Quick Wash and Quick Dispense menus. Depending on 
the devices installed, press Pump to scroll to the WASH, PER for Peri-pump, 
and when the Syringe dispenser is installed, SYR-A, SYR-B, or SYR-BOTH 
quick dispense menus, if applicable:

 o Wash – When WASH is displayed, put a plate on the carrier, set the desired 
parameters and press Start to run a wash routine. See  Quick Wash (Keypad 
only) on page 86. Except when the 1536-well hardware is installed and quick 
wash is not supported.

 l See Quick Dispense (Keypad only) on page 88:

 o Peri-pump Dispenser (PER) options:
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 l First, make sure the PER-# matches its installed cassette type. If not, 
change the setting: See Change the cassette   type setting on page 
41.

 l Press and hold the Prime and Purge keys to execute these actions for 
as long as you hold the key.

 l Set the dispense VOLume using the arrow and number keys, put a 
plate on the carrier, and press Start.

 o Syringe Dispenser: When the dual Syringe dispensers are installed press Pump 
at the quick menu to toggle through the list of dispensers, Syringe A, Syringe B, or 
Syringe-BOTH.

 l Press the Prime key to prime the tubing with 5000 µL of fluid.

 l Set the dispense VOLume using the arrow and number keys, put a 
plate on the carrier, and press Start.

 o Turn On/Turn Off the Vacuum Pump to drain the priming trough. At the Quick 
menu:

 l Press Shift+1 to turn on the vacuum pump.

 l Press Shift+2 to turn off the vacuum pump.

 l Use these key sequences to manually control the vacuum pump 
when dispensing fluid. At times the priming trough fills up and is 
not emptied automatically. This option gives you control in that 
situation.

 o PUMP – to select the device to perform a quick routine.

 o PLATE – to select the plate type for a quick routine. The default plate type  is 96-
well. Press PLATE to  scroll through and select a plate type. See Define the 
Plate Type and Plate Map (or Partial Plate) on page 91 and the Plate 
Types Table on page 103 to learn about the types of microplates supported.

 l DEFINE –  leads to the protocol creation and editing mode: Create or Edit a 
Protocol on page 89.

 l  UTILS – to run system tests, the Adjust Utility, and to define AutoPrime 
parameters.

 l Setup Menu: press this key to access the instrument’s general settings and the 
settings for each of the devices and the BioStack. 

 l The Options key (and sometimes the arrow keys) scroll through the available 
options or settings for the current focus. Shift+Options reverses the scrolling 
direction.
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Quick Wash (Keypad only)

 1. Select QUICK>WASH at the main menu to perform a quick wash (with Buffer A 
when Buffer Switching is installed). 

 2. Press Pump, if necessary, to get to the Quick Wash menu.

96    WASH:003   VOL:0300 uL
PRIME   PARMS   PUMP  PLATE  

Quick Wash Menu

 n Quick Wash is not an option for 1536-well plates. You must define a protocol or 
run a predefined protocol.

The EL406 saves the parameters that were last used to run a quick wash. They are 
displayed in the top-line of the LCD:

 l 96 in the above example is the plate type. Select PLATE to change it; scroll 
through the compatible choices for plate washing with the currently installed 
hardware and press Enter to select the desired plate.  

 l WASH:003 is the number of wash cycles (one aspirate and dispense step per 
cycle). Select PARMS>CYCLE to change the number of cycles to perform.

 l VOL:0300 uL shows the dispense volume per well in microliters. 

 To change the dispense volume, use the arrow keys to move the 
cursor to the desired number position. The cursor appears to underline a number: 
0010. When the correct position is selected, use the number pad to enter the desired 
value. Or, press Options to increment the value, Shift+Options to decrease the value.

 l Buffer is offered on washers with Buffer Switching to select the buffer valve. 
The current selection is displayed in the top right corner of the LED.

 l PRIME to flush the tubing to remove air bubbles with the desired volume. 

 l PLATE lets you change the selected plate type and define a partial plate run, 
if applicable. See Define the Plate Type and Plate Map (or Partial Plate) 
on page 91.

 l PARMS lets you change the number of wash cycles and the height of the 
aspiration manifold above the wells.

 l PUMP changes the selected device; exits the Quick Wash menu. 

 When the desired values are entered, put a plate on the carrier and press 
Start to run the routine. Up to 10 quick wash routines are saved. When 10 have 
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been defined, the newest replaces the oldest. Use the Options key to scroll the 
quick wash routines to select one.

If Quick Wash is too limited to satisfy your assay requirements, use the LHC or the 
keypad to define a wash protocol. All wash parameters can be defined during 
protocol creation, including those designed for special assays.
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Quick Dispense (Keypad only)

 1. Select QUICK at the main menu to perform a quick dispense. 

 2. Press PUMP (if necessary) to select the dispenser you want to use. Depending 
on how many dispensers are installed, pressing Pump scrolls to the WASHer, 
PER for Peri-pump, or when the Syringe dispenser is installed, SYR-A, SYR-B, 
or SYR-BOTH quick dispense menus, if applicable.

96    SYR-A     VOL:0100 uL
PRIME        PUMP  PLATE 

Quick Dispense Menu

The EL406 displays the last Quick Dispense that was run for the selected device:

 l 96 (displayed above) is the plate type. Select PLATE to change it; scroll 
through the compatible choices for plate with the currently installed 
hardware and press Enter to select the desired plate.

 l PER-# is the Peri-pump cassette setting. Make sure it matches the currently 
installed cassette:          See Change the cassette   type setting on page 41. Refer 
to  instructions for physically changing the cassette: Install the Dispense 
Cassette on page 39. 

 n 0.5 µL dispensing is not an option via the Quick menu. You must 
define a protocol (Half microliter)

 l SYR-A            or SYR-B or SYR-BOTH identifies the Syringe dispenser to be used in 
the Quick Dispense. 

 o When the Syringe Buffer Switching module is installed, SYR-A uses valve A1 and 
SYR-B uses valve B1.

 l VOL:0010 uL shows the dispense volume (not the priming volume) per well 
in microliters (µL). 

 To change the dispense volume, use the arrow keys to 
move the cursor to the desired number position. The cursor appears to 
underline a number: 0010. When the correct position is selected, use the 
number pad to enter the desired value.

 l Prime: At the Peri-pump dispense screen, press and hold the prime key to 
prime the tubing. Fluid flows into the prime trough for as long as you press 
the key. For the Syringe dispensers, PRIME pumps 5000 µL each time it is 
selected.
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 l Empty the priming trough: Turn on/off the vacuum pump when using the 
Quick Dispense menu: Shift+1 to turn it on; Shift+2 to turn it off.

 l Purge: At the Peri-pump dispense screen, press and hold the Soft-key to 
purge the tubing. Fluid is pumped back into the supply vessel as long as 
you press the key.

 l Plate: lets you to change the plate type and plate map or, more accurately, 
the columns of the plate to dispense to. See Define the Plate Type and Plate 
Map (or Partial Plate) on page 91.

 n  153F: For best performance with this plate type use SYR-BOTH (both 
Syringe A and B) and remove the Peri-pump dispense cassette, or remove 
the Syringe manifolds when dispensing with the Peri-pump.

 When the desired values are entered, put a plate on the carrier and press 
Start to run the routine. Up to 10 quick dispense routines are saved for each 
dispenser. When 10 have been defined, the newest replaces the oldest. When the 
desired dispenser is displayed onscreen, press the Options key to scroll through 
the quick routines to select one.

Create or Edit a Protocol (Keypad Only)

At the main menu:

 1. Select DEFINE, and then, CREATE or EDIT.

  CREATE EDIT

2. Name the protocol and select the 
Plate Type.  Press Enter after 
making selections to proceed. See 
 How to name a protocol 
(Keypad only) on next page

Select the protocol to edit: enter 
its number or use the Options key 
to scroll through the stored 
protocols to select one. Then, you 
can edit the name and plate type, 
if desired. Press Enter to proceed. 

3. Define or modify the plate type using the Previous and Next buttons to 
scroll through the supported Plate Types.

4. Select ADD to define the first 
step: then, select the device to use 
or SHAKE to mix or soak the 
plate’s contents.

EDIT the first step or press the 
Options key to scroll to the step 
you want to change in a multi-step 
protocol.

 5. Select the device to use:

 
WASHR To use the wash manifold to wash, dispense or aspirate fluid 

or to run AutoClean.
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PERIP To dispense fluid using the Peri-pump dispenser. Select 

HLF-D for 0.5 µL, if applicable.

 
SYRNG To dispense fluid using one or both of the Syringe 

dispensers, A or B.

 
SHAKE To mix the contents of the plate and/or soak or steep the 

fluids for a specified time period.

 

5.
6.

Select the action you want the device to perform and then define the 
step’s parameters.  Press Enter to proceed.

6.
7.

Keep Added Step? Save Step Changes? 

  Select Yes or No using the Soft-keys to save or discard your inputs for 
the current step.  

* 
Press Main Menu to end the session at any time. Then, select RUN 
and select the protocol to run it. 

See Protocol Parameters Tables on page 73 for valid ranges.

How to name a protocol (Keypad only)

NAME:
- % & _

 

At the Name screen when you are creating or editing a protocol, you can enter 
up to 16 alphanumeric characters to name the protocol:

 l Press Shift + the number key for A-H, or scroll through the alphabet with the 
Options key for A-Z.

 l Press Shift +Options to reverse direction.  

 l Use the arrow keys ◄ ► on either side of the Options key to move the 
cursor within the display. 

 l Press its Soft-key to add one of the four symbols (- % & _) in the display to 
the protocol name. 

 l Press ENTER when you are finished to store the protocol name.
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 n If the name already exists, an Invalid Protocol Name message displays and 
you must enter a unique name.

Define the Plate Type and Plate Map (or Partial Plate)

The EL406, depending on the currently installed hardware, can process 96-well, 
384-well, and 1536-well plate types. Washing and dispensing to a part of the plate 
is limited by the foot print of the hardware. When washing 384- and 1536-well 
plates, you can choose the sectors to be processed or skipped. When dispensing 
you can skip certain columns in any plate type. This requires defining a “plate 
map.” By default, the whole plate is processed. 

Quick Routines: Quick Wash and Quick Dispense

 l When defining a quick routine, select Plate with the Soft-key to set the plate 
type, and to define the plate map. 

Protocols: Wash and Dispense

 l When creating or editing a protocol (Define mode), set the Plate Type after 
naming the protocol.  Use the                      Next or Previous button to scroll through the 
options. 

 l To define the plate map (i.e. the columns, and rows when using the Peri-
pump):

 o Wash step: select OPTS >      FORM. First choose the processing mode Sector or 
Plate (described below). Then, proceed to the plate map screen.

 o Dispense step: press Enter to proceed to the plate map screen. 

To change the plate type:

 l Quick Menu: Repeatedly press the Soft-key under the plate type (in the right corner of 
the display) to scroll through the available options. Hold the Shift key while pressing the 
button to reverse direction. 

Plate Map          Plate Type
g c g g g g g g g g g g                    
  —                                        

Column: 02 . . 12                     96  
                          l

The two-line display changes to show a representation of the current plate type’s 
columns or sectors in the top line. The display shows each column as a filled or 
empty square; empty columns/sectors will not be dispensed to or washed. For 
the current plate type, shown in the right corner, the left corner shows the 
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selection range, beginning with the currently selected column/sector. (In the 
example above, column 2 is currently selected to be skipped.)

 l DEFINE mode: When defining a protocol, press Next or Previous to specify the plate 
type.

g g g g                                
—                                      

Sector: 01 . . 04                 386  
                       l

The two-line display changes to show a representation of the current plate type’s  
sectors in the top line, with each sector as a filled or empty square; empty 
sectors will not be  washed. Press the Options button to toggle the sector to filled 
or empty.

Press the Clear button once to empty all the columns. Press it again to fill all the columns. 
This is useful when you want to dispense to only a couple columns.

g g g g g g g g g g g g g g g g g g g g g g

—                                          
Columns: 01 . . 24       à             1536  
       l                   l

1536-well plates require two screens to show all 48 columns. Select the à key to toggle 
between the two screens to select the columns to dispense to.

1536F - 1536-well Flanged Plates

Important: Crashes can occur! Remove unused manifolds when dispensing to 153F 
plates. 

To prevent an unused Peri-pump cassette  or  Syringe manifold from colliding with 
the plate flange during dispensing:

 l use both Syringe manifolds simultaneously, and,

 l unload the Peri-pump cassette when it is not being 
used;

 l alternatively, remove the Syringe manifolds while 
using the Peri-pump;

 l limit protocols to one dispenser only, either the 
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Syringe or Peri-pump, i.e. run multiple protocols on a 
plate when the assay requires using more than one 
device.

 n See About Wash Processing Patterns on page 105 for plate washing.

To change the plate map (selected columns):

 1. When defining a protocol, press Enter until the plate map screen is shown.

 2. 34 Use the arrow keys to move the cursor to the column/sector you want to 
change. The cursor underlines the currently selected column and its number is 
shown in the display. (In the top example, column 2 is currently selected.)

 3. Press the Options key to toggle between filling the column or not. When the 
image of the column is filled it will be dispensed to. Conversely, when the 
column image is blank or unfilled, the column will not be dispensed to.

 4. Press Enter to save the settings and continue. 

Skip "rows" when Peri-pump Dispensing

The Peri-pump offers an additional way to limit dispensing to a plate:        See 
Dispense Processing Patterns on page 108 .

Wash Step Format: Plate or Sector

When washing a high-density plate you can choose between two processing 
methods, Plate or Sector:
 l Plate format performs each wash cycle to   the entire plate before it starts the next 

cycle.

 l Sector format performs the entire wash   step to each sector of the plate before it 
moves to the next sector. A   sector is defined by the manifold's footprint:

 o 96-tube manifolds process   384-well plates in 4 evenly spaced sectors (quadrants);

 o 192-tube manifolds process   384-well plates in two sectors: even and odd 
numbered columns.

 o 128-tube aspirate manifolds   process 1536-well plates in 12 sectors;

 o 32-tube dispense manifolds   process 1536-well plates in 48 sectors or 24 sectors 
when the manifolds   are used simultaneously.

 Use sector mode when you are concerned about the fluid   drying out before the 
procedure is completed. To learn more See About Wash Processing Patterns on page 
105
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How to shake the plate

These instructions are for keypad control. 

The shake command is tied to the Soak option. These instructions apply to soaking 
or incubating the plate at room temperature, as well as shaking. 

There are two ways to specify a shake period:

 l During a wash cycle: To shake (and/or soak) in between every wash cycle, 
select OPTS when defining Wash Step Parameters and then select MIDCYC, 
and follow the prompts to specify parameters.

 l Shake step: create a protocol to shake the plate, it can be a one-step, shake-
only protocol, or you can ADD a Shake step before or after another step.

 n See Create or Edit a Protocol (Keypad Only) on page 89

 n Soak is not the same as "submerge" the tips. You must define a prime step or 
use the AutoPrime feature to soak the tips in the priming trough.

 n Soak is equivalent to incubating the plate at room temperature or delaying the 
protocol.

 n Shaking and soaking the plate is also an option when defining a Wash step.

How to enter negative numbers (Keypad only) 

Some protocol parameters, like Horizontal Dispense Position (X-axis), require 
inputting a negative number to improve performance.

To enter a negative value:

 1. Using the number pad, start at 00 (zero) and press Shift +Options to display 
the minus sign.

 2. Use the number pad to enter the desired value. The minus sign will remain, 
making it a negative value.
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Using LHC to Control the EL406 Washer Dispenser

BioTek's Liquid Handling Control (LHC) software, which works   with the EL406 
Interface Software (IS), is a more graphically rich way   to design protocols and 
control the instrument. The EL406 must be attached   to and communicating with 
your personal computer (PC) for the LHC to function.   

 n The keypad must be displaying its Main Menu   for the LHC to communicate 
with it.             

Predefined Protocols

BioTek provides predefined protocols for maintenance   routines, instrument 
qualification, and other purposes like serial   dilutions. 

 Click the Open button and locate the   EL406 folder to open a predefined   
protocol. 

Learn   how to Customize the Predefined Protocols on page 67 for your lab.

Communications Port

Click the Port link in the main screen

The LHC needs to know the COM   Port - Communications Port: USB or Serial component 
on the instrument used to connect the washer-dispenser to the computer.   

 n Make sure the EL406 is connected to   the computer, turned on, and not busy.             

 n Learn more About   COM Ports in the LHC Installation   Guide or select 
Help>Help Topics.             

Click Test Communications after   entering the number to verify its accuracy. The 
LHC will display a message.   

If communication is unsuccessful:
 l Check   the cabling: make sure you're using a new/undamaged BioTek-supplied   cable 

and it is properly inserted into the instrument's USB or serial   port.              

 l Turn   on the washer-dispenser: make sure the instrument is on and not   busy 
processing a plate, running AutoPrime, or performing a system test,   for example.             

 l Retry:   contact BioTek TAC if you are still unable to establish communication   between 
the instrument and the PC.             
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Introducing the LHC Workspace

 Instrument Settings: Click the Name link and select your instrument.

 EL406 Steps on the facing page

 Define a Protocol: select Help>Help Topics.
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EL406 Steps

Because the EL406 offers  three devices in one instrument:   a microplate washer, a 
peristaltic pump dispenser called the Peri-pump,   and dual Syringe dispensers, 
there are action buttons for   each component. You will only see buttons that 
correspond to the devices and options available on your configuration of the 
instrument (as defined in Target Instrument Settings.)

Click the action button and define the parameters to add   that step to the 
protocol:

W- for   steps performed by the Washer.

P- for   steps performed by the Peri-pump   dispenser.

S- for   steps performed by one of the Syringe   dispensers, when 
installed.

Shake and soak are device-independent.

Each step is executed sequentially.   You can combine steps performed by 
different devices in one protocol.   For example, a W-Wash can be preceded or 
followed by a P-Dispense. Invalid   combinations of steps will be identified when 
you press the Validate   button.

 See How to define a Protocol (LHC only) on page 102
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LHC Protocols

BioTek provides predefined protocols for maintenance   routines, instrument 
verification, and general samples for common applications   like serial dilutions. 

Review  the Predefined Protocols on page 69

Customize the Protocols

Typically, you must modify the predefined protocols to   match your instrument 
configuration and to meet your assay requirements.

Instrument Settings:   In addition to action steps, every protocol file contains 
instrument   settings, including COM port, manifold type, and so on. Edit the 
protocol   to match your instrument's COM Port and other configuration details: 
 l Customize the Predefined Protocols on page 67

 l Power Users: If you create protocols   for multiple instruments or for other LHC users, 
read   this more detailed description of how the EL406 validates a protocol   to be run on a 
specific instrument.             

 n Recommended:   Before changing  a predefined protocol, select File>Save   As 
and give it a unique name. This practice preserves the custom protocol   in the 
case of a future upgrade.             

File Location

The LHC installs the protocols   in the Windows Common Applications Data Folder:
 l Windows®   XP: C:\Documents and Settings\All Users\Application Data\             

 l Windows®   Vista™ and Windows 7: C:\ProgramData\             

The file location path continues:

[CommonAppDataFolder]\BioTek\Liquid   Handling Control v.#\Protocols\EL406

Three folders are provided:
 l \Maintenance: the recommended daily   and periodic maintenance routines;

 l \QC: some of the quality control or   performance verification procedures;             

 l \Samples: examples of common applications,   including washing 96- and 384-well 
plates, performing serial dilutions,   and a cell wash protocol.             
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LHC Protocols Explained

Prerequisite

This discussion about EL406 protocols will be easier to   follow if you are already 
familiar with the LHC. Read "Understanding the LHC" in the Help.

Protocol Files

In addition to the "Protocol Steps" (the actions you tell the EL406 to perform to 
process plates), each protocol file contains "Instrument Settings."   

The LHC must know an instrument's settings in order to create a protocol that will 
run on that instrument. This virtual "Target Instrument Settings" feature lets you 
write protocols when the instrument is not connected to your computer.                  

Generally, and especially when you are managing only one instrument,   the best   
practice is to always match the instrument settings to your instrument. (Select "Get 
actual settings" from the connected instrument. Unless the instrument is not 
connected to the computer, then, you must specify the settings.)

The "Instrument Settings" stored in the protocol file include the COM port and 
configuration details like the type of manifold/dispense cassette installed, the 
presence of a Peri-pump or Syringe dispenser, and other details that are critical to 
controlling the instrument.

  The LHC keeps track of the  last-used COM port for an instrument type. For example, 
when an EL406 runs a protocol, the LHC logs the COM port used and the next time an EL406 
is used, the LHC applies the same COM port setting. You can disable this feature by defining 
your Ports preference: select Tools>Preferences>Ports. 
To correct the COM port for the current protocol, click the Port link  and use the drop-down 
list to select the correct value. The LHC stores the COM port value in the protocol file. 

Managing Multiple Instruments

The target instrument settings feature is useful for those managing multiple 
instruments. In addition to the flexibility of being able to create protocols for non-
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connected instruments, you can create and save an instrument settings file for each 
of your liquid handlers, another time saver.

Protocols are considered valid when an instrument can successfully perform  the 
protocol. The   LHC will run a protocol even when the instrument settings do not 
match the physical   configuration of the instrument. For example, a protocol with 
instrument  settings that include Buffer Switching can be run by an instrument 
without   Buffer Switching when none of the steps actually call for different   buffer 
valves, i.e. all steps use the same buffer.

Similarly, an EL406 that does not have the Syringe dispenser   installed can run 
protocols with instrument settings that include the   Syringe, as long as the protocol 
does not include any Syringe dispenser   steps. This flexibility is useful when you 
are designing protocols   for multiple instruments. 

Validate versus Run

 Validate checks the action steps against the protocol's   Target 
Instrument Settings.

 Run talks to the instrument to check the action steps   against the 
instrument's onboard settings. 

Validate will catch   errors when the Instrument   Settings have been changed after the 
protocol steps have been defined   and there is a mismatch. Run performs   a similar 
validation before executing the protocol. Errors are not reported   unless the steps 
cannot be performed.  

Target Instrument Settings

 n For LHC users only.

Click the Settings link in the main workspace

Actual Instrument or Simulated Instrument? That is the question for the Target 
Instrument Settings dialog. 

When the EL406 is:
 l connected to the computer: it is best to "Get (the) actual settings" from it;           

 l not connected to the computer: you must define the settings.

One vs. Multiple Instruments
 l If you are running only one instrument, always "Get the actual settings" to identify the 

exact configuration of your EL406 to ensure   it can successfully perform the wash and 
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dispense protocols.

 l If you are managing multiple BioTek instruments (or one instrument with multiple 
configurations): you can create and save a "settings file" for each instrument to help 
create protocols for that instrument when you are not connected to it. See below. 

The "instrument settings" tell the LHC what the instrument can do, e.g. fill a 384-
well plate or not. It is impossible to create a protocol without this information. Read 
this   to understand the correlation between the Target Instrument Settings and the 
protocol.

Get settings from:
 l Instrument:   BioTek configures and tests the EL406 at the factory before shipping it.   If 

you have not changed the instrument's onboard settings, you can safely   click the Get 
actual settings now link to upload the correct settings from the instrument.

 l Settings   file: If you have previously saved the instrument's settings to   a file (using the 
Save link), click this link   to import them.

 l This   screen: manually define the instrument's settings and click OK. This option does 
not affect the instrument's onboard configuration settings. It lets you define protocols for 
an instrument with the specified components.                                       

Configured with: 

Select the appropriate devices to identify your instrument's   components:
 l Washer   Manifold:

96-tube Single                     96-well plates only

96-tube Double 96-well and 384-well plates

192-tube                     384-well plates only 

128-tube Aspriate                     1536-well plates only

 l Syringe   Dispenser: when a dual syringe pump dispenser is installed, identify   the 
dispense manifold type:

 l Non-Autoclavable: the black plastic casing of the non-autoclavable syringes 
are easy to distinguish from the glass and stainless steel autoclavable 
syringes. This model only supports the 8-channel and 32-channel manifolds.

 l Autoclavable: glass and stainless steel autoclavable syringes.

8-tube Double manifold with two sets of 8 tubes.

16-tube 16-channel manifolds.

16-7 tube 16-channel with tubes angled 7°.           

32-tube 1536-well plates only;
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Model: Large Bore (LB) or Small Bore (SB) 

 l Peri-pump Dispenser: when the instrument is equipped with a peristaltic pump for 8-
channel dispensing. 

 l Buffer   Switching: when this external valve module is installed for   automatically 
switching wash buffers/reagents for either the washer or Syringe dispenser. 

 l Vacuum   Filtration: when the instrument is equipped with the special   carrier for 
washing filter-bottom microplates. 

 l Ultrasonic Advantage: when the instrument is equipped with the stainless steel 
reservoir and ultrasonic cleaning capability.

 n Be sure to complete all the steps for   Changing the Washer   Manifold, when 
applicable.

Save Settings File

If you have multiple instruments or use one instrument in   multiple configurations, 
you can create unique settings files for each   configuration and save time when 
defining protocols for that configuration.   

Click the Save link and use Windows'   file-saving dialog to create a .SET file based 
on the currently-selected   parameters. Then use the Get "settings from a previously 
saved" link to load the   parameters.

How to define a Protocol (LHC only)

 n For keypad instructions: Create or Edit a Protocol on page 89

In short:
 o Select the Plate Type and assign a unique Protocol Name Limit the name to 16 

alpha-numeric characters if you want to run the instrument using the keypad 
only, i.e. disconnected from the computer..

 o Click a button in the Add Step area.             

 o Define the parameters for   the step in the dialog that opens.             

 o Continue adding steps, if   desired.             

 o Save   the file and/or click Run to execute the protocol.             

 Double-click   a step in the protocol to open it for editing.
 •  Highlight   a step and press Delete to remove it. 
 •   Click   and drag a step to change its sequence order.
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Plate Types and Processing Patterns

Depending on the type of hardware installed on the instrument, e.g. manifold type, 
the EL406 can process several plate types. The default parameters for wash and 
dispense steps represent the optimal positioning of the hardware for the plate type. 
And, the aspirate and dispense heights and horizontal positions can be adjusted 
when necessary for special situations and to optimize assay performance.
 l Review the Plate Types Table below for a listing of supported plates and their 

geometries;

 l See About Wash Processing Patterns on page 105 in the Help system or operator's 
manual.             

 l See Dispense Processing Patterns on page 108 in the Help system  or operator's 
manual.             

 l Review these instrument settings that may improve your work flow:
 o Plate Carrier Setting

 o Plate Clearance Setting

 o Peri-pump Dispense Pattern

Plate Types Table

Only the Peri-pump can process all plate types. Washer manifolds limit processing 
to plates with the same geometry.          Only the 32-tube Syringe dispenser manifolds 
can dispense to 1536-well plates.

Plate Type
On board

Name
Columns x

   Rows

Plate 
Height

 
Default 

Aspirate/
Dispense   Height

EL406  
sup-
ported

mm Wash-
er

Dis-
pensers

96 Well 96 12x8 14.35 29/121 336 a

 96 Deep Well  96D 12x8 41.50 335  929  

 96 Half Well^ 96H 12x8 14.20 120  332  

96 Mini Tubes 96MT 12x8 49.53 398 1105  

384 Well 384 24x16 14.22 22/120 333 a
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Plate Type
On board

Name
Columns x

   Rows

Plate 
Height

 
Default 

Aspirate/
Dispense   Height

EL406  
sup-
ported

mm Wash-
er

Dis-
pensers

384 Deep Well 384D 24x16 44.08 355 986  

384 PCR² 384P 24x16 9.50 2/83 230 a

1536 Well 1536 48x32 10.41 42/- 250 a

1536 Flanged‡ 153F 48x32 10.26 13/- 196 a

Peri-pump Only Plates

Plate 
Type

Onboard 
name

columns x 
rows

Plate Ht. 
(mm)

Dispense Ht. 
(steps)

Tubes/  
well

6 Well 6 3x2 20.20 464 4*

12 Well 12 4x3 20.20 464  2*

24 Well 24 6x4 20.50 470 2

48 Well 48 8x6 20.10 461  1*

^ Only available for 8-channel manifolds
‡ Only 1536 Flanged (153F) plates have a "flange height" greater than zero. These plates require 
special handling.

 n *Important:   when dispensing to  6-, 12- and 48-well plates some dispense   
tubes must be removed from the fluid supply vessel. See Handling Special 
Plates and Mini-tubes  on page 110
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Plate Geometry Diagram

Plate height = physical measurement 

Default Dispense Height = (plate height - flange height + 1.0 mm)

Travel Height = (plate height - flange height + Plate Clearance)

 n If Dispense Height > Travel Height (greater than), the travel height is changed 
to match the dispense height.

About Wash Processing Patterns
When using a 96-tube manifold to process a 96-well plate,   all wells are processed 
simultaneously.  To process 384- and   1536-well plates, a processing pattern is 
needed, which also provides the ability to process the plate partially. Some   
portions of the plate can be left untouched or panels can be defined, i.e. multiple 
assays can be run on the same plate.

The processing pattern is determined by the hardware's footprint.

32-Tube Syringe Dispenser Manifolds

One 32-tube dispense manifold addresses one column at a   time. When both 32-tube 
manifolds are used simultaneously, they align   with every 5th column, in a pattern 
like this: 

Columns 
1       5       9       13  
  2       6       10       14
    3       7              
      4       8     and so on...
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Columns 1 and 5 are dispensed to first, then columns 2 and 6, 3 and 7, and so on.

During a wash step the dispenser mirrors the pattern defined   for the aspirate 
manifold, dispensing to the same columns in the same   order they were aspirated 
from.

96-tube wash pattern for 384-well plate

To process a   partial plate, you must select the sector or sectors you want to process:

 Checkmarks show the   sectors to be processed. Numbers show 
potential sectors that are currently unselected and will not be washed. The 96-tube 
manifold processes the plate in four sectors.

A B
C D

192-tube wash pattern for 384-well plate

To process a   partial plate, you must select the sector you want to process:
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 Checkmarks show the   sectors to be processed. Numbers show 
potential sectors that are currently unselected and will not be washed. The 192-tube 
manifold processes the plate in two sectors.

A B
   

128-tube wash pattern for 1536-well plate

The 128-tube aspirate manifold processes 1536-well   plates in 12 sectors. When you 
select the columns to process for a partial   plate, they correspond to these sectors.

 or 

In a wash step, click the Columns link: All or Partial to define a partial   plate.

 Selections correspond to the 12 sectors.

In a wash step, the dispenser mimics the pattern   of the aspirate manifold, i.e. 
dispenses to the same columns in the same   order.
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Dispense Processing Patterns

When dispensing to high-density plates, 384- and 1536-well, the 8-channel Peri-
pump and the various Syringe dispensers employ a dispensing pattern to fill the 
plate. The dispenser's footprint determines the pattern required to fill a plate and 
provides the ability to process a partial plate, skipping some sections.

 n Washing Plates: Learn about processing patterns.

Columns

 

To skip an entire column toggle the radio button off. With this feature you can 
dispense to odd columns in one dispense step, change fluids or use another 
dispenser and dispense to even columns in another dispense step.

Rows

The Peri-pump offers another way to control the dispense pattern to high-density 
plates. See Peri-pump Dispense Patterns.

32-Tube Syringe Dispenser Manifolds

One 32-tube dispense manifold addresses one column at a   time. When both 32-tube 
manifolds are used simultaneously, they align   with every 5th column, in a pattern 
like this: 

Columns 
1       5       9       13  
  2       6       10       14
    3       7              
      4       8     and so on...
                           

Columns 1 and 5 are dispensed to first, then columns 2 and 6, 3 and 7, and so on.
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During a wash step the dispenser mirrors the pattern defined   for the aspirate 
manifold, dispensing to the same columns in the same   order they were aspirated 
from.

Peri-pump Dispense Pattern

When addressing high density plates, 384- and 1536-well, the 8-channel cassette 
moves in the pattern described here to fill the plate. With Advanced Dispense 
Options, you can skip certain rows and columns.

Because the Peri-pump cassette addresses every column during a dispense, you 
can specify which columns to skip during a dispense step. 

384-Well Plate 

Rows: You can skip one of the two "rows" sections:

When the 8-channel cassette addresses a 384-well plate, it first dispenses to odd 
numbered rows, and then dispenses to even numbered rows. With this feature you 
can dispense to odd rows in one dispense step, change fluids or use another 
dispenser and dispense to even rows in another dispense step.

In addition, you can combine a selection of  columns with one of the two row 
sections (odd or even) to define a complex distribution pattern.

1536-Well Plate

Rows: You can skip up to three "rows" sections:
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When the 8-channel cassette addresses a 1536-well plate, it first dispenses to rows 
1, 5, 9, 13, 17, 21, and 25. The next section of rows dispensed to includes 2, 6, 10, 14, 
18, 22, 26, and 30. And so on, creating 4 sections of rows. 

Handling Special Plates and Mini-tubes 

Note: Also see the Plate Types Table on page 103.

Peri-pump Only Plates

The Peri-pump supports several plate types, but vessels with fewer than   8 rows 
require special handling. Some adjustment of or consideration of   how the 8-channel 
dispense head will address the plate is needed.  

The Peri-pump’s dispense volume is per tube or channel,   not per well. This is the 
most important fact to consider when using these   special plates. The volume 
defined in a Quick Dispense or protocol is   the amount each tube will dispense to 
the well. 

When you use multiple tubes to address a well, specify the   desired volume with 
this multiple in mind. For example, two tubes can   address each well in a 24-well 
plate, so the "defined" volume must be half   the desired volume. As always, be sure 
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to also consider the Peri-pump’s   optimal performance settings when designing the 
dispense protocol, i.e.   full aliquots are more accurate than fractions of an aliquot. 

Another tool to consider using with special plates is the   X- or Y-axis Dispense 
Position setting. You may be able to use it to aim   the dispense tubes to a certain 
region of the well.

6-, 12-,   24-, and 48-Well Plates

BioTek recommends experimenting with different dispense-tube-to-well   
configurations when using these special plates. For some plates, multiple   tubes can 
dispense to a single well. Conversely, dispense tubes can (and   sometimes, must) be 
removed from the supply vessel or from the cassette   to prevent them from missing 
the wells.

Testing at BioTek found the following capabilities:

Plate   Type Columns/Rows Tubes   per Well Tubes   removed

6 Well 3 x 2 3 or 4 (4 and 5) or   0
12 Well 4 x 3 2 3 and 6
24 Well 6 x 4 2 0
48 Well 8 x 6 1 3 and 6

 l 6-well   plates with 2 rows: three or four tubes can fit in the wells. Remove   tubes 4 and 
5 to use just three tubes per well. Fewer tubes may be preferred   to preserve cells in 
certain assays.              

 l 12-well   plates with 3 rows: two tubes can fit in the wells, so 6 tubes will   be used. 
Remove tubes 3 and 6.             

 l 24-well   plates with 4 rows and large enough wells to support two tubes are   the easiest 
of these special plates. All 8 tubes can be used, 2 per well, for standard microplates. 
Exception: the special 24-vial rack, PN 7212058, requires removing the even numbered 
tubes from the cassette or fluid supply.               

 l 48-well   plates with 6 rows: requires two tubes, 3 and 6, to be removed.              

 n Remember, when defining a run: dispense   volume is per tube, not per 
well. Divide the desired volume by the   number of tubes in a well.             

 If you regularly use 6- or 48-well plates, which require  dispense tubes to be removed 
from   the fluid supply before dispensing, you should consider dedicating certain   cassettes 
for the purpose. Removing the unused tubes from the cassette,   rather than from the fluid 
supply, will preserve them for future use and   make the cassette easier to handle. Review 
the instructions to Replace Peri-pump Dispense Cassette Tubing on page 210.
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1536F - 1536-well Flanged Plates

Important: Crashes can occur! Remove unused manifolds when dispensing to 153F 
plates. 

To prevent an unused Peri-pump cassette  or  Syringe manifold from colliding with 
the plate flange during dispensing:

 l use both Syringe manifolds simultaneously, and,

 l unload the Peri-pump cassette when it is not being 
used;

 l alternatively, remove the Syringe manifolds while 
using the Peri-pump;

 l limit protocols to one dispenser only, either the 
Syringe or Peri-pump, i.e. run multiple protocols on a 
plate when the assay requires using more than one 
device.

To achieve the best dispense performance when processing 1536-well flanged 
plates, the EL406's default protocol settings specify a low dispense height to 
position the dispense tubes as close as possible to the wells. When the dispense 
arm holds multiple dispense manifolds, the manifolds not addressing the wells can 
collide with the plate flanges during a dispense.

Change the Plate Clearance Setting (Keypad)

The Plate Clearance setting adds the specified (input) value to the travel height for 
the selected plate type, i.e. it adds this number to the "Plate Height" value cited in 
the Plate Types Table. The manifold rises to this height to move from one column 
to the next and whenever repositioning is needed.     This setting does not affect 
dispense and aspirate heights.

Use this setting to accommodate plates that are slightly taller than standard     plates 
to make sure the manifolds rise high enough    above the plate to prevent crashes 
when the plate carrier moves. 

Note: Enabling the Magnet Adapter Height affects  the travel height, as well as 
dispense and aspirate heights. The Magnet Adapter Height increases the respective 
values of all height parameters. Generally, it is best to keep the default setting for 
Plate Clearance when using the Magnet Adapter Height setting.

To change the setting using the keypad:
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 1. Press Setup Menu (button in center of keypad).
 2. Select g and ADVANC then PLTCLR.

 3. Enter an offset value in millimeters (mm).          

Change the Magnet Adapter Setting (Keypad)

When performing magnetic bead assays/biomagnetic separation, this offset setting 
is a real time saver. It increases the height or Z-axis for all processing options to 
accommodate the increased height of the plate when the magnet is installed. 

This setting eliminates the need to modify individual protocol parameters to adjust 
the dispense and aspirate heights  and enables Quick Dispense and Quick Wash 
(without adjustments) when the magnet is used. It applies the specified height 
value as an offset to all relevant steps. 

 Custom or non-standard microplates and special adapters for labware may benefit from 
this setting, too. If a vessel's height has been its only limitation to processing with the 
EL406, i.e. the vessel's geometry permits the manifold tips to successfully address its 
wells, this setting can be used to simplify protocol development.

See         Determine Magnet Height Offset on page 130.

After determining the offset value, change the setting using the keypad:

 1. Press Setup Menu (button in center of keypad).
 2. Select g twice and then MAGHT.

 3. Select Yes. This setting tells the instrument if the magnet adapter is currently 
installed or not. It lets you retain the height offset value while turning off its 
application, i.e. when you are no longer using the adapter, change this 
setting to No. The EL406 will remember the offset value.

 4. Enter an offset value in millimeters (mm).            
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About the EL406 Wash Step

 
Minimally, a wash step includes an aspirate step followed   by a 
dispense step. This is a wash cycle.
The default definition of a wash step includes 3 cycles,   followed by a 
final aspiration to evacuate the wells. 
It is important to prime   the washer manifold before running a wash. 
You may also want to include   a Pre-dispense or tip prime (over the 
priming trough) to correct for evaporation and other minor fluid loss   
to normalize the tips. 
About the hardware:     The 96- and 192-tube wash manifolds perform 
both steps, aspirating and dispensing fluid to and from 96-well and 
384-well plates.  Models that support 1536-well   plates have  an 128-
tube aspirate manifold      and two 32-tube syringe-pump dispensers to 
wash the plate.
 
Recommendations for Priming the Washer

 When tubes are empty When changing fluid

With Buffer 
Switching 

Prime 
Volume

Low Flow Prime 
Volume

Low Flow

750 mL 50 mL 900 mL 100 mL

     

Without Buffer 
Switching 

Prime 
Volume

Low Flow Prime 
Volume

Low Flow

360 mL 50 mL 400 mL 100 mL

Recommendations for 1536-well hardware

Our experiments using the 128-tube aspirate manifold and the 32-tube Syringe   
dispenser manifolds yielded the following recommendations. "Your   mileage may 
vary”: experiment with the parameters and settings to   determine the optimal values 
for your assays.
 l High-throughput: to speed   up processing try these settings:             

Aspirate Travel Rate 6 CW

Dispense Flow Rate 5

EL406™ Microplate Washer Dispenser



About the EL406 Wash Step |  115

 l Improve Accuracy: set the   Dispense Flow Rate to 2.             

 l Improve evacuation for the   smallest residuals: use a standard Aspirate Travel Rate, not 
a CW (cell   wash) rate.             

 l Retain fluid in the wells,   increase residuals: increase the aspirate height, Z Position. For 
example,   in our testing, 56 steps, instead of 40, left 3 µL deionized or distilled water in 
each well.             

 Remember   to keep the dispense manifolds wet when not in use: soak the tubes in   the 
priming trough inserts with AutoPrime, for example.              

Add a secondary aspiration to a wash cycle

When too much residual is left in the wells during a wash cycle, you   can add a 
secondary aspiration to reduce it. Secondary aspiration can be performed 
immediately after each aspiration in a wash cycle and/or after the final aspiration 
step. It is not available for 1536-well plates. 

 n Secondary aspiration is also called Crosswise aspiration because it is typically 
performed in a different location within the well. Reposition the tubes by 
defining different X-, Y-, and/or Z-axis positions when enabling the secondary 
aspiration for the most effective evacuation of the wells.

Edit   the Wash step or stand-alone Aspirate step to add a secondary aspiration:

LHC Keypad

 1. Double click the step in the 
protocol to open   it for editing.             

 2. Click   Advanced Options (for 
Aspirate) and enable Perform 
Secondary Aspirate.

 3. Apply a second aspiration to the 
Final Aspirate, also, for best 
evacuation results.

 4. Optionally,   adjust the position of 
the manifold as it addresses the 
wells.              

 1. Edit the Wash step or stand-alone 
Aspirate step: Define>Edit>select 
protocol, and if necessary press 
Options to scroll to the desired 
step.

 2. Select ASPIR and press Enter until 
Secondary Aspirate is offered. 
And/or select OPTS>POST to add a 
second aspiration to the Final 
Aspirate.

 3. Select YES to perform a second or 
crosswise aspiration.

 4. Specify a crosswise position for the 
manifold as it addresses the wells.
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For example, you may want to   adjust the X- or Y- axes to get to hard-to-reach areas 
of certain types   of wells. Or, you may want to lower the height (reduce the Z-axis),   
to better evacuate fluid. 
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Cell Wash

 n Not all EL406 models support cell wash assays. The dual 96-tube wash 
manifold must be installed.

See   how to Define a Cell Wash Protocol on next page. 

Low-flow Fluid Path

The EL406 supports cell-based assays that require the addition   and removal of 
buffer solution without disrupting the cells in the wells   of the microplate. Cells are 
often dislodged when fluid is dispensed at   too high a pressure and lost during 
subsequent aspiration of the fluid   from the well unless counter measures are taken. 
The EL406 is equipped   with a low-flow fluid path that provides a "cell wash" 
alternative   for cell-based assays.
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The low-flow tubing is used during a wash step when the   Flow Rate is set to 1 or 
2. It dispenses fluid to the wells slowly enough   to avoid damaging the cells. Note 
that the low flow line is always open,   i.e. some fluid flows through the tubing 
during normal dispenses. For   this reason, priming the low flow tubing is 
recommended for all Prime   steps.

Additional Techniques 

Delay Aspiration: Also critical to cell-based assays   is delaying aspiration to allow 
the slower dispense process to finish   before beginning fluid removal from the well. 
This option, offered as   part of the dispense step, is called Delay Start   of Vacuum.

Adjust the Aspirate Travel   Rate and Aspirate Height:   when defining the aspirate 
step select one of the specially designed travel   rates that minimize turbulence in 
the wells. Increase   the aspirate height to leave more residual fluid in the wells to 
protect   the cell layer. Also, consider using a secondary aspiration as described in 
the Cell Wash Strategies described below.

Adjust the Dispense Flow   Rate, Height and Position: when defining the dispense 
step be sure   to select one of the special Flow Rates that trigger use of the low-flow   
tubing, 1 or 2 CW. Also reposition the dispense tubes   to aim the fluid at the side of 
the wells to further minimize turbulence. See Cell Wash Strategies on the facing 
page.  

CW+ Dispense Manifold

As a result of BioTek's continuous improvement effort for liquid handlers, the 
washer dispense manifold has evolved. The dispense tubes of the improved 
manifold ensure fluid hits higher on the walls of the well, minimizing damage to 
the cells. "CW+ Dispense Manifold" is  engraved on the top of these newer 
manifolds to make them easy to recognize. If you do not have one of these 
manifolds you may need to experiment with the Washer Settings  (the CW+ Control) 
to improve the performance of your cellular assays. Contact BioTek to obtain this 
special cell wash manifold.

Next: Define a Cell Wash Protocol below.

Define a Cell Wash Protocol

Adjust the volumes recommended in this procedure to meet   your specific needs. 
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 1.    Create a new protocol.             

 2.  Add a Prime   step, especially when the lines are empty or when 
changing fluids.

 3.  Add a Wash step and define it as you normally   would, except 
with these special parameters:             
 o Set the Aspiration Travel Rate   to 6 CW and the Delay   to 0.             

 o Set the Dispense Flow Rate to 1   or 2.             

 l Click the Dispense Advanced Options link and enable the Delay start of Vacuum   
until sufficient fluid has been dispensed. For small dispense volumes,   BioTek 
recommends setting the delay volume to equal your dispense volume.             

 l Reposition the dispense tubes to aim fluid at the side of the wells to reduce turbulence   
and change the aspirate height to increase the amount of residual fluid   left in the well to 
protect the cell layer. See Cell Wash Strategies below.

 Be sure to check the parameters for Final Aspiration.

Cell Wash Strategies

To give you a starting point for optimizing your own assays, here are some 
recommendations for improving your cell wash assays:     
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Repositioning the dispense and aspirate tubes helps minimize turbulence in the 
wells, preserving more cells. Using a standard 96-well Corning Costar plate, best 
results were achieved with these values:

Dispense Step Settings:
Z - height = 120 steps
X - horizontal position = -45
Y - horizontal position = 0
 

Aspirate Step Settings:
Z = 46 steps
X = 35
Y = 0
Secondary Aspirate:
Z = 80 steps
X = -45
Y = 0
About 40 µL/well residual fluid is 
retained using these values.

  For loosely adherent cells, the best performance was seen by increasing the aspirate 
height and using both a standard and secondary (or crosswise) aspiration. Moving the 
aspirate tubes from one side of the well to the other prevents a fluid stream from forming 
and dislodging the cells. Increased residual in the well means increased cell retention.

Best practice:

 l Use the Adjust Utility to determine the optimal X, Y, and Z axis adjustments needed to 
best position the manifold above the wells during the wash routine.

 l Test the protocol settings by running the protocol using only water and an empty plate 
before actually running your assay to make sure the fluid stream hits the wells as 
desired.

 l Optimal cell wash performance is achieved with BioTek's special CW+ Dispense 
Manifold. "CW+ Dispense Manifold" is  engraved on the top of these newer manifolds to 
make them easy to recognize. If you do not have one of these manifolds you may need 
to experiment with the Washer Settings  (the CW+ Control) to improve the performance 
of your cellular assays. Contact BioTek to obtain this special cell wash manifold.
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Delay Aspiration or Vacuum On Volume Control

Keypad Users: Edit the Wash or Dispense Step>Press Enter till Vacuum Delay 
Vol:

During regular plate washing, aspiration and dispensing   occurs simultaneously. 
This allows "overflow" dispensing, because   the fluid is aspirated before 
overflowing the plate. But, the low-flow   tubing used in cell wash protocols 
dispenses fluid so slowly that aspiration   must be delayed to allow the fluid to 
reach the well. 

     

Use this control to turn on the vacuum pump and begin aspiration only after the 
specified volume is dispensed. For cell wash assays, specify at least 10 µL/well. 

For small dispense volumes, BioTek recommends setting the vacuum-on   volume to 
equal your dispense volume. Refer also to application notes   on the BioTek web site 
for more information (www.biotek.com).
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Vacuum Filtration for Filter Plate Assays

With the optional vacuum filtration accessory kit, you can process most standard-
size filter-bottom microplates. 

To perform filter plate assays:
 l Set up the Vacuum Filtration Accessory on page 31

 l Install the Vacuum Filtration Plate Carrier on page 124

 l Change the Plate Carrier Setting (Keypad) on page 125 or Change the Plate Carrier 
Setting (LHC) on page 124

 l Create a Vacuum Filtration Protocol on the facing page

 l Set up the Vacuum Filtration module

 l Install Vacuum Filtration Plate Carrier   

 l Create a Vacuum Filtration Protocol on the facing page

Find guidelines for controlling the vacuum level in the EL406 Getting Started 
Guide and detailed maintenance procedures in the operator's manual.

Maintenance guidelines: Maintaining the Vacuum Filtration System on page 187

Recommendations for best performance:

Here are some guidelines to achieve the best performance of your filter plate 
assays:

 l Shake the plate to suspend the beads before aspiration. Enable the wash 
cycle option to shake the plate after the dispense and before aspiration. Also 
consider creating a multi-step protocol that begins by shaking the plate.

 l Experiment with the two parameters, aspiration time and vacuum level, to 
determine the best combination of settings for your assay. Start with a brief 
time period and low vacuum to avoid lodging the beads in the filter 
material.      

 l Maintain consistent vacuum during the process with a tight seal:      
 o Use new or defect-free filter plates and make sure they are seated perfectly in the 

carrier; 

 o Make sure all tubing is connected correctly, and leak-free.

Expect to spend some time experimenting with different pressure settings. Follow 
the filter plate manufacturer's recommendations, if available. Generally, bead 
assays prefer low pressure and DNA separation assays prefer higher pressure. The 

EL406™ Microplate Washer Dispenser



Vacuum Filtration for Filter Plate Assays |  123

best performance in tests at BioTek were seen when the pressure was set to 2.5 
inHg.

Create a Vacuum Filtration Protocol

  You may want to begin the protocol with a Shake step to suspend the beads. 

LHC: Keypad:

 1. Click  (or select File>New).

 2. Select the plate type.

 3. Specify a Protocol Name.

 4. Click 

 5. Click Show Wash Options

 6. Fill the checkbox for Vacuum Filtration 
and specify the vacuum duration, Time. 
Optionally, do the same for the Final 
Aspirate.

 1. At the main menu, select 
DEFINE>CREATE and assign a 
unique name to the protocol.

 2. Select the plate type.

 3. Select ADD>WASHR>WASH

 4. Select ASPIR>VAC

 5. Specify the duration to apply 
vacuum.

 6. Select OPTS>MIDCYC and add 
a Shake duration to follow each 
dispense to suspend the beads 
before applying the vacuum.

 7. Select OPTS>POST to either 
disable the Final Aspirate or 
make sure it is defined for 
vacuum filtration.

 8. Experiment with other 
parameters, like number of 
cycles, to optimize the protocol 
for your assay.

 7. Fill the checkbox for Shake/Soak and 
specify the shake duration.

 

Experiment with different settings to determine the optimal parameters to meet 
your goals.
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 n Important: Be sure to change the Plate Carrier setting to match the installed 
carrier.

  Remember to specify the type of aspiration to perform in a Final Aspirate.  Keypad 
users: select OPTS>POST at the Wash Step Parameters menu.

Install the Vacuum Filtration Plate Carrier

Vacuum Filtration Plate Carrier

Connect the tubing to the pressure gauge before installing the carrier.         

After connecting the tubing:

 1. Look   at the underside of the carrier to visualize how it fits in place: its   two legs 
will be positioned on the left and the curved hollow fits over   the transport rail 
on the right. Note the small slit adjacent to the curved hollow. This slit fits into 
the Y-axis Carrier Arm.             

 2. Position the carrier with the evacuation tubing facing forward. Aligning   the 
curved hollow with the transport rail, place the carrier on the rail   so it sits 
properly on the transport rail and into the slot on the Y-axis Carrier Arm. 

 n Important: Change the instrument's Plate Carrier setting to match the 
installed carrier before running a protocol.

Change the Plate Carrier Setting (LHC)

The instrument's onboard settings must match the installed hardware. 
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When you physically change the plate carrier to perform special assays,  you must 
also change the instrument carrier setting to direct the devices to higher or lower 
positions to accurately address the wells:

 1. Select        Tools>Instrument Utilities.

 2. On the General Settings tab, use Plate Carrier Selection drop-down list to 
identify the currently installed carrier: 
 o STD - Standard carrier

 o VAC - Vacuum filtration carrier.

 3. Click Send.

Change the Plate Carrier Setting (Keypad)

The instrument's onboard settings must match the installed hardware. 

When you physically change the plate carrier to perform special assays,  you must 
also change the instrument carrier setting to direct the devices to higher or lower 
positions to accurately address the wells:

 1. Press Setup Menu (button in center of keypad).

 2. Select g and then CARR.

 3. Select the currently installed carrier by pressing its Soft-key: 
 o STD - Standard (Magnet Ready) carrier

 o VAC - Vacuum filtration carrier.
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Biomagnetic Separation - Magnetic Bead Assays

The microplate carrier supports placement of a magnet under the microplate. The 
magnet induces magnetic beads to settle at the bottom of the wells to help retain 
them during  a wash protocol’s aspirate cycle.

The EL406 supports standard microplates and these magnets available for purchase 
from BioTek:

Plate Type Magnet PN

96-well 96 Flat Magnet 7103016

 96 Ring Magnet 7102216

384-well 384 Flat Magnet 7103017

 384 Ring Magnet 7102215

You can use a different magnet if it fits in the carrier and accommodates your 
plates. Contact BioTek TAC or visit the Customer Resource Center at 
www.biotek.com to obtain a drawing of the carrier with its dimensions.

Persons with pacemakers/implants should avoid direct contact. Keep all 
magnetic media, watches, and sensitive electronic devices away from the magnets. 
Credit cards, tapes, and disks can be erased in the presence of a magnetic field. Bodily 
harm [pinching of hands and skin] can result if magnets are not handled correctly. 
Maintain distance between two or more magnets.

Handling and Cleaning the Magnets

For best magnet strength and bead retention, the bottom of the microplate must be 
as close to the magnet as possible. We recommend using flat-bottom plates with 
minimal support “webbing” between the sides of the outer wells and the plate 
skirts.

Handle the magnets with care. Avoid direct contact with the magnet material. Keep 
loose ferrous material away and do not attempt to disassemble.

The magnet should be stored in a cool, dry environment and should be cleaned 
with a damp cloth and mild detergent when exposed to harsh solvents. Do not 
autoclave.

To install the magnet in the proper orientation:
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 l Flat magnet: place in the plate carrier so the text on the side of the magnet is readable;

 l Ring magnet: place in the plate carrier with the small round magnets visible, facing 
upwards.

Realign the BioStack with the Magnet Installed

Using the magnet increases the effective height of the carrier surface (generally by 
at least 7 mm). This shift in the plate position requires a comparable adjustment to 
the BioStack’s gripper movement. Realign the BioStack before using it with the 
magnetic bead assays.

Refer to the BioStack Operator’s Manual for detailed instructions of the alignment 
procedure. To help get you started:

 1. Place the magnet in the carrier and a microplate on top of it.

 2. Launch the BioStack Alignment Utility:

LHC Keypad

Tools> BioStack Utilities> Alignment Utility SETUP >g BIOSTK > ALIGN

 3. HOME the  BioStack and Begin Realignment.

 4. Lower the claw until a 0.050” (1.3 mm) gap between the bottom of the plate and 
the top of the gripper fingers is achieved and save the gripper position.

 5. Put the microplate in the input stack and Verify the alignment.

 Remember to realign the BioStack for non-bead assays, when applicable.

Perform Magnetic Bead Assays

For the best results when performing biomagnetic separation assays:
 l Use the Manifold Stop Screw Adjustment Kit, if necessary.

 l Realign the BioStack with the Magnet Installed 

 l Change the Magnet Height Offset

 l Optimize Magnetic Bead Protocols below

Optimize Magnetic Bead Protocols

Here are some suggestions to consider for optimizing your magnetic bead assays:
 l Plate Type: Flat-bottom plates are recommended for magnetic bead assays because 

more of their well surface sits closer to the magnet, resulting in increased magnet 
strength, than with other plate formats. If you must use round-bottom plates, increase 
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the between-cycle soak time to improve bead separation during processing.

 l  Shake/Soak Step: Begin the protocol with a delay to let the magnetic beads settle. 
Also, specify a mid-cycle soak to let the beads settle after fluid is dispensed to the plate, 
e.g. include a 60 second soak before and between cycles.

 l 6CW Aspirate Travel Rate: select 6CW for the aspirate travel rate. The CW travel 
rates are designed to minimize disruption to cell layers on the bottom of the well. The 
same principle applies to magnetic bead assays.

 l Adjust the Aspirate height: increase the aspirate height setting (Z-axis) which will  
increase the residual fluid in the wells but also preserve the beads. Good results were 
obtained when keeping the aspirate height around 8.0 mm above the plate carrier for all 
but a last Final Aspirate (disabled between cycles).

 l Adjust the Aspirate position: When using Flat Magnets below, position the aspirate 
tubes near the sides of the wells (X-axis), if possible, to improve bead retention.

 l As always, before running assays, we recommend testing new protocols using deionized 
or distilled water and a little Tween® 20 with the desired microplate and a magnet 
installed.

Flat Magnets

Use this information about the flat magnets to fine-tune wash protocol settings:

96F Magnet 7103016

384F Magnet 7103017

The 96- and 384-well magnets are structured differently. Their force fields traverse 
the magnet in opposite directions. Magnetic beads in the wells will be drawn to the 
center. For the best bead retention, reposition the aspirate tubes in the proper axis:

96-well Flat Magnet PN 7103016 

The magnetic force (approx. 6800 Gauss) 
is distributed in a horizontal pattern, 
row-wise, across the plate. Magnetic 
beads are pulled to the center, across the 
well in flat-bottom plates and to the 
button in round-bottom plates. Increasing 
the aspirate height to increase the 
amount of residual in the well may 
improve performance.
Aspirate Settings:

Adjust the Y Position to align the 
aspirate tubes near the well walls, if 
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available. Increase the Aspirate Height (Z 
axis), leaving more residual volume in 
the wells.

384-well Flat Magnet PN 7103017 

The magnetic force (approx. 4300 Gauss) 
is distributed in a vertical pattern, 
column-wise, across the plate.

Adjust the X Position to align the 
aspirate tubes away from the center of 
the well, near the well walls.

Ring Magnets

Use this information about the VP magnets to fine-tune wash protocol settings:

96 Ring Magnet 7102216

384 Ring Magnet 7102215

96 Ring Magnet 
PN: 7102216 

This magnetic bead separator uses 
329 of VP’s 52 MGO magnets (7094 
Gauss). The magnets are arranged  
around each well, pulling the 
magnetic beads to the bottoms and 
edges of the wells. Aspirate from 
the center of the well (the default 
position), when using this magnet. 

384 Ring Magnet 
PN: 7102215 

This magnetic bead separator uses 
425 of VP’s 52 MGO magnets (6994 
Gauss). The magnets are aligned 
with the intersections of the wells, 
pulling the magnetic beads to the 
bottoms and edges of the wells. 
Every well is circled by 4 magnets.  

Aspirate from the center of the well 
(the default position), when using this 
magnet.
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Determine Magnet Height Offset

Use a caliper for the best results or another measuring device.

 

 1. Measure the combined height of the 
plate, magnet, and adapter in 
millimeters.

 2. Measure the plate only.

 3. Calculate the offset:   (plate + magnet + 
adapter)         - plate = Magnet Adapter 
Height Offset

 1. Put a magnet in the adapter and the type of plate you will be using  on top of it.

 2. Measure the distance from the bottom of the adapter to the top of the plate in 
millimeters (mm).

 3. Remove the plate, and measure it alone.

 4. Subtract the stand-alone plate measurement from the measurement value of the 
combined elements. This is the offset value to use.

Example:

25.6 mm = 96-well Corning microplate + 96-well flat magnet + adapter

- 14 mm = 96-well Corning microplate

11.6 mm = Magnet Height Offset

Bottom Wash
Bottom washing adds an initial dispense/aspirate sequence,   another wash cycle, to 
the specified number of cycles. Fluid is simultaneously   dispensed and aspirated to 
create cleaning turbulence (at the specified   height). The manifold descends to 
aspirate again and ends with a final   dispense to fill the wells.

Buffer: Select the buffer to   use, if applicable.

Bottom Wash Volume: Enter the   volume of wash solution to dispense per well 
during the bottom wash.
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Flow Rate: Set the rate. Valid   range is 3-11. The cell wash rates, 1 CW and 2 CW, 
which use low-flow   tubing, when available, are not recommended. Cell wash 
options are designed   for gentle washing, while bottom wash is designed for 
vigorous washing.

Advanced Options

Parameters Description

Bottom Wash 
Height: 
Z-axis Position

The distance between the bottom of the aspirate 
tubes and the carrier   surface. The valid range is 12 
to 175. The value in mm is displayed on   screen.

Horizontal X-axis 
Position  

The left and right position of the dispense tubes 
when the carrier is   beneath the manifold. 

Horizontal Y-axis 
Position

The front-to-back carrier   position (or Y axis) to align 
the microplate with the manifold tubes during   a 
dispense. The range depends on the model.

Delay start of 
Vacuum 

until dispensing this volume. 3000 µL max 

Washer Flow Rates

Washer Dispense Parameter

The default setting   for flow rates is 7, in the middle of the range for standard 
tubing rates   3-11, 3 is the slowest, 11 is the fastest. Slower rates are recommended 
for viscous fluids. 

Dual 96-Tube Manifold: When this manifold is installed, you can select rate 1 or 2 
to use the low-flow tubing to dispense   fluid slowly and gently to avoid damaging 
well contents.   

 l 1536-well   hardware uses the 128-tube aspirate manifold and the 32-tube 
Syringe dispenser,   so these values do not apply.

 Rate                     µL/tube/second                     
  96 tube 192 tube

Cell Wash 1 116* NA*
Cell Wash 2 134* NA*

 3 204 102
 4 244 122
 5 273 136.5
 6 306 153

Default 7 325 162.5

BioTek Instruments, Inc.



132 | Chapter 3: Operation

 Rate                     µL/tube/second                     
 8 352 176
 9 375 187.5
 10 391 195.5
 11 418 209

*Cell Wash flow rates direct fluid through special   low-flow tubing, which is not 
compatible with the single 96-tube and 192-tube wash manifolds. 

Aspirate Travel Rates

Rate mm/sec  

1 4.1 +1 Slowest 

1 CW  4.1  

2 5.0 +1  

2 CW 5.0  

3 7.3 +1 Default rate

3 CW 7.3  

4 9.4 +1  

4 CW 9.4  

5 9.4 +2 Fastest

6 CW 14.7 Recommended rate 
for Cell Wash 
protocols

CW   rates are specially designed travel rates that minimize turbulence in   the wells 
for Cell Wash protocols.   

Standard rates (1-5) show two speeds as they   approach the well because they slow 
down to 1 or 2 mm/sec before reaching   the aspirate height to provide more time to 
aspirate the fluid, improving   evacuation. Conversely, the CW rates do not change 
speeds, they move into   and out of the well as quickly as possible to limit 
turbulence.
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Peri-pump Peristaltic Dispenser

 n Some models do not include a Peri-pump dispenser. When present it is 
installed above the wash manifold.

Quick Dispense-Prime-Purge

In addition to controlling the Peri-pump with defined protocol steps, the EL406 
keypad offers a Quick Dispense-Prime-Purge option using the keypad. (0.5 µL 
dispensing is not available; you must create a protocol to dispense this volume.)

Dispense Cassettes

 n Important: It is imperative that the cassette type setting onboard the 
instrument match the installed cassette! The cassette type is displayed in the 
Main Menu and Quick Dispense menu: PER-# 

 l Install the Dispense Cassette on page 39

 l Change the cassette type setting on page 41

 l Dispense Cassette Diagram on page 38

 l Release the tension on the dispense cassette on page 136
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Peri-pump: How it works

The Peri-pump component dispenses fluid using a peristaltic pump. It works by 
expelling a portion of fluid trapped between advancing rollers. The tubing is 
pinched by the rollers to form a full aliquot or slug. 

Peri-pump drum

The volume of fluid in a single slug depends on the tubing size and linear distance 
between rollers. As the rollers spin, the fluid advances and is expelled at the tip in 
finite aliquots or slugs. The volume of each slug is the amount of fluid squeezed 
between two adjacent rollers.

The stepper motor turns the pump a determined number of steps. The pump drum 
can be advanced in smaller increments than the distance between rollers to expel a 
fraction of the full aliquot. However, the volume of the fractions is variable, 
depending as it does on many factors (exact rotor position, tubing tension, tip 
geometry, etc.). The variation between volumes of fractional aliquots is significantly 
higher than between dispenses done with full aliquots. Thus, the best possible 
performance and reproducibility from dispense to dispense is done in full 
aliquot increments. That is, specifying a 1 µL dispense volume when using the 1 
µL cassette, 5 µL dispense volume when using the 5 µL cassette, and 10 µL 
dispense volume when using the 10 µL cassette. The exception is for instruments 
that support 0.5 µL dispensing. These late-model instruments apply an  offset to the 
stepper motor to ensure precise and repeatable dispenses using a 1 µL cassette to 
dispense 0.5 µL aliquots, which is the only half increment permitted.  Only a 0.5 µL 
dispense volume can be requested, not 1.5 or 2.5 µL, for example.

The tubing cassettes are calibrated by stretching the tubing to the size required to 
accurately dispense the expected volume per aliquot. BioTek calibrates cassettes to 
meet the specifications before shipping them. Over time the tubing’s properties 
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will alter slightly, but the cassettes can be recalibrated to restore expected 
performance, in most cases. 
 l See Performance Specifications on page 15.

 l See Recalibrate the Peri-pump Dispense Cassette on page 211.

Recommended priming volumes for the Peri-pump

Generally, the recommended prime volume is three times the dead volume, where 
dead volume is the total internal volume of the fluid path. 

Cassette Type Dead Volume

1 µL 1.20 mL

5 µL 4.23 mL

10 µL 7.36 mL

However, a primary advantage of the Peri-pump dispenser is its entirely visible 
fluid path. This allows you to prime the tubing until all visible signs of air bubbles 
are dissipated.            

At   the start of the day:

Prime the tubing to prepare for a dispense run.

 1. Reload   the cassette and fill the supply vessel:             
 l When dispensing solutions   not effected by water, prime with the dispense fluid.             

 l When dispensing protein   solutions, first prime the tubing with a buffered saline 
solution to remove   any traces of water in the tubing, then, prime with the dispense 
fluid.             

 2. Hold   the Prime button on the keypad   until fluid flows into the priming trough 
and all visible air bubbles   have been removed.             

At   the end of the day:

Purge the tubing to reclaim the dispense fluid, then Prime   the tubing to flush it 
clean.

 1. Hold   the Purge button on the keypad until the tubing appears empty.             

 2. Replace   the supply vessel with the appropriate rinse fluid:             
 l When dispensing water soluble   solutions, use deionized or distilled water.             

 l When dispensing protein   solutions, first prime the tubing with a buffered saline 
solution to remove   protein particles, then, prime with deionized or distilled water.             

 3. Hold   the Prime button on the keypad:             
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 l 1 µL cassette = 5 seconds             

 l 5 µL cassette = 7 seconds             

 l 10 µL cassette = 10 seconds.             

Release the tension on the dispense cassette

 Important information about dispense   cassettes!

When not in use, BioTek recommends releasing the tension   on the cassette. This 
practice extends its life, preserving the tubing’s   integrity. 

To release the tension:

 

 
 1. Open the Pump Cover.     

 2. Pull out the Cassette Rest. 

 3. Release the spring-loaded   latch that holds in place the Tube   Tensioner 
attached to the pump’s stainless steel plate. It   will rest against the cassette 
rest.
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Peri-pump Dispense Step

 Add a Peri-pump dispense step to the protocol:

LHC Keypad

Click P-Dispense and define the   parameters Select PERIP>DISP or HLF-D*

* 0.5 µL dispensing is supported on certain late model instruments.
Define the Dispense Step 

The LHC and Keypad display these parameters in distinct sequences:

Dispense Volume: Enter   the per well volume in microliters.   The recommended 
values for each cassette type are:             

 o 1 µL cassette = 1 - 50 µL             or 0.5 µL for certain late-model instruments

 o 5 µL cassette = 5 - 2500 µL             

 o 10 µL cassette = 10 - 3000 µL             

Select the Flow   Rate
Cassette Type 1 μL 5 μL 10 μL
 (μL/sec/tube)
Low 50      120 140
Medium 60 140 160
High 64 160 180

When dispensing 0.5 µL with the 1 µL cassette the average flow rate values are:

1 μL Cassette 0.5 μL Dispense
 (μL/sec/tube)
Low 52      
Medium 54    
High 56    

Cassette Type Requirement    

LHC Keypad

 Optionally,  Require (a) specific cassette type to 
run this protocol.              
 l Fill   the checkbox to ensure users install the correct 

cassette type when running   this protocol.                   

 l Leave the checkbox empty   to allow any cassette type 
to be used.             

 l Select ANY to permit any 
cassette type to be used for 
this protocol; 

 l Select a cassette type to 
engage the Cassette 
Requirement Mode option.
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Note: Half-microliter (0.5 µL) dispensing requires a 1 µL cassette. The Cassette 
Requirement Mode behavior is implemented whenever a 0.5 µL volume is requested. 
Make sure a 1 µL cassette is installed and the Cassette Type setting matches it. 
When supported, only a 0.5 µL dispense volume can be requested, not 1.5 or 2.5 µL, for 
example. Perform two dispense steps, one for the half microliter and another at a full 
increment to achieve these volumes.

Pre-Dispense

When enabled, the Peri-pump primes into the priming trough   immediately 
before dispensing to the plate. Pre-dispense is recommended   for most 
applications. It normalizes the tips, to correct for evaporation, for example, to 
ensure precise fluid   distribution. 

See Protocol Parameters Tables on page 73 for details about the remaining 
parameters. 

Require a Specific Peri-pump Cassette

When defining a Peri-pump   step you can require a specific cassette type. Choose 
the   desired behavior when the required cassette is not   installed at runtime:
 l Prompt the user to confirm: provides the best protection   against an unintentional 

mismatch. If the cassette type itself has been   physically changed to match the protocol, 
but the instrument's setting   has not been updated, this option changes the EL406's 
setting upon confirmation.   However, if the cassette has not been changed to match the 
protocol, users   are given a chance to cancel the run, fix the error, and rerun the 
protocol.               

 l Return an Error code: gives robotics programmers   the ability to design and run 
unattended processing routines without fear   of a message screen interrupting the 
operation.              

 l Automatically Set the cassette type: this option   changes the EL406's setting without a 
confirmation. This option is for   advanced users only.             

 n No action is taken when the cassette   type setting matches the protocol's 
required cassette type.             

Note: The Cassette Requirement Mode is automatically enforced when a 0.5 µL 
dispense is requested. In this case, make sure a 1 µL cassette is installed.

LHC Keypad

 1. Select Tools>Instrument 
Utilities>Peri-pump 
Dispenser.

 1. Press Setup Menu (button in center of 
keypad).

 2. Select PERI and then g and then MODE.
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 2. Select the desired Cassette 
Requirement Mode behavior:

 o PROMPT

 o ERROR

 o SET

 3. Select the desired mode by pressing its Soft-
key: 

 o PROMPT

 o ERROR

 o SET

Change the Peri-pump Dispense Pattern (Keypad)

LHC users: Change this setting in the Instrument Utilities.

Select the fill pattern: by column or row for   processing 384- and 1536-well plates.  

 Choose row for faster throughput or column for more precision.             

For high-density plates, the 8-tip manifold must address   the plate multiple times to 
fill it. Column-wise dispensing fills each   column before moving to the next. Row-
wise dispensing fills the first   8 rows, then reverses direction to fill the next 8 rows, 
and so on.  Once it is defined, your pattern preference will apply to   all runs, Quick 
Dispenses and protocols.

 1. Press Setup Menu (button in center of keypad).

 2. Select PERI and then   PATRN.

 3. Select the desired dispense pattern by pressing its Soft-key: 

 l COL - column

 l ROW - row.

Settings for 0.5 µL Dispense

LHC: Tools>Instrument Utilities>Peri-pump Dispenser

Keypad: Setup Menu>PERI>PUMP>HALF

Do not alter these settings without precise instructions from BioTek. 

Peri-pump offsets are required to ensure precise and repeatable dispense 
performance when dispensing 0.5 µL. The default values were determined after 
thorough testing and should not be changed. This control is provided in 
anticipation of potential future changes to the 1 µL cassette tubing. In that case, 
specific instructions to alter the offsets will be provided.

Contact BioTek TAC for assistance if you have questions about dispense performance 
at 0.5 µL.

BioTek Instruments, Inc.



140 | Chapter 3: Operation

Dual Syringe Dispenser

 n Some models do not include a Syringe dispenser. 

Quick Dispense

In addition to controlling the Syringe dispenser with defined protocol steps, the 
EL406 keypad offers a Quick Dispense menu. 

How it works

The Syringe dispenser uses two positive-displacement syringe-type pumps and 
distinct fluid paths to accurately deliver buffer, reagents, and other fluids.

See Syringe Dispenser- Autoclavable vs. Non-autoclavable on page 147 to learn 
the difference between these two options.

Prime the Tubing
 l How to Prime the Syringe dispenser below

 l Recommended prime volumes for the Syringe dispensers on the facing page

 l See also: Syringe Dispenser Maintenance on page 193

How to Prime the Syringe dispenser

Priming the tubing to remove all air bubbles is critical for accurate dispensing. 
There are several ways to make sure the tubing is primed:
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Quick Prime using the Keypad

 1. Select QUICK      at the main menu.

 2. Press PUMP until the Syr-A or Syr-B or Syr-BOTH menu appears, if necessary.

 3. Press PRIME as many times as necessary. 5000 µL is dispensed each time.

Add a Prime step to the Protocol

See Syringe Prime Step on page 1.

Similarly, always include a Pre-dispense (or tip prime) in a Dispense/Wash 
step.

Keep the tubing wet during idle time

Turn on AutoPrime for the Syringe Dispenser on page 156

Recommended prime volumes for the Syringe dispensers

The predefined maintenance protocols for the syringe dispensers   fully prime the 
system, pumping 40 mL through the tubing and pump:
 l S-DAY_RINSE_A&B - to fully prime both Syringe systems             

 l S-DAY_RINSE   - defined for Syringe A only             

Modify these protocols as needed when changing fluids and   performing other 
tasks. For example, make a copy of S-DAY_RINSE for Syringe   B or edit the protocol 
to add another prime cycle when changing fluids   to make sure all previously used 
fluid is expelled and replaced with the   new liquid.

 The approximate dead   volume for each Syringe dispenser system is 12 mL without 
Buffer Switching. The Buffer Switching unit adds 5 mL per fluid path. Generally, three times
   the dead volume completely primes the system. BioTek recommends modifying the 
predefined prime protocols when using Buffer Switching to account for the difference in 
fluid paths, e.g. increase the number of prime cycles. When using precious fluids,   e.g., 
expensive reagents, you can change the prime parameters: reduce   the volume or number 
of cycles specified in the predefined protocols or create your own protocols. Use the 
priming trough inserts to capture expensive reagents when priming.
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Syringe Dispense Step

 Add a Syringe pump dispense step to the protocol:

LHC Keypad

Click S-Dispense and define the   parameters Select SYRNG>DISP

Define the Dispense Step 

The LHC and Keypad display these parameters in distinct sequences:

Select the Syringe   to dispense with:
 o A or B   or Both dispensers: without Buffer Switching module.

 o Buffer Switching options:             when this module is installed choose a compatible 
supply option:

 l for Syringe A select A1 or A2

 l for Syringe B select B1 or B2

 l or select one of the options for Both syringes

 n Both: When both Syringe dispensers are used, they simultaneously dispense 
the specified volume/well to two adjacent columns in a 96-well plate, to odd 
numbered and then even numbered rows in a 384-well plate, and every 5th 
column in a 1536-well plate. Remember to create two prime steps, one for 
each dispenser, to precede the dispense step.

 n 1536-well Flange Plates: Use both Syringe dispensers when processing 
153F plates.

Enter the Volume to dispense per well. The valid   values are 5-3000 µL depending 
on the plate type.             

Define the Flow   Rate: The rate at which the fluid is dispensed. Options   range from 
1-5, 1 is the slowest, 5 is the fastest. The valid rate is   volume dependent. Lower 
rates are recommended for viscous fluids.             
Rates are volume and plate-type dependent:

For example, rate 1 must be   used when dispensing between 10-19 µL to a 96-well 
plate. When dispensing   20-49 µL to a 96-well plate, you can use rates 1 or 2. And, 
when dispensing   50-59 µL to a 96-well plate, you can use rates 1, 2, or 3. And so 
on,   as shown in these tables.
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96-well plate 16-Tube 8-Tube

Volume 
(µL)

Rate µL/sec/well

10-19 1 450 140
20-49 1-2 600 209
50-59 1-3 750 279
60-79 1-4 900 350

80-3000 1-5 1000 420

384-well plate

Volume 
(µL)

Rate µL/sec/well

5 -9 1 225
10-24 1-2 300
25-29 1-3 375
30-39 1-4 450

40-1500 1-5 500

 n Note:   For 16-channel syringes the µL/sec/well rate accounts for   2 tubes/well 
when addressing 96-well plates and one tube/well for 384-well plates.             

1536-well plate

Volume (µL) 3-3000
The 32-tube manifold flow rates do 
not have minimum   volumes.
The µL/sec/well for each type of 
manifold, Small Bore (SB) and Large 
Bore (LB), is shown:

Rate SB LB

1 56 125
2 58 150
3 60 162
4 62 174
5 64 187

The default rate is 3. 

Enable  Pre-dispense to normalize the tips   before dispensing. Enter the volume and 
number of cycles.  

Define the Columns   to dispense to (aka the Plate Map):

 Each button represents a column.
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Select the columns to dispense to using the buttons and   Set and Clear links.   The 
buttons, which represent each column, toggle on and off when clicked.   Toggle them 
on to dispense to the column or off to skip the column. 
 l Each button represents   a column. The Syringe dispenser   can only skip columns, not 

rows. 

 l The number of active   column buttons reflects the Plate Type selected in the main view, 
which   should match the plate you are dispensing to. 

 l Learn about Processing   Patterns for 384- and 1536-well plates. 

Pump Delay

When dispensing highly viscous fluids, the tubing's check   valves perform more slowly. 
Delaying the syringe pump sufficiently to   allow the specified amount of fluid to pass through 
the check valves before   being pumped into the syringe has been shown to improve dispense 
accuracy.   
Begin by setting the delay to 500 msec. Experiment with   different settings to determine the 
optimal value for your fluid.

Change the Syringe Dispenser Manifold

Changing the Syringe manifold requires two steps:
 l Physically changing the Syringe dispenser manifold: See Install the Syringe 

Dispenser Component on page 43.

 l Updating the instrument's   manifold setting; as described below.             

After physically changing the manifold, perform these steps   to tell the instrument 
which one is installed.

 1. LHC: Select Tools>   Instrument Utilities> Syringe Dispenser
Keypad: Press the Setup Menu button, select SYR  and then MAN.

 2. LHC: Under Syringe Dispenser Assembly: Choose the option that represents the 
installed manifold. Look at the top of the manifold to identify its type, which is 
engraved on the top:

8-tube Dual 8-tube manifolds in a single block.

16-tube 16-channel straight tubes
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16-7 tube 16-channel angled 7°                      

32-tube 1536-well plates only;
Model: Large Bore (LB) or Small Bore (SB) 

 3. LHC: Click Send   to send this setting to the instrument.

Special Procedure for Magnetic Bead Assays

Before using the dual Syringe Dispenser to dispense magnetic beads, you must 
remove the magnets that normally hold the dispense manifolds on the instrument. 
Two thumbscrews are shipped with the instrument to replace the magnets. 

 1. Use the 1/16th hex wrench (PN 48713) to 
loosen the set screw on top of the 
manifold.

 2. Take advantage of the magnet’s attraction 
to the hex wrench to remove it from the 
manifold. 

 3. Locate the thumbscrews shipped with the 
instrument’s accessories. After sliding both 
manifolds onto the dispense arm, put the 
screws into the post to hold the manifolds 
in place.

 

 n Store the magnets in the plastic pouch for potential future installation.
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Syringe Dispenser Settings (Keypad)

When installing or making changes to the dual Syringe dispenser, you must update 
the instrument's settings to match the hardware.

Note: LHC users: select Tools>Instrument Utilities>Syringe

To change or review settings using the keypad:

 1. Press Setup Menu (button in center of keypad) and select SYR.

Manifold (MAN)

Select MAN to define the manifold setting. Select the option that matches the 
dispense manifold installed:

8-tube Dual 8-tube manifolds in a single block.

16-tube 16-channel straight tubes

16-7 tube 16-channel angled 7°                      

32-tube 1536-well plates only;
Model: Large Bore (LB) or Small Bore (SB) 

Syringe Type (TYPE)

Select TYPE to define the type of Syringe dispenser installed:
 l Non-Autoclavable (NATCLV): the black plastic casing of the non-autoclavable 

syringes are easy to distinguish from the glass and stainless steel autoclavable syringes. 

 l Autoclavable  (ATCLV): glass and stainless steel autoclavable syringes.

Calibration Data (CAL)

Select CAL to enter (or modify) the calibration data for the Syringes.

Calibration data is critical to achieving expected performance   and it is unique to 
each individual syringe unit. BioTek prints the values   on the bottom of the unit, so 
you have a permanent record of the values.
See Update the Instrument to use the Syringe Dispenser on page 52

Buffer Switching

This optional accessory for the Syringe dispenser, an automated buffer switching 
valve box, can be installed. Make sure the instrument setting matches the current 
state: 
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 l Yes  = buffer switching is installed,

 l No = not installed.

 n Important: Only one buffer switching unit can be installed at a time, 
either the washer's buffer switching module or the Syringe's. Thus, the 
instrument's settings for these devices work like a toggle, when one is 
enabled, the other is disabled, if applicable.

Syringe Dispenser- Autoclavable vs. Non-autoclavable

Two types of Syringe dispensers are available, autoclavable and non-autoclavable. 
It is easy to distinguish them:

Autoclavable Non-autoclavable

Stainless steel and glass pump heads Black plastic pump heads

Glass supply bottles Plastic supply bottles

Amber, transparent check valves White, opaque check valves
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EL406 Instrument Utilities: General

Plate Carrier Selection

The type of plate carrier installed on the instrument must match this setting to 
ensure expected performance. The instrument's basecode keeps track of the optimal 
positioning of its devices for each type of carrier.
 l Standard (Magnet Ready)

 l Vacuum Filtration: special carrier for performing vacuum aspiration or filtration assays. 
This setting must be selected to run a vacuum filtration protocol. 

Instrument Functions (LHC Only)

 l Run the Adjust Utility: To   determine the precise positioning of the dispense 
and aspirate tubes.

 l Reset the instrument: Reboots the instrument, homes   all axes, and performs 
a system test. If you experience problems with   the washer-dispenser, reset it 
to clear any internal errors. If problems   persist, contact BioTek TAC.             

 l Perform Self-check: Homes all axes, drains the   washer's and dispensers' 
priming troughs, and performs the system test.   Any errors will be displayed.

Plate Clearance 

The Plate Clearance setting adds the specified (input) value to the travel height for 
the selected plate type, i.e. it adds this number to the "Plate Height" value cited in 
the Plate Types Table. The manifold rises to this height to move from one column 
to the next and whenever repositioning is needed.     This setting does not affect 
dispense and aspirate heights.

Use this setting to accommodate plates that are slightly taller than standard     plates 
to make sure the manifolds rise high enough    above the plate to prevent crashes 
when the plate carrier moves. 

Note: Enabling the Magnet Adapter Height affects  the travel height, as well as 
dispense and aspirate heights. The Magnet Adapter Height increases the respective 
values of all height parameters. Generally, it is best to keep the default setting for 
Plate Clearance when using the Magnet Adapter Height setting.

Default setting:   1.0 mm. 

Vacuum Dissipate

Delay: 5 second   default value; valid range is 0-50 seconds. 
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 l For high-throughput plate   processing, when using a BioStack and a High 
Flow Pump, for example, eliminate   the delay: set the value to 0 seconds. For 
standalone use, BioTek does   not recommend changing the default setting, 
unless you are troubleshooting.             

About Vacuum Dissipation   Delay: Some equipment requires a delay at the end of a 
run to allow   air into the fluid containers to prevent the vacuum pump from 
overworking.   A delay of 1 second/liter has proved reliable in preventing certain 
pumps   from blowing an auxiliary 5-amp fuse (PN 46055). When necessary, set the   
delay to 10 seconds when using a 10-liter bottle, 20 seconds when using   a 20-liter 
bottle, and so on.

Sensors Enabled

Fill checkboxes to enable the function; empty checkboxes   to disable the function. 

 l Vacuum Detection: verifies sufficient   vacuum to function properly.             

 l Waste Detection: monitors the fluid   level in the waste bottles before 
beginning a run.             

When the sensors are triggered, the LHC displays an explicit   message describing 
the failure or required action. 

 n BioTek recommends keeping the detection   systems activated. One exception 
is when running the system using air   instead of fluid to dry out the components 
before shipping or long-term   storage. In that case, deactivate the detection 
sensors to avoid getting   errors.             

 

Adjust Utility

LHC: Tools>Instrument Utilities>General Information

Keypad: Select UTILS>ADJST from the main menu

The Adjust Utility   is a tool for determining the precise positioning of the dispense 
and   aspirate tubes when addressing the plate. Generally, the components' default   
positions function perfectly, but certain assays may be improved by repositioning   
the dispense or aspirate tubes. For example, to minimize cell damage,   tubes can be 
positioned at the sides of the wells, rather than the center.   Use the utility to identify 
the offsets required, then, enter these offsets   when defining the protocol step.

The Adjust Utility puts the plate in its run position and   lets you position the plate 
in relation to the manifolds. You can:
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 l Raise or lower the manifolds in the Z-axis, to determine the optimal dispense or aspirate 
height, for example. The default   positions are based on the plate type.

 l Position the tubes in the X and Y axes by moving the plate carrier. The default position is 
the center of the well, 0 steps:       

 o Move the carrier left or   right in the X-axis. Negative offsets   move left of center; 
positive offsets are right of   center.

 o Move the carrier forward   and back in the Y-axis. Negative offsets move the plate 
backward from center; positive offsets place the plate forward of center.

Warning:   The Adjust Utility does not have limits to protect you from making bad   
choices. It is possible to identify dispense positions that   miss the wells, for example. If 
incorrect values are defined in the protocol,   you'll have a big mess on your hands.  

Positional Limits: 

The allowable ranges for positioning the devices for operation:

 X Y Z
Washer -60 to 60 steps

2.74 mm offset
-40 to 40

2.96 mm offset
1 to 210 steps
26.68 mm max

Dispensers -60 to 60
2.74 mm offset

-40 to 40
2.96 mm offset

1 to 585 steps
26.75 mm max

  

Run the Adjust Utility (Using the Keypad)

This page describes how to run the Adjust Utility using the keypad rather than the 
LHC. Find LHC instructions in the Help system.  

 l Learn about   the Adjust Utility on previous page.
 l Keep in   mind the positional limits of the devices during operation.

 1. Place a microplate on the carrier.

 2. Select UTILS at the main menu and then select ADJST.

 3. Select the PLATE TYPE. Only valid options for the installed hardware are 
presented for selection. 

 4. Select the device.

 5. Select a run position. Only one position may be viewed at a time.
 o for the Washer choose ASPIR (aspiration) or DISP (dispense) depending on which 

tubes you are measuring offsets for;

 o for the Dispensers, choose FIRST column or LAST column to move the plate to that 
position.

EL406™ Microplate Washer Dispenser



Adjust Utility |  151

 6. At the AXIS screen, choose an axis, Z, X or Y. The top line of the display 
indicates which axis is active, and the offset position of that axis:

Axis Washer                    Dispensers  

Z-axis (up/down) MAN DISP Positions the manifold or dispense arm.

X-axis (left/right) CARX CARX Positions the plate carrier.

Y-axis (front/back) CARY CARY Positions thee plate carrier.

 7. Closely observe the position of the hardware. Use arrow keys:  t (reverse) and 
u (forward) to single-step the offset in either direction.

 8. When the desired offset position is found, record the position number to enter 
later when defining a wash, dispense, or aspirate step.

 9. To quit the Adjust Utility, press Main Menu. The carrier and manifolds return 
to their default positions.

How to use the Adjust Utility- LHC

This page describes how to use the LHC to run the Adjust Utility. See Run the 
Adjust Utility (Using the Keypad) on previous page.

 n Learn about   the Adjust   Utility.

 l Keep in   mind the positional limits of the devices during operation.

 1. Put   a plate on the carrier.

 2. Select   Tools>Instrument Utilities>General   Settings and click Adjust Utility 
under   Instrument Functions. 

 3. Choose   the Selected Device and the starting position   to Measure offsetfrom   using 
the drop-down lists.

 4. Set   the Plate Type.

 5. Click   the Align now link.

The utility positions the plate   according to your selections. Take a close look at 
the current position   of the selected device above the wells to determine the 
required adjustments.
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 6.  Use the radio buttons to select the Axis   you want to adjust.

 7. Use   the Direction buttons to move one step at   a time. Press the companion 
button to reverse direction.

To move multiple steps at a time,   use the numeric field next to the Go to now 
link.   Enter a positive or negative number of steps to move the device or plate   
carrier and click the link. 

The Offset   is shown in number-of-steps and mm. 

 8. Repeat   the process for each axis, as necessary, starting at step 6. 

 9. Jot   down the Offset values so you can enter them   when defining the protocol 
step.

 10. Click   to   end the session.

EL406™ Microplate Washer Dispenser



AutoPrime |  153

AutoPrime

LHC: Tools>Instrument Utilities> AutoPrime 

Keypad: Select      UTIL at the main menu, then     AUTPRM

Recommended for optimum performance, AutoPrime keeps the tubing wet in 
between runs and can be an essential part of your daily maintenance routine.

About AutoPrime

AutoPrime  automatically primes the tubing whenever the instrument is idle for a 
specified time. Keeping the tubes wet  prevents clogging and mitigates fluid 
evaporation at the tips. AutoPrime's   submerge feature lets you soak the tubes for 
extended   periods, which is an effective maintenance option.

The downtime interval is defined for all components, but each device supports 
distinct priming parameters. Devices are primed consecutively,   beginning with the 
syringe dispensers, not concurrently.

Important: Remove the Peri-pump cassette when the Syringe dispenser is set to 
"Submerge." 

"Submerge" is not offered for the Peri-pump because it is not a good practice for 
the dispense cassettes. However, because the cassette Tip Holder resides on the 
same dispense arm as the Syringe dispenser manifold, it will be moved into the 
submerge position when the Syringe tips are submerged. Either remove the cassette 
altogether when soaking the Syringe tips, or remove the prime trough inserts for 
the Peri-pump to prevent cross contamination of fluids or unintended wicking of 
fluid into the cassette.

 n Keep   in mind that any interaction with the EL406 will reset the interval clock.   
And,  AutoPrime only runs when the main menu, quick menu, or run completion 
message is displayed.               

 n When AutoPrime   is running you can press STOP   on the keypad to stop it. It 
will run again the next time the downtime   interval occurs.             

Specify the Interval and AutoPrime Parameters

AutoPrime runs when the instrument has been idle for a specified   interval. One 
interval setting is defined for all devices. 

To set the AutoPrime Interval:
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LHC: Keypad:

 1. Select   Tools>Instrument 
Utilities> AutoPrime tab.              

 2. Specify the idle-time 
interval that will trigger 
an AutoPrime; up to 24 
hours. 

 3. Enable and define the 
parameters for each 
device. Remember to set a 
Submerge Duration to 
employ this option.       

 4. Click   Send to transfer the 
settings to the instrument.
             

 1. Select UTILS at the main menu 
and select AUTPRM. 

 2. Specify the idle-time interval 
that will trigger an AutoPrime; 
up to 24 hours in minutes and 
press Enter.                 

 3. Set the Submerge Duration, if 
desired. You will select the 
device to submerge in a 
subsequent step.

 4. At the AutoPrime Device Menu, 
select the device you want to 
enable.

 5. "Enable AutoPrime."

 6.  For each device, define the 
AutoPrime parameters: rate, 
volume, and buffer valve, if 
applicable. Press Enter at each 
screen to advance to the next. 

 

Turn on AutoPrime for the Washer

 l Learn about AutoPrime, if   you haven't already done so.

 n Keypad users: Select      UTIL at the main menu, then     AUTPRM and specify 
parameters.

 1. Select   Tools>Instrument Utilities>AutoPrime.

 2.  Fill the Enabled   checkbox for the washer.

 3. Set the AutoPrime Interval: enter the downtime interval   that will trigger an 
AutoPrime.               

 4. Select   the Buffer to use if you have Buffer Switching  installed.

 5. Set   the Volume and Rate.   The default values are 40 mL at flow rate 9.
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 6. You   can Submerge the   manifold tubes in the fluid after   the prime, if   desired.    
Set Duration in      Hours   and Minutes.

After the dispense tubes have been primed, the manifold   moves down into the 
priming trough that is filled with the dispensed solution. The vacuum pump is 
turned off and the tubes are allowed to   soak. After the specified duration, the 
vacuum pump is turned on and the   trough is aspirated.

It takes approximately 93 mL of fluid to fill the priming   trough. Be sure to 
specify a volume of fluid that will cover the tubes.

 7. Click   Send to transfer the settings to the instrument.

Keep in mind:

 l AutoPrime can be stopped   when it is underway: press STOP on the keypad.

 l Any interaction with the instrument via the keypad or the LHC resets the 
interval clock.

 l AutoPrime only runs when the main menu, quick menu, or run completion 
message is displayed.

Turn on AutoPrime for the Peri-pump Dispenser

LHC                     Keypad                     

 1. Select   Tools>Instrument 
Utilities>AutoPrime;

 2. Set the AutoPrime Interval: enter the 
downtime interval that will trigger   an 
AutoPrime.             

 3.  Fill the Enabled   checkbox  for the 
dispenser.               

 4. Set   the Volume and Rate.   The default 
settings are 50 µL/tube at the High flow rate.

 5. Click   Send. Wait   for a confirmation message.

 1. Select UTIL>AUTPRM.

 2. Set the AutoPrime Interval: 
enter the downtime interval that 
will trigger   an AutoPrime.             

 3. Select the dispenser.

 4. Set   the Volume and Rate.   The 
default settings are 50 µL/tube 
at the High flow rate.

 5. Press Main Menu, and look for 
AP in the display to confirm that 
AutoPrime is enabled.

Details about Peri-pump AutoPrime

Important: Remove the Peri-pump cassette when the Syringe dispenser is set to 
"Submerge." 

"Submerge" is not offered for the Peri-pump because it is not a good practice for 
the dispense cassettes. However, because the cassette Tip Holder resides on the 
same dispense arm as the Syringe dispenser manifold, it will be moved into the 
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submerge position when the Syringe tips are submerged. Either remove the cassette 
altogether when soaking the Syringe tips, or remove the prime trough inserts for 
the Peri-pump to prevent cross contamination of fluids or unintended wicking of 
fluid into the cassette.

 n Keep   in mind that any interaction with the EL406 will reset the interval clock.   
And,  AutoPrime only runs when the main menu, quick menu, or run completion 
message is displayed.               

 n When AutoPrime   is running you can press STOP   on the keypad to stop it. It 
will run again the next time the downtime   interval occurs.             

When the Peri-pump AutoPrime is Stopped

Because purging and priming the tubing is the best way to remove air bubbles and 
prepare the tubing for accurate dispensing, this routine is executed whenever 
AutoPrime for the Peri-pump is stopped:

 1. Purge: fluid is purged from the tubing, i.e. returned to the supply vessel. The 
volume depends on the cassette type.

 2. Prime: the tubing is primed with the optimal volume of fluid:

Cassette Type Purge Volume Prime Volume

10 µL 250 750

5 µL 150 450

1 µL 50 200

 

Turn on AutoPrime for the Syringe Dispenser

LHC                     Keypad                     

 1. Select   Tools>Instrument 
Utilities>AutoPrime;

 2. Set the AutoPrime Interval: enter the 
downtime interval that will trigger   an 
AutoPrime.             

 3.  Fill the Enabled   checkbox  for the 
dispenser.               

 4. Set   the Volume and Rate.   The default 
settings are 400 µL at rate 3.

 1. Select UTIL>AUTPRM.

 2. Set the AutoPrime Interval: 
enter the downtime interval that 
will trigger   an AutoPrime.             

 3. Select the dispenser.

 4. Set   the Volume and Rate.   The 
default settings are 400 µL at 
rate 3.

 5. Press Main Menu, and look for 
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LHC                     Keypad                     

 5. Click   Send. Wait   for a confirmation message. AP in the display to confirm that 
AutoPrime is enabled.

Note: The Volume dispensed is actually double the input value. The Syringe dispenser 
always performs two prime cycles during AutoPrime, doubling the volume. For example, 
when 400 µL is entered, the dispenser actually primes the tubing with 800 µL.

You   can Submerge the   dispense tubes in the fluid after   the prime, if   desired. This 
requires filling the priming   trough inserts, one for each syringe. Each reservoir 
holds approximately   6.5 mL. More...

After the dispense tubes have been primed, the manifold   moves down into the 
priming trough inserts. When both Syringes are enabled,   the soak duration 
begins after both dispensers are primed. 

The vacuum pump is turned off and the tubes are allowed   to soak. 

 n Important:   When using the submerge option, specify a volume that fills the 
priming   trough inserts with sufficient fluid to cover the tubes, e.g. 6000 µL.   
And, be sure to use the priming trough inserts when the option is enabled.   
Learn more about soaking the dispense tubes... 

Set the Submerge Duration and fill the Submerge checkbox to enable this option.

 n Remove the Peri-pump cassette or its priming trough insert when soaking the 
Syringe dispensers.

Important: Remove the Peri-pump cassette when the Syringe dispenser is set to 
"Submerge." 

"Submerge" is not offered for the Peri-pump because it is not a good practice for 
the dispense cassettes. However, because the cassette Tip Holder resides on the 
same dispense arm as the Syringe dispenser manifold, it will be moved into the 
submerge position when the Syringe tips are submerged. Either remove the cassette 
altogether when soaking the Syringe tips, or remove the prime trough inserts for 
the Peri-pump to prevent cross contamination of fluids or unintended wicking of 
fluid into the cassette.

 n Keep   in mind that any interaction with the EL406 will reset the interval clock.   
And,  AutoPrime only runs when the main menu, quick menu, or run completion 
message is displayed.               

 n When AutoPrime   is running you can press STOP   on the keypad to stop it. It 
will run again the next time the downtime   interval occurs.             
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Delay After Dispense

About Vacuum Dissipation Delay or Delay after Dispense: 

Standard vacuum pumps (not high flow) require a delay at the end of a run to 
allow air into the fluid containers to prevent the vacuum pump from 
overworking. A delay of 1 second/liter has proven to be reliable in preventing 
certain pumps from blowing an auxiliary 5-amp fuse (PN 46055). When 
necessary, specify a delay of 10 seconds when using a 10-liter bottle, 20 
seconds when using a 20-liter bottle, and so on.

By default the EL406 is programmed with a 5 second delay   after every dispense; 
valid range is 0-50 seconds.

To adjust the delay:

 1. LHC: Select Tools>Instrument   Utilities>General Settings
Keypad: Press Setup Menu and select —> twice, select VACDIS              .

 2. Set the Delay   to the desired time period.             

 3. LHC: Click Send.               
Keypad: Press Enter.

Download Basecode (LHC Only)

Tools> Instrument Utilities>Software>  Download Basecode

Keypad users: Contact BioTek TAC for guidance. 

Use this feature when it is necessary to upgrade the instrument's   onboard software 
or basecode. BioTek provides the basecode (EL406.bin)   file on the Customer   
Resource Center website. 

Important prerequisite:   Download the basecode from our website to perform the 
basecode upgrade.   Alternatively, you can request a CD of the basecode software. 

To download basecode   to the instrument:

 1. Put the instrument in download   mode:

 2. Turn off the EL406.

 3. Press   and hold the Shift key while restarting the EL406,   i.e. turn it on. 

EL406™ Microplate Washer Dispenser



AutoPrime |  159

The keypad display will appear   blank. If the main menu appears, start again.   

 4. Using   the LHC, select Tools> Instrument   Utilities, select the Software tab and 
click Download Basecode

 5. Click Browse to the   EL406.bin file. 

 6. Click Start   Download.

 l Technical Note: Only one of the two communication ports (COM port) on the 
instrument can be used at a time. They cannot be used simultaneously. You can 
use either the USB or the RS232 serial port to connect the EL406 to a computer 
or to a BioStack or similar robotic device. But you cannot use both ports 
simultaneously. 

Upload-Download Protocols (LHC Only)

The LHC lets you transfer protocols from your computer to   your instrument and 
back again. 

Limitation:   Protocols must contain only instrument-supported action steps to 
qualify   for download. That is, the protocol cannot contain any of the LHC provided
   steps like Delay and Loop (buttons in the left column of the Add   Step box in the 
main view). And, a Protocol   Name is required.

 n The instrument's   main menu must be displayed for the LHC to communicate 
with it.             

 1. Select   Tools>Transfer Protocols.             

 2. Make   sure the desired protocols are displayed: check the Protocol   Folder path 
for This computer. Refresh   the list of protocols onboard the Instrument   by clicking 
the Settings link.             

 3. Highlight   one or more protocols in a display box. (Hold the Ctrl or Shift key to   
simultaneously select multiple files.)             

 4. Optionally,   at the top left corner of the screen, choose to Disable Editing of 
transferred protocols   to lock the protocols from editing or deleting when they 
are onboard the   instrument.             

 5. Click   the applicable Upload or Download   button.              

The LHC will confirm the transfer or prompt you for more   information. When the 
transfer is complete, you can manipulate the files   as you normally would in their 
new location.
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How to determine the Magnet Adapter Height Offset

Use a caliper for the best results or another measuring device. 

 1. Put a magnet in the adapter, and the 
type of plate you will be using in 
place on top of it.

 2. Measure the distance from the 
bottom of the adapter to the top of 
the plate in millimeters (mm). 

 3. Remove the plate, and measure it 
alone.

 4. Subtract the stand-alone plate 
measurement from the measurement 
value of the combined elements. 
This is the value to use.             

 n Be sure to click Send after inputting the offset value to update the EL406 with 
this Magnet Adapter Height setting.

Examples

In our testing we found these offset values to be effective:

Plate Type With PN Offset Value 
(mm)

96 Corning Magnet Adapter 7180011 (kit) 8.73

 Dexter 96 Magnet 7103016 10.20

 VP 96 Ring Magnet 7102216 10.48

 VP 96 Magnet 7102217 10.18

384 Corning Magnet Adapter 7180011 (kit) 8.73

 Dexter 384 Magnet 7103017 11.20

 VP 384 Ring Magnet 7102215 11.50

Change the Washer Buffer Switching Setting

The instrument's onboard settings must match the installed hardware. 
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Instrument models that specify Buffer Switching ("B" is included in their model 
name) are configured at the factory to use the valve module to supply fluid. If you 
choose not to use the module and instead connect a supply bottle directly to the 
instrument,  change the washer's buffer switching setting:

Keypad LHC

 1. Press Setup Menu (button in center of keypad).

 2. Select WASH and then BUFMOD.

 3. Select Yes when the buffer switching module is 
installed, otherwise, select No.

 1. Select Tools>Instrument 
Utilities>Washer.

 2. Change the setting for the 
Buffer Switching Module.
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Maintenance

Properly maintaining the EL406 is the key to reliable 
performance.
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Overview

A Preventive   Maintenance (PM) regimen for   the EL406 includes rinsing and 
soaking the fluid path and cleaning   and/or autoclaving the various components. 
The level of maintenance   required to keep the instrument performing as expected 
is dependent on   several factors, including the type of fluid dispensed, the 
frequency   of use, and the work habits employed.

The Recommended Maintenance Schedule on page 167 summarizes BioTek’s   
recommended maintenance tasks, and indicates approximately how often each   task 
should be performed. Daily and periodic routines and minimal guidelines   for 
frequency are listed. Beyond that, it is difficult for BioTek to recommend   a fixed 
frequency for each task to be performed. The frequency of conducting   these tasks 
must be based on the risk and performance factors of your   assays. 

Develop a maintenance schedule for your EL406 based on the characteristics of the 
fluids used and the activity level.   Here are some guidelines for each component:

Washer
 o When using fluids prone   to dry and harden quickly, the washer’s dispense and 

aspirate tubes   can clog quickly, and must be rinsed frequently and cleaned 
regularly.   Run AutoClean   ultrasonic cleaning regularly, when available. 
Otherwise, Remove and clean the washer manifold on page 185.              

 o If the washer will be   idle for several hours or days at a time, soak the tubes to   
keep them in a ”wetted” state. Enable AutoPrime   if the washer is idle for more 
than 3 hours.             

 o Wash solutions affect   the rinse frequency. If the solution does not contain 
surfactant,   consider rinsing (or running AutoPrime)   at least once an hour.             

Peri-pump
 o Purge the fluid at the   end of a dispense run and flush the tubing with water (or 

buffered saline   and then water). This is a good practice whenever the dispenser 
will be   idle for more than an hour, and at the end of the day.             

 o When using the 1 µL cassette,   filter fluids to 50 microns to reduce the chance of 
the tips clogging.             

 o When dispensing fluids   that can crystallize or harden after use, increase the 
frequency of maintenance   activities.  Autoclave the cassette as needed.             

 o Keep track of the number   of plates processed with a cassette to determine when 
the cassette has   reached its expected lifetime and is due for replacement or 
recalibration.             
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Syringe Dispenser
 o Perform the daily maintenance   routines. Flush the dispenser with an appropriate 

reagent at the beginning   of the day (e.g., deionized water in the morning) and at 
the end of a   run.             

 o When dispensing fluids   that can crystallize or harden after use, increase the 
frequency of maintenance   activities. This is especially important for the 32-tube 
small bore (SB) dispensers.

 o Autoclave the Syringe heads and pistons, when applicable, and the 16-tube 
manifolds as needed. See Clean the Dispense Tubes on page 195.

Recommended   Maintenance Schedule

The schedule recommends preventive maintenance tasks, the   frequency with which 
each task should be performed, and the predefined   onboard Maintenance program 
that should be run (if applicable). See Recommended Maintenance   Schedule on 
the facing page.

 n It is important   to note that the risk and performance factors associated with 
your assays   may require that some or all of the procedures be performed 
more frequently   than suggested in this schedule. 

 n Water: Daily maintenance is the key to keeping the liquid handler performing 
to specifications. In the maintenance procedures provided in this manual, the 
requirement to use distilled (dH2O) or deionized (DI) water can be met by 
numerous water purification methods, including MilliQ™. A minimum water 
purity of 2mOhm is expected.              
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Recommended Maintenance   Schedule

Tasks

Frequency

Daily Overnight/
Multi-Day

Weekly Periodic/
Monthly

Before 
storage/
shipment

Washer

Run W-DAY_RINSE ü ü    

Run AutoPrime ü     

Run W-OVERNIGHT_LOOP  ü    

Run W-RINSE_AND_SOAK  ü    

Run AutoClean    ü ü

Peri-pump

Flush   dispense cassette ü ü    

Record   number of plates 
processed with cassette

ü     

Syringe   Dispenser 

Run S-DAY_RINSE_A&B ü ü    

Run AutoPrime ü     

Components

Remove protein residuals and 
fungi growth, (if necessary)   

ü  ü ü  

Check/empty waste bottles ü    ü

Clean bottles    ü ü

Clean plate carrier system   ü  ü

Clean   washer manifold    ü ü

Clean aspirate and dispense tubes    ü ü

Clean exterior surfaces and mist 
shield

  ü   

Clean   fluid inlet filter    ü ü
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Tasks

Frequency

Daily Overnight/
Multi-Day

Weekly Periodic/
Monthly

Before 
storage/
shipment

Clean Syringe dispenser manifold    ü ü

Clean Syringe dispenser tubes    ü ü

Autoclave Syringe pumps    ü  

Clean vacuum filtration system     ü ü

Decontaminate

Decontaminate external surfaces    ü ü

Run W-DECONTAMINATE    ü ü

Run S-DECONTAMINATE    ü ü

Decontaminate vacuum filtration 
system

     ü  

Prepare   for Storage or Shipment

Run W-LONG_SHUTDOWN     ü

Run S-LONG_SHUTDOWN     ü

Replace/Repair   Components

Replace washer manifold O-rings 
and channel-end seals

Annually

Recalibrate   Peri-pump cassette 
Find the PDF folder on the 
operator's manual CD for detailed 
instructions for two methods of 
recalibrating the cassette.

As Needed

Replace Peri-pump dispense tips As Needed

Replace Peri-pump cassette tubing As Needed

Replace Syringe manifold check 
valves and plugs

As Needed
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Daily Maintenance

Daily maintenance involves flushing the washer and dispensers   with an 
appropriate reagent or deionized water throughout the day.   Routine rinsing helps 
to prevent the aspirate and dispense tubes from   clogging between runs. Flushing 
the devices with deionized water is recommended   at the end of the day for most 
applications.

The recommended rinsing   frequency depends on the solutions currently in use:    

 l When a solution containing   surfactant is used throughout the day, perform 
the rinsing procedure when the device is idle for more than 3 hours.             

 l When the solution does not   contain surfactant, consider rinsing at least once 
an hour.             

 n The type of hardware also affects rinsing frequency. The 32-tube dispense 
manifolds require more diligence to keep them clog-free.

Run these protocols and enable AutoPrime   to satisfy the daily maintenance 
requirements:

 l W-DAY_RINSE             

 l S-DAY_RINSE_A&B             

 l P-#UL_CASS_RINSE  (# represents the cassette type)

Make sure the supply bottles contain sufficient rinse solution   and that the waste 
bottles are empty before running the protocols.     

 Also see the additional maintenance procedures required when dispensing protein 
solutions: Removing Protein Residuals and Fungi Growth on page 175. 

AutoPrime

AutoPrime automatically conditions   the  dispense tubes, priming them with the 
specified volume, after a user-specified   amount of idle time. See AutoPrime on 
page 153.

 l Press the STOP button  to interrupt the AutoPrime routine when it is 
underway.

 l Any interaction with the instrument via the keypad or the LHC resets the 
interval clock.
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 l AutoPrime only runs when the main menu, quick menu, or run completion 
message is displayed on the keypad.

Overnight/Multi-Day Maintenance

Overnight/multi-day maintenance involves flushing all solutions     out of the 
instrument, and then periodically rinsing and soaking the tubes    to keep them 
moist. Here are three recommendations for accomplishing the task. Employ the 
method that best suits your work flow: 

Maintaining 1536-well Hardware

At the end of the day run W-DAY_RINSE to flush the 128-tube aspirate manifold. 
The aspirate tubes cannot completely empty the priming trough when the run is 
finished. Remove the fluid manually with a pipette or paper towel.

The 32-tube-SB dispense manifolds can become easily clogged. It is especially 
important to perform one of the overnight maintenance procedures  with the 
suggested soaking periods to ensure trouble free startup at the beginning of the 
next day.

Overnight Loop

To keep the wash manifolds in a wetted condition, you can run these predefined 
protocols to soak the tubes for several hours at a time:

 l W-OVERNIGHT_LOOP: requires the washer to remain turned on.

 l W-RINSE_AND_SOAK: alternatively, run this protocol  and turn off the 
instrument after the soak begins. The tubes will soak in the priming trough 
until the instrument is turned on again.

AutoPrime for Overnight-Weekend Maintenance

AutoPrime can be used to keep the manifold tubes wetted during idle periods 
throughout the day and then modified to soak the tubing for longer periods 
overnight and on the weekends. See AutoPrime on page 153 for setup instructions.

AutoPrime Parameters Washer Syringe 

AutoPrime Interval 15 minutes* 15 minutes*

Device Washer Syringe A and B
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AutoPrime Yes/Enabled Yes/Enabled

Volume 90 mL 1000 µL

Rate 09 3

Buffer Any NA

Submerge Duration 120 minutes/2 hours 180 minutes/3 hours

*To repeatedly soak both devices, make sure the AutoPrime interval is less than the 
total combined submerge duration.

 l When the EL406is set up for 1536-well washing, you can disable AutoPrime 
for the washer; typically the 128-tube aspirate manifold does not require the 
same amount of soaking as dispense manifolds.

Overnight/Multi-day Procedure: After modifying the AutoPrime parameters to 
submerge the tubes for several hours:

 1. Put the priming-trough-inserts into the priming trough.

 2. Use Quick Dispense to fill both inserts (prime cups): DISP>PRIME (for both 
Syringe A and B). Run the Prime two or three times to fill the cups.

 3. When the priming troughs are filled, press Main Menu.

Submerge and Shutdown

An overnight/multi-day maintenance option for soaking the tips and turning off 
the instrument for overnight and weekend maintenance.

You can soak the EL406 dispense manifolds by filling the priming troughs and 
turning off the instrument after the soak begins. The tubes will soak in the priming 
troughs until the instrument is turned on again.

 1. First, run S-DAY_RINSE_A&B but do not empty the priming trough inserts.

 2. Run W-RINSE_AND_SOAK. 

 3. When the wash manifold is submerged, turn off the instrument. 

The syringe dispenser manifolds will lower into their troughs.

 n Remove either the cassette or the Peri-pump priming trough from the 
instrument before performing this procedure.

32-tube Syringe Dispenser

When using the 32-tube dispense manifold, especially the small bore (SB) model, 
BioTek recommends using the following AutoPrime parameters to keep the 
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manifold clog-free:

Volume: 1000 µL

Flow rate: 3

Submerge duration: 3 hours (requires priming trough inserts)

Overnight/Multi-day practice: After modifying the AutoPrime parameters to 
submerge the tubes for several hours:

 1. Put the priming-trough-inserts into the priming trough.

 2. Use Quick Dispense to fill both inserts (prime cups): QUICK>PRIME (for both 
Syringe A and B). Run the Prime two or three times to fill the cups.

 3. When the priming troughs are filled, press Main Menu.

Soak the manifold tubes in cleaning fluid

Keeping the dispense and aspirate tubes in a wetted condition   is required to keep 
them clog free. Soak the tubing in deionized or distilled water or a cleaning   fluid 
whenever the device is not being used to ensure trouble-free performance.

Prime Step

 

 1. Fill   a supply bottle with a cleaning agent.             

 2. Click W-Prime or S-Prime                  and define parameters to fully prime the tubing, for 
example:

Washer Syringe Dispenser

Volume = 500 mL Volume = 8000 µL

Flow Rate = 7 Flow Rate = 5

Prime Low Flow = 100 mL Cycles = 5

 Submerge   tips in fluid after prime: enable option and set Duration,   up to 24 
hours.

 n For the   Syringe manifolds: Use the priming trough inserts to submerge the 
tips.             
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 n Overnight Maintenance: You can turn   off the instrument after the tips are 
submerged to leave them soaking   in the priming trough for an extended 
duration.             

 3. Click   Run. Save the program with a memorable name   for future use.             

AutoPrime

Enable AutoPrime   to ensure the tubing is soaked during downtime intervals.

It is especially important when using the 32-tube SB dispense   manifolds to keep 
the tubes wet to prevent clogs. One option is to modify   the AutoPrime parameters 
used for idle periods during a regular work day   to soak the tubing for longer 
periods overnight and on the weekends.

 n Be sure   to use the priming trough inserts when the submerge feature is 
enabled. And, remove either the Peri-pump cassette or its priming trough 
insert.             

Define the AutoPrime values to fill   the priming-trough-inserts,   e.g. 6000 µL, and 
then submerge the tubes for several hours.    When AutoPrime is enabled for both 
dispense manifolds, the   soak duration begins after both manifolds are primed, i.e. 
both priming-trough-inserts   have been filled. 

When the EL406 is set up for 1536-well washing, you can   disable AutoPrime for the 
washer; the 128-tube aspirate manifold does   not require the same level of soaking 
as dispense manifolds.

More about soaking the dispense tubes...

You can soak the Syringe dispenser's two manifolds, A and B, simultaneously or 
separately depending on how you define the prime routine. Two priming trough 
inserts are supplied, one for each manifold. The troughs can be used to preserve 
precious fluids and to soak the manifold tubes.
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 n Be sure   to use the prime trough inserts   
to submerge the tips in fluid.             

Create a Prime protocol

As an alternative to AutoPrime, BioTek recommends creating a protocol with two 
prime steps   to soak the Syringe dispenser's tubes:
 l Do not enable the submerge   feature for Syringe A. Specify a volume that fills the prime 

trough insert,   e.g. 6000 µL.             

 l Create a second prime step   for Syringe B, with the same volume, and the submerge 
duration defined.   Both Syringe A and Syringe B dispense tubes will be submerged in their
   respective prime trough inserts. 

Important: Remove the Peri-pump cassette when the Syringe dispenser is set to 
"Submerge." 

"Submerge" is not offered for the Peri-pump because it is not a good practice for 
the dispense cassettes. However, because the cassette Tip Holder resides on the 
same dispense arm as the Syringe dispenser manifold, it will be moved into the 
submerge position when the Syringe tips are submerged. Either remove the cassette 
altogether when soaking the Syringe tips, or remove the prime trough inserts for 
the Peri-pump to prevent cross contamination of fluids or unintended wicking of 
fluid into the cassette.

 n Keep   in mind that any interaction with the EL406 will reset the interval clock.   
And,  AutoPrime only runs when the main menu, quick menu, or run completion 
message is displayed.               

 n When AutoPrime   is running you can press STOP   on the keypad to stop it. It 
will run again the next time the downtime   interval occurs.             
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Removing Protein Residuals and Fungi Growth

Important! Solutions containing   proteins, such as bovine serum albumin (BSA), will 
compromise the EL406’s   performance over time unless a strict maintenance regime is 
adhered to.   Do not use isopropyl alcohol to flush out BSA.          

When using protein solutions or   similar fluids, BioTek   recommends performing the 
following additional Maintenance procedures   to thoroughly flush out protein 
particles and other contaminants from   the fluid path. 

Also note, some components can be autoclaved to sterilize them.

 n Four-liter   volumes specified in the following are approximate amounts.             

 n S-DECONTAMINATE     (S-DECON): this predefined protocol specifies Syringe 
A. Make a copy of the protocol and modify it for Syringe B.   

Daily Practice with buffer or deionized water:

If the EL406 will be idle between plates for longer than 45 minutes, flush the 
proteins:

 1. Fill a supply bottle with deionized water. Connect the bottle to the washer or 
dispenser. (Buffer valve “A” for Buffer Switching models)

 2. Run the applicable DAY_RINSE protocol.

 3. Enable AutoPrime for 60-minute intervals.

At the end of the day:

 1. Fill a supply bottle with deionized water. Connect the bottle to the washer or 
dispenser(Buffer valve “A” for Buffer Switching models).

 2. Run the applicable DAY_RINSE protocol three times.

 3. Perform your regular Overnight/Multi-Day Maintenance routine.

Weekly or As Needed use NaOH and HCl to remove proteins:

 1. Flush the system with 0.1-0.5 N* NaOH (sodium hydroxide), followed by 
neutralization with an equivalent normality (0.1-0.5 N) of HCl (hydrochloride).

 2. Rinse well with deionized water to remove the HCl.

 3. Run the applicable DAY_RINSE protocol three times with deionized water if 
you plan to use the device immediately.
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 n * N = Normal solution, which contains 1 ‘gram equivalent weight’ (gEW) of 
solute per liter of solution. The gram equivalent weight is equal to the 
molecular weight expressed as grams divided by the ‘valency’ of the solute.

Alternatively use an Enzyme-Active Detergent:

 1. Mix an enzyme-active detergent according to the manufacturer’s directions to 
fill a four-liter supply bottle. Connect the bottle to the washer’s Buffer valve A 
or one of the Syringes.  Connect a bottle of deionized or distilled water to 
Buffer valve B to rinse the tubing.

 2. Run the W-DECONTAMINATE (W-DECON) or S-DECONTAMINATE protocol, as 
appropriate.

 3. Respond to the Delay message, “Connect a bottle of water…”, leave the 
detergent bottle connected and when ready, press           Continue.

 4. For the Syringes: connect a bottle with deionized or distilled water to the 
pump and REPEAT the protocol.

 5. When the protocol is completed, connect a bottle containing four liters of 
deionized water and run W-DAY_RINSE or S-DAY_RINSE three times to flush 
the system.

 6. Repeat the procedure for the other Syringe dispenser.

EL406™ Microplate Washer Dispenser



Periodic Maintenance |  177

Periodic Maintenance

Periodic maintenance involves cleaning the components on   a regular basis to keep 
the instrument running efficiently and in compliance   with performance 
specifications.  The recommended frequency   for cleaning components is at least 
monthly. The risk   and performance factors associated with your assays may require 
that some   or all of the procedures be performed more frequently.

Warning!   Internal Voltage. Turn off and unplug the instrument for all cleaning   
operations.

 n Important: Do not apply lubricants to manifold O-rings, channel-end seals, 
bottle cover seals, any tubing connection, or any surface   that is a part of the 
fluid path. The use of any lubricant on the fluid   handling components will 
interfere with aspirate and dispense performance,   and may cause irreparable 
damage to these components.

 n Water: Daily maintenance is the key to keeping the liquid handler performing 
to specifications. In the maintenance procedures provided in this manual, the 
requirement to use distilled (dH2O) or deionized (DI) water can be met by 
numerous water purification methods, including MilliQ™. A minimum water 
purity of 2mOhm is expected.

Important! 
 l Do not immerse the instrument, spray it with liquid, or use a ”wet”   cloth on it.

 l Do not allow the cleaning solution to run into the interior of the instrument.   (If this 
happens, contact the BioTek TAC.)

 l Do not expose any part of the instrument to the recommended diluted sodium   
hypochlorite solution (bleach) for more than 20 minutes. Prolonged contact   may damage 
the instrument surfaces.

 l Be certain to rinse and thoroughly wipe all surfaces.

 l Do not soak the keypad. Instead, moisten a clean cloth with deionized or   distilled water 
and wipe the keypad. Dry it immediately with a clean,   dry cloth.

Perform these preventive maintenance tasks regularly:

 l Clean the Bottles on next page

 l Clean the Plate Carrier on next page

 l Washer Maintenance on page 181

 l Peri-pump Dispenser Maintenance on page 188

 l Syringe Dispenser Maintenance on page 193 
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Clean the Bottles

 l Clean      and rinse the supply bottles with deionized water before the first use,      before each 
refill, and, periodically, as necessary, to prevent bacteria      growth.    

 l Empty      the waste bottle often (at least daily), and firmly seat the waste bottle      stopper.     

 l Rinse      the covers every time the wash or rinse bottles are filled.     

 l Accumulated      algae, fungi, or mold may require decontamination.    

 n To ensure that fluid does not back up      into the vacuum pump during operation, 
always operate the instrument with      the waste sensor cable installed and the 
waste detection      sensor enabled (the sensor is enabled by default).    

If      fluid collects in the overflow bottle, thoroughly rinse the level-switch      assembly and 
bottle.    

 l Check      the hex nuts securing the quick-disconnects to the bottle cap to ensure      they are 
not loose or corroded.    

Clean the Plate Carrier

If liquid has overflowed onto the plate carrier, transport     rail, or glide strips, some 
buildup may occur and prevent the microplate     from seating correctly on the carrier. 
This can interfere with plate transport.    Weekly cleaning is recommended.

 1. Turn      the instrument off.     

 2. Lift      the carrier up and off the transport rail.

 3. Clean      the carrier, rails, and glide strips, using mild detergent and hot water,      
70% isopropyl alcohol, or ethanol. Clean the priming trough, too.    

 4. If      detergent was used, wipe the components with a cloth moistened with water.      
Use a clean, dry cloth to dry the components.     

 5. Reinstall the carrier:
 l Place it on the transport rail so the slot on its      base fits into the Y-axis Carrier Arm. 
 l If necessary, release the      spring-loaded microplate clamp in the back left corner of the 

carrier      to level the carrier on the base. 

Clean the Vacuum Filtration Carrier

Use a damp cloth to wipe up any spills, especially if the fluid is prone to dry and 
harden quickly. If necessary, flush it out with warm water by holding it under a 
running faucet for a few seconds. 
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Clean the exterior surfaces and mist shield

 1. Turn   off the instrument and disconnect the power cable.             

 2. Moisten   a lint-free disposable towel with water, or with water and mild 
detergent.   Do not soak   the cloth.             

 3. Remove   the mist shield if it is attached. Wipe the inside and outside surfaces   of 
the mist shield with the towel. Wipe the top surface of the instrument   base, and 
all exposed surfaces of the instrument.             

 4. If   detergent was used, wipe all surfaces with a cloth moistened with water.             

 5. Use   a clean, dry cloth to dry all wet surfaces.
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Autoclavable Components

Autoclaving is an efficient method of sterilizing instrument components. For 
qualified items, it is a good alternative to some of the decontamination procedures. 

Do autoclave: Do NOT autoclave:

 Washer manifolds

Peri-pump cassettes Plate carrier

16-Tube Syringe dispenser manifolds 32-Tube Syringe dispenser manifolds

Priming trough inserts 8-Tube Syringe dispenser manifolds (gray 
block holds two manifolds, 16 tubes total)

Autoclavable Syringe pump head 
(glass/stainless steel)

Non-autoclavable syringe pumps (black plastic)

Syringe module tubing with transparent 
amber check valves and glass bottles

Non-autoclavable syringe accessories, white 
check valves and plastic bottles

 l Autoclaving the cassette typically increases the tubes' capacity. Expect the cassette to 
dispense more fluid than expected immediately after sterilizing or disinfecting the 
tubing. (When the cassette is completely dry, dispense volumes return to normal.)

 l Autoclaving the dispense cassette does not diminish its expected life , See Peri-Pump 
Dispenser on page 17.
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Washer Maintenance

The EL406’s washer manifold, mist shield, and tubing   require periodic cleaning. 

Regular rinsing helps to keep the washer manifold clean,   the aspiration and 
dispense tubes clear, and it increases the life of   the tubing. Likewise,
 thoroughly cleaning the manifold to unclog aspirate and dispense tubes can 
correct poor or uneven aspiration or   dispensing.

Washer Maintenance Tasks:

 l Clean the manifold, mist shield, and tubing on page 179

 l Create an AutoClean protocol on page 183 (when available). Run it regularly.

 l Remove and clean the washer manifold on page 185

 l Clean the Fluid Inlet Filter on page 186

 l Maintaining the Vacuum Filtration System on page 187 (if applicable)             

AutoClean the Washer

Some models of the EL406 feature BioTek's Ultrasonic Advantage™   for easy and 
thorough cleaning of the wash manifold. Instruments with AutoClean capability are 
easily identified by the stainless steel priming reservoir built into the instrument's 
base, under the wash manifold.

Warning!   Ultrasonic energy is present in the cleaning reservoir when the AutoClean   
program is running. Do not put your fingers in the bath! Ultrasonic energy   can harm 
human tissue.             

 n Important!  Ensure there is adequate room in the waste bottle and sufficient   
volume in the supply bottle before   running AutoClean!             

AutoClean Procedure:

 1. Empty   the waste bottle.             

 2. Make   sure supply bottles have sufficient volume of detergent and deionized   
water.             

 3. Select the predefined protocol, W-CLEAN_w-BUFFER or             Create an AutoClean 
protocol on page 183.             

 4. Click   Run.             
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 5. Fill   a supply bottle with deionized water and run W-DAY_RINSE   one or two 
times to flush the system.             

 Tip: Detergent such as Terg-A-Zyme®   added to deionized water in the supply bottle 
helps to break down the   water’s surface tension and enhances the cleaning process. Terg-
A-Zyme   also contains protease enzyme for assimilating protinaceous residue such   as 
bovine serum albumin (BSA).

 n Note: The   128-tube aspirate manifold (1536-well   hardware) does not 
completely evacuate the fluid from the trough. After   the cleaning procedure is 
finished, you must manually absorb the remaining   fluid (approximately 15 mL) 
with a pipette, paper towels or other method.   Be sure to obey the 
manufacturer's handling guidelines when using detergents.             

 n AutoClean   32-Tube Dispense Manifolds: With   a little manual intervention, 
you can use the ultrasonic cleaner on the   hard-to-clean dispense tubes, 
especially the  small bore models.   Find instructions in the operator's manual.             

About AutoClean

BioTek's Ultrasonic   Advantage™ is a built-in ultrasonic   cleaner that provides 
enhanced maintenance capabilities   by using ultrasonic pulses in a water bath to 
clean the   manifold tubes. Ultrasonic energy causes cavitation forces within the   
water bath, which in turn cause tiny vapor bubbles to be created. The   formation 
and subsequent collapse of these bubbles is the mechanism that   cleans the 
manifold tubes submerged in the bath. 

The cleaner consists of a stainless steel reservoir with   an ultrasonic transducer 
bonded to the bottom of the reservoir. The reservoir   is mounted under the washer 
manifold and also functions as the priming trough. 

 n Do not try to remove the ultrasonic cleaner!   Only BioTek authorized service 
personnel should remove the ultrasonic   cleaner for maintenance or repair.                               

While the program is running, the ultrasonic cleaner will   pulse on and off 
approximately every ten seconds, and you will hear a   periodic hissing sound that 
indicates the ultrasonic energy is present. 

 n Not all EL406 models are equipped with this feature.
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Create an AutoClean protocol

Create an AutoClean protocol for regular use. Make sure it begins   by priming the 
tubing with the cleaning fluid. Approximately 93 mL of fluid fills the reservoir   
during each run.  

General   Recommendation: Run AutoClean   for 1 hour. Follow with a full prime using 
deionized water to   remove the detergent from the system and/or with a wash 
buffer to leave the   instrument primed and ready for use. 

LHC Keypad

DEFINE>CREATE>NAME>PLATE>ADD>WASHERg>ACLEAN   

Define the cleaning protocol:

 1. First, add a Prime   step to fully prime the 
tubing   with the cleaning fluid (or water). 

 2. Add an AutoClean   step to the protocol.              

 3. Buffer Valve:   select the supply bottle containing the desired cleaning 
fluid if Buffer Switching is installed.             

 4. Duration:   enter the duration in hours and minutes; up to 24 hours.              

 5. Click OK   to add a cleaning step to the protocol.              

AutoClean the 32-Tube Dispense Manifold

With a little manual intervention, you can use the ultrasonic cleaner on the hard-to-
clean dispense tubes, especially the SB – small bore models.
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Before running AutoClean for the aspirate manifold, run it for the 32-tube Syringe 
dispenser manifolds:

 1. First, remove the Peri-pump cassette, if applicable.

 2. Grasp both Syringe dispenser manifolds, and keeping them together, slide them 
off the dispense arm. The magnets help keep them together.

 3. Gently release their tubing from the black bracket above the wash manifold and 
position them on the left side of the wash manifold, ready to put into the 
ultrasonic bath.

 4. Run the AutoClean protocol: Create an AutoClean protocol on previous page.

 5. When AutoClean begins, lift the wash manifold with your right hand and place 
the dispense manifolds into the bath with your left hand.

 6. Make sure the tubes are in the fluid and the edges of the manifolds are resting 
on the edges of the priming trough. Then, gently lower the wash manifold down 
on top of the dispense manifolds. The wash manifold will hold them in place.

 n Important: the aspirate manifold will be unable to evacuate the fluid from the 
priming trough when the run ends because the dispense manifolds will be in 
the way. To complete the process:

 7. Reinstall the dispense manifolds on the dispense arm.

 8. Run the AutoClean protocol for the aspirate manifold.
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 9. When AutoClean is finished, remove the residual liquid in the priming trough 
using a paper towel or other method. Be sure to follow the manufacturer’s 
handling instructions for the cleaning fluid you are using.

Remove and clean the washer manifold

 n DO NOT AUTOCLAVE the manifold! 

 1. Run   the system "dry” to remove any fluid: Connect   an empty supply bottle and 
run a prime protocol until the tubing is empty.                    

 2. Turn   off the instrument, disconnect the power cable and remove the mist shield.
             

 n Dual manifolds: Hold the two manifolds together as a single unit when 
removing   and reinstalling.

 3. Carefully remove the manifold(s) and end plates, if applicable.             

Avoid   pressing the stylus against the sides of the tubes during cleaning. This   can cause 
the tubes to bend, adversely affecting dispense precision.             

 4. Using   a soft-bristled brush, thoroughly clean the outside of the manifolds.   Clean 
the insides of each tube with the appropriate stylus (aspirate/dispense).   Flush 
hot water through the cross channels.             

 5. Rinse   the manifold with deionized or distilled water. Check to see if   water 
comes out of all dispense and aspirate tubes. If not, soak the manifold   in hot, 
soapy water and repeat. 

Caution. When reinstalling the manifold, only tighten the   screw-washer-spring 
assembly that holds it in place until you feel the   mechanical stop. Tightening past this 
point will damage the instrument   and will void your warranty.

 6. When satisfied, reassemble the manifold and end   plates, making sure that the 
two o-rings are in place prior to reassembly.   Do not overtighten   the manifold 
screws.

 7. Install   the mist shield.              

 8. Reconnect   the power cable and turn on the instrument. 

 9. Prime   the system with deionized water by running W-DAY_RINSE or a   similar 
Maintenance or Prime protocol. Watch for leaks. If fluid leaks   out of the back of 
the instrument, firmly seat the tubing. If fluid leaks   from the manifold, try 
disassembling and carefully reassembling.              
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 10. Verify   aspirate/dispense performance visually or by performing the 
qualification   tests.             

 n Replace   the O-rings on an annual basis. Replace the channel-end seals (rubber
   plugs) if they show signs of cracking or drying out. See Replace Washer 
Manifold O-rings and Seals on page 208.

Clean the Fluid Inlet Filter

Warning! Internal Voltage. Turn off and unplug the instrument   for all cleaning 
operations.             

Periodically clean the fluid inlet filter (PN 49943):

 1. Unscrew   the Dispense Fluid   In fitting from the back of the instrument.              

 2. Note   the orientation of the filter in the fitting (the cone-shaped end of the   filter 
points ”in” toward the instrument) and then remove   the filter from the fitting.             

 3. Wash   the filter with hot water and a soft-bristled brush.             

 4. Rinse   the filter, then replace it in the fitting and reinstall.             
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Maintaining the Vacuum Filtration System

Perform the following tasks as part of your regular maintenance when you are 
using the vacuum filtration system:

Clean the Vacuum Filtration Carrier

Use a damp cloth to wipe up any spills, especially if the fluid is prone to dry and 
harden quickly. If necessary, flush it out with warm water by holding it under a 
running faucet for a few seconds. 

 l Decontaminate the Vacuum Filtration System on page 204
 l Vacuum Filtration Carrier: Replace the Gasket on page 210 (as needed)

BioTek Instruments, Inc.



188 | Chapter 4: Maintenance

Peri-pump Dispenser Maintenance

The level of the maintenance required to keep the dispenser   performing as 
expected is highly dependent on several factors, including   the type of fluid 
dispensed, the frequency of dispensing, and the work   habits employed. For 
example, when dispensing fluids that can crystallize   or harden after use, 
maintenance activities are required more frequently. 

 When using the 1 µL cassette filter fluids  to 50   microns to reduce the chance of tips 
clogging.  

Daily maintenance includes purging the fluid at the end   of a dispense run and 
flushing the tubing with water (or buffered saline   and then water). This is a good 
practice whenever the dispenser will be   idle for more than an hour, as well as at 
the end of the day. 

Another important daily requirement is keeping track of   the number of plates 
processed with a cassette. This is necessary to determine   when the cassette has 
reached its expected lifetime and is due for replacement   or recalibration. 
Replacement Tubing Kits, a refurbishment service, and new cassettes are   available 
from BioTek Instruments. 

Monthly maintenance requires overall cleaning of the dispenser   and its accessories, 
and verifying performance to determine if the cassette   needs recalibration. 
Autoclaving or decontaminating the cassette is also   recommended.

Peri-pump Maintenance   Tasks:

 l Flush the Dispense Cassette on the facing page

 l Unclog the Dispense Tips on page 190

 l Record the Number of Plates Processed on page 191

 l Recalibrate the Peri-pump Dispense Cassette on page 211

 l Replace Peri-pump Dispense Cassette Tubing on page 210
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Flush the Dispense Cassette

Prime the tubing with an appropriate   reagent at the beginning of the day, and, 
flush the tubing to effectively   remove all contaminants at the end of the day. 

The type of rinse fluid to use is determined by the type   of fluid you are 
dispensing. Some dispense fluids require the use of enzyme-active   detergent, 
buffered saline, ethanol or isopropyl alcohol, rather than   deionized water alone.

Tools and Supplies

 l Deionized   or distilled water             

 l Buffered   saline solution or enzyme-active detergent for protein or cell based 
assays             

At the start of the day:

Prime the tubing to prepare for a dispense run.

 1. Reload   the cassette and fill the supply vessel:             

 l When dispensing solutions   not effected by water, simply prime with the 
dispense fluid.             

 l When dispensing protein   solutions, first prime the tubing with a buffered 
saline solution to remove   any traces of water in the tubing, then, prime with 
the dispense fluid.             

 2. Prime  the tubing until fluid flows into the priming trough and all   visible air 
bubbles have been removed.             

At the end of the day:

Purge the tubing to reclaim the dispense fluid, then Prime   the tubing to flush it 
clean.

 1. Purge the cassette until the tubing appears empty.             

 2. Replace   the supply vessel with the appropriate rinse fluid:             

 l When dispensing water soluble   solutions use deionized or distilled water.             

 l When dispensing protein   solutions, first prime the tubing with a buffered 
saline solution to remove   protein particles, then, prime with deionized or 
distilled water.             

 3. Prime   the tubing for the specified duration:             
 l 1 µL cassette = 5 seconds             

BioTek Instruments, Inc.



190 | Chapter 4: Maintenance

 l 5 µL cassette = 7 seconds             
 l 10 µL cassette = 10 seconds.             

Unclog the Dispense Tips

The small diameter of the dispense tips makes them susceptible   to clogging. You 
may be able to visually identify a clogged tip, or inaccurate   dispense performance 
may signal a problem. Good work habits can prevent   clogging or reduce its 
occurrence:

 l When using   1 µL cassettes, filter fluids to 50 microns before dispensing.              

 l Thoroughly   flush the tubing after/in-between usage, especially when using 
liquids   that crystallize or harden.              

In case the need arises, BioTek ships a 10 cc plastic syringe   with special tubing and 
fitting for use unclogging tips. Installation   instructions recommend storing it in the 
pouch on the back of the instrument.   The remedy involves removing the dispense 
tip and flushing it with water.   Depending on the type of clog, soaking the tip 
holder in hot water with   mild detergent is recommended. 

  This task may be easier if you use   the cassette’s shipping container to hold the 
unaffected cassette   parts, keeping them out of your way. 

Required Materials
 l 10 cc syringe with tubing   and fitting attachment shipped with dispenser             

 l Screwdriver shipped   with dispenser             
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 l A sufficient quantity of   deionized (DI) water in a beaker             

Procedure

 1. Fill   the 10 cc syringe with water and set aside.             

 2. Remove   the cassette from the dispenser.             

 3. Use   the screwdriver to open the Tip   Holder. Put the top of the holder aside.             

 4. Lift   the affected dispense tube from the holder and pull its tip off the tube.             

 5. Slide   the tip, tapered end first, into the tubing on the end of the syringe.             

 6. With   the tip poised to expel the clog and the water into the beaker or a sink,   
discharge the syringe.             

 7. Fill   and discharge the syringe as many times as needed to flush the tip.             

 8. Reassemble   the cassette:             
 l Put the straight end of   the tip into the bottom of the tube (the tapered end of the dispense 

tip   is exposed).             

 l Reinsert the tube into the   Tip Holder. Seat the flared edges of the tip into the molded 
slots.             

 l Replace the Tip Holder cover   with its two screws. The etched BioTek label identifies the 
top of the   cover (except for 1536 cassettes’ steel cover plate).             

Record the Number of Plates Processed

To determine when a tubing cassette has reached the end   of its expected lifetime, 
make a habit of counting and recording the approximate   number of plates and 
volume dispensed per cassette.

Create a form similar to the example table below or estimate   your usage of the 
cassette and project a date for replacement or recalibration.

Cassette Expected Lifetime

Cassette Types Cassette Life Total Volume

1 µL 1000 384-well plates @ 5 µL/well 2,000 mL

5 µL 1000 96-well plates @ 50 µL/well 5,000 mL

10 µL 1000 96-well plates @ 100 µL/well 10,000 mL

With strict adherence to best practices and maintenance recommendations, this is 
the typical longevity of the dispense cassettes.
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Example table for recording cassette usage:

You may want to create a form similar to this table to keep   track of the volume 
dispensed with each cassette:

Cassette   serial #: 2178

Date #   Plates Plate   Type Volume/Well Total   Daily Vol. Total   Cassette Vol

10/10/08 26 384 5   µL 49920   µL 50   mL

10/11/08 33 96 10   µL 31680   µL 82   mL 
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Syringe Dispenser Maintenance

The level of the maintenance required to keep the dispenser   performing as 
expected is highly dependent on several factors, including   the type of fluid 
dispensed, the frequency of dispensing, and the work   habits employed. For 
example, when dispensing fluids that can crystallize   or harden after use, 
maintenance activities are required more frequently. 

32-tube small bore (SB) dispense manifold: If the fluid 
streaming from a dispense tube appears to be awry or skewed, 
it is most likely caused by minute particles of debris on the end 
of the tube. Brush away any particles from the end of the tube 
using a piece of silicon tubing. Silicon will not flake off and leave 
particles behind like other materials. 
See AutoClean the 32-Tube Dispense Manifold on page 
183

 

Clean the Bottles and Tubes  
 l Clean the dispense   and rinse bottles and supply tubes with deionized water before   the 

first use, before each refill, and if they have been idle for   any length of time.             

 l Accumulated   algae, fungi, or mold may require decontamination.             

Syringe Dispenser Maintenance Tasks
 l Autoclave the Syringe Head on page 196

 l Clean the Dispense Tubes on page 195

 l Clean the Syringe Dispenser Manifold below

 l Clean or Replace the Check Valves on page 196

 l Run AutoPrime to soak the   dispense tubes             

Clean the Syringe Dispenser Manifold

Regular rinsing helps to keep the manifold clean and the   dispense tubing clear, 
and will increase the life of the tubing. Follow   the Decontamination   procedure to 
disinfect the manifold and tubing.

If you suspect a particular problem is related to the manifold   (for example, clogged 
tubes can result in uneven dispensing), you should   perform a thorough cleaning of 
the manifold. 
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To clean the manifold:

 1. Turn off and unplug   the instrument.             

 2. Pull the manifold off of   the dispense arm and disconnect the tubing from the 
manifold.              

 3. Remove the plugs from the   ends of the manifold. Using a lint-free disposable 
towel, thoroughly clean   the outside of the dispense tubes.              

 4. Run hot water through the   inlet fitting. Check to see if water comes out of all of 
the dispense   tubes. If not, soak the manifold in hot soapy water and repeat. 
Clean the Dispense Tubes on the facing page, if necessary.             
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Clean the Dispense Tubes

 n Do NOT  autoclave   the dual 8-tube and 32-tube dispense manifolds!

 n Note: The autoclavable 16-tube and non-autoclavable 8-tube  manifolds have 
removable dispense tubes. We do not recommend routinely removing   these 
tubes. In the case of a particularly difficult problem with any   one channel, 
however, a tube may be removed and cleaned individually,   or replaced.             

Clean the Tubes 

Unless there is a problem, the manifold dispense tubes do   not need special 
cleaning. Periodic rinsing is usually sufficient to keep   the tubes clean. However, if 
the regular maintenance is not completely   successful, try the following:
 l 8- and 16-tube manifolds:   clean the tubes with the stylus;             

 l 32-tube manifolds: flush   the tubing with the 10 mL syringe.             

 

 1. Remove the plugs   from the ends of the manifold.             

 2. Tip the manifold on end   and flush hot water through this open channel.             

 3. Using the supplied tool,   clean the insides of all of the dispense tubes.             

BioTek Instruments, Inc.



196 | Chapter 4: Maintenance

 o 8- and 16-tube   manifold stylus: PN 2872304                 

 o 32-tube   manifold: 10 cc syringe and tubing                 

Let water flow through the open   channel while you probe or flush each tube, 
forcing any particles to be   washed away.

 4. Rinse the manifold   with deionized or distilled water. Check to see if water 
comes out of   all of the dispense tubes (except when working with the 32-tube 
SB manifold).   Reinsert the plugs into the ends of the manifold.             

 5. Remount the manifold and   replace the tubing.              

 6. Run a Prime protocol using   40 mL of deionized water.             

 7. Verify dispense performance   visually, or              Perform the Syringe Dispense Precision & 
Accuracy Test on page 262.             

Clean or Replace the Check Valves

 n The check valves do not twist open.             

If the check valves leak or become clogged, you can either   clean or replace them. 
Contact BioTek Customer Service to order replacement check valves.

To clean a check valve:

 1. Pull the tubing off the   check valve.             

 2. Insert the stylus into the   feed end of the valve to hold it open (observe arrow on 
valve indicating   flow direction).             

 3. Flush with hot water.              

 4. Replace the valve and the   tubing.              

Replace Syringe Dispenser Check Valve on page 211, if necessary.

Autoclave the Syringe Head

Certain models of the Syringe dispenser are not autoclavable. Be sure your dispenser 
is described as autoclavable before proceeding. See Syringe Dispenser- 
Autoclavable vs. Non-autoclavable on page 147.
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 1. Use the supplied 3/32”   (2.39 mm) hex wrench to remove the two mounting 
screws that hold the syringe   head in the unit.             

 2. Pull the syringe head straight   back and off of the piston             

 3. Use   the hex wrench to loosen the setscrew on top of the sleeve that holds   the 
piston and then remove the piston.             

Important! Autoclave the piston and syringe head separated from one another.   Keep 
the piston and syringe head unattached to each other when autoclaving.              

 4. Autoclave at 134°C and 216   kPa for 3 minutes, or 121°C and 115 kPa for 30 
minutes. The manifold,   tubing, autoclavable check valves, and supply bottles 
may also be sterilized   in the autoclave.             

 n Check valves (PN 68073) recommended   for use with organic substances 
cannot be autoclaved.             
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 5. Replace the components by   reversing the steps:             

 6. With the flat side of   the shaft facing up, slide the syringe   piston shaft into the 
piston   holder until it stops.                 

 7. Use the 3/32”   (2.39 mm) hex wrench to tighten the setscrew.                 

 8. Push the syringe head over the piston   until it is flush with the unit and use the 
hex wrench to attach the two   mounting screws.                    
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Decontamination

Any laboratory instrument   that has been used for research or clinical analysis is 
considered a biohazard   and requires decontamination prior to handling.

Decontamination minimizes the risk to all who come into   contact with the 
instrument during shipping, handling, and servicing.   Decontamination is required 
by the U.S. Department of Transportation regulations.   Persons performing the 
decontamination process must be familiar with the   basic setup and operation of the 
instrument.

The recommended frequency   for decontamination is at least monthly, and before 
shipment   of the instrument to BioTek for calibration or repair.

 n Important! BioTek Instruments, Inc. recommends the use of the following 
decontamination   solutions and methods based on our knowledge of the 
instrument and recommendations   of the Centers for Disease Control and 
Prevention (CDC). Neither BioTek   nor the CDC assumes any liability for the 
adequacy of these solutions   and methods.  Each laboratory must ensure that 
decontamination procedures   are adequate for the biohazards they handle.

Warning!   Internal Voltage. Turn off and unplug the instrument for all 
decontamination   operations.

 n Do not immerse the instrument, spray it with liquid, or use a ”wet”   cloth. Do 
not allow the cleaning solution to run into the interior of   the instrument. If this 
happens, contact the BioTek TAC.   Do not soak the keypad.

 n Wear prophylactic gloves when handling   contaminated instruments. 
Gloved hands should be considered contaminated   at all times; keep gloved 
hands away from eyes, mouth, nose, and ears.    Eating and drinking while 
decontaminating instruments is not advised.

 n Mucous   membranes are considered prime entry routes for infectious agents. 
Wear   eye protection and a surgical mask when there is a possibility of aerosol   
contamination. Intact skin is generally considered an effective barrier   against 
infectious organisms; however, small abrasions and cuts may not   always be 
visible. Wear protective gloves when performing the decontamination   
procedure.

Tools and Supplies 

0.5% sodium hypochlorite   (NaClO, or bleach)
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70% isopropyl alcohol (as   a bleach alternative)

Deionized or distilled water

Priming plate

Safety glasses

Surgical mask

Protective gloves

Lab coat

Biohazard trash bags

Clean cotton cloths

Step-by-Step Decontamination Instructions:

 l Decontaminate Exterior Surfaces below

 l Decontaminate Tubing and Manifold on page 202

 l Alternate Decontamination Procedure for Tubing and Manifold on page 203

Decontaminate Exterior Surfaces

Caution! Be sure to check the percentage NaClO of   the bleach you are using; this 
information is printed on the side of the   bottle. Commercial bleach is typically 10% 
NaClO; in this case,   prepare a 1:20 dilution. Household bleach is typically 5% NaClO; in 
this case, prepare a 1:10 dilution.             

The   bleach solution is caustic; wear gloves and eye protection when handling.  

 1. Turn off the instrument    and disconnect the power cord. Empty the waste bottle.             

 2. Unload the Peri-pump cassette   and the prime trough inserts, and remove the 
Syringe dispenser manifold   and tubing, if applicable.              

 3. Autoclave the cassette and   other autoclavable components.             

 4. Prepare an aqueous solution   of 0.5% sodium hypochlorite (NaClO, or bleach). 
As an alternative, 70%   isopropyl alcohol (or 70% ethanol) may be used if the 
effects of bleach   are a concern.              

 n Isopropyl alcohol is not recommended for   removing proteins (such 
as bovine serum albumin).                             

 5. Moisten a cloth with the   bleach solution or alcohol. Do   not soak the cloth.             
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 l Wipe the keypad (do   not soak). Wipe again with a clean cloth moistened with 
deionized or distilled   water. Dry immediately with a clean, dry cloth.                 

 l Remove the mist shield   if it is attached. Wipe the inside and outside surfaces of the 
mist   shield. 

 l Wipe the plate carrier, top surface of the instrument’s   base, supply bottles and 
tubing, and all exposed surfaces of the instrument.                  

 6. Wait 20 minutes. Moisten   a cloth with DI or distilled water.             
 l Wipe the inside and   outside surfaces of the mist shield. 

 l Wipe the plate carrier, top surface   of the instrument’s base, supply bottles, tubing, 
bottle covers   and all exposed surfaces of the instrument that have been cleaned 
with   the bleach solution or alcohol.                 

 7. Use a clean, dry cloth to   dry all wet surfaces.             

 8. Reassemble the instrument   as necessary.             

 9. Discard the used gloves   and cloths using a biohazard trash bag and an 
approved biohazard container.             
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Decontaminate Tubing and Manifold

Predefined protocols to flush and soak the supply tubing and manifolds   with 
disinfectant, then flush the system with rinse fluid are installed onboard the 
instrument and on the host computer   during installation of the LHC:

 o W-DECONTAMINATE  for the washer             

 o S-DECONTAMINATE   (S-DECON onboard) for the Syringe dispenser             

 For the Syringe dispensers: copy this protocol and modify it to run on Syringe B.

When storing or shipping the instrument, the LONG_SHUTDOWN procedure (on 1) 
primes and soaks the instrument, and ends by pushing air through the system. The   
parameters can be edited for optimum cleaning. For example, consider using   
ethanol instead of air to complete the decontamination process.

 n Two supply   bottles are required for this procedure: one for disinfectant, and 
one   for rinse.             

 1. Empty the waste bottle.             

 2. Prepare an aqueous solution   of 0.5% sodium hypochlorite (NaClO, or bleach).             

 3. Fill one supply bottle with   at least 400 mL of bleach solution (disinfectant).             

 4. Fill another supply bottle with at least 800 mL of deionized water (rinse). 

When using Buffer Switching:

 l Buffer valve A: Disinfectant                   

 l Buffer valve B: Rinse   solution (they will be reversed in the next round)              

Without Buffer Switching, connect   the bottle containing disinfectant to the 
Fluid   In port.

 5. Reconnect the power cord   and turn on the instrument.             

 6. Run the decontamination   protocols.                

Preparing to run W-DECON or W-DECONTAMINATE:

Keypad with 
Buffer Switching

Connect the supply bottles this way:
 • Buffer valve A: Disinfectant bottle
 • Buffer valve B: Rinse solution bottle

Keypad without 
Buffer Switching

Connect the disinfectant bottle to the Fluid In port.
When the protocol is finished, connect the rinse bottle to the inlet 
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port, and press REPEAT to rerun the protocol.
Keypad: Run DECON_STEP1 followed by DECON_STEP2.
LHC: At the prompt/delay, change bottles.

LHC with Buffer 
Switching

Connect the supply bottles this way:
 • Buffer valve A: Disinfectant bottle
 • Buffer valve B: Rinse solution bottle

 For unattended operation, change the Delay steps, make the delay a 
fixed time rather than indefinite.

LHC without 
Buffer Switching

Connect the disinfectant bottle to the Fluid In port.
At the prompt, when the protocol is delayed, connect the rinse bottle 
to the inlet port, and press Continue to complete the protocol.

Preparing to run S-DECON or S-DECONTAMINATE:

 n Buffer Switching for the Syringe dispenser: modify the predefined protocols to 
take advantage of the buffer switching module.

Using 
the

Description

Keypad Connect the disinfectant bottle to the Syringe A port. When the protocol is 
finished, connect the rinse bottle to the port, and press REPEAT to rerun the 
protocol.
Make a copy of the protocol and modify the copy for Syringe B, assign an 
unique name, e.g. SB-DECON, and repeat the above procedure.

LHC Connect the disinfectant bottle to the Syringe A port. At the prompt, when the 
protocol is delayed, connect the rinse bottle to the inlet port, and press 
Continue to complete the protocol.
Copy the protocol, select File>Save As, assign it a unique name, e.g. SB-
DECONTAMINATE, and modify it for Syringe B. Then, replicate the procedure.

See also Alternate Decontamination Procedure for Tubing and Manifold below.

Alternate Decontamination Procedure for Tubing and Manifold
If you are unable to run the decontamination protocols due   to a system failure, 
perform the following alternate decontamination procedure   to disinfect the internal 
tubing and manifolds.

Caution! Be sure to check the percentage NaClO of   the bleach you are using; this 
information is printed on the side of the   bottle. Commercial bleach is typically 10% 
NaClO; in this case,   prepare a 1:20 dilution. Household bleach is typically 5% NaClO; in 
this case, prepare a 1:10 dilution.             

 1. Turn   off the instrument and disconnect the power cord.             

 2. Remove the mist shield.              
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 3. Using the 9/64” (3.57   mm) hex wrench, remove the screws, washers, and 
springs that hold the   washer manifolds in place. Remove the wash manifold(s) 
and end plate(s).             

 n For dual manifold models, hold the two   manifolds (and end plates) together as 
a single unit when removing and   replacing them.             

 4. Prepare an aqueous solution   of 0.5% sodium hypochlorite (bleach). As an 
alternative, 70% isopropyl   alcohol (or ethanol) may be used if the effects of 
bleach are a concern.               

 n Isopropyl alcohol is not recommended for   removing proteins (such as 
bovine serum albumin).                             

 5. Soak the tubing and manifold   in the bleach or alcohol solution.               

 6. Wait 20 minutes. Rinse the   tubing and manifold with DI or distilled water.             

 7. Use a clean, dry cloth to   dry all wet surfaces of the tubes and manifold.             

 8. Reassemble the washer manifold,   making sure that the o-rings/gaskets are in 
place prior to reassembly. Do not over tighten the   manifold screws.

 9. Re-attach the mist shield.               

 10. Prime the system by running W-DAY_RINSE or a similar Maintenance or Prime 
protocol. Watch for leaks. If fluid   leaks out of the back of the instrument, 
firmly seat the tubing. If fluid   leaks from the manifold, try disassembling and 
carefully reassembling.             

 11. Discard the used gloves   and cloths using a biohazard trash bag and an 
approved biohazard container.             

 12. Verify performance   visually or by performing qualification tests. 

Decontaminate the Vacuum Filtration System

First, disinfect the tubing, then, remove and soak the carrier:

Decontaminate the tubing:

Run the predefined protocol VAC30/10_TEST (depending on your instrument 
model) with disinfectant as the fluid supply to clean the tubing and hardware 
used to perform filter plate assays.

 1. Connect a supply bottle filled with 200 mL of bleach solution/disinfectant.

 2. Insert the black vent plug into the vent port on the front of the carrier.
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 3. First prime the tubing.      

 4. Run TEST.

 5. When the run is completed, replace the decontamination fluid supply with 
deionized or distilled water and rerun it once or twice.

Decontaminate the vacuum filtration carrier:

 1. Turn off and unplug the instrument.

 2. Disconnect the tubing from the vacuum carrier.

 3. Remove the carrier and soak it in the Decontamination (bleach) solution for 20 
minutes.

 4. Rinse the carrier thoroughly to remove all bleach.

 5. Use a clean, dry cloth to dry all wet surfaces.

Inspect the plate seal gasket and replace it if defects are observed replace the 
gasket: Vacuum Filtration Carrier: Replace the Gasket on page 210.
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Long Shutdown (Prepare for Storage or Shipment)

Before the EL406 is shipped or stored, the entire system   should be rinsed and 
soaked with disinfectant and then purged of all fluid.   Perform these steps when 
leaving the instrument unused for a long period   of time.

Predefined protocols are installed onboard the instrument and on the host 
computer   during installation of the LHC:

 o W-LONG_SHUTDOWN — for the washer             

 o S-LONG_SHUTDOWN — for the Syringe dispenser             

The LONG_SHUTDOWN   protocols flush and soak the supply and manifold tubing  
with disinfectant, then flush with rinse, and finally purge the system   of fluid.  

 For the Syringe dispensers: copy this protocol and modify it to run on Syringe B.

 n Three supply bottles are required for   this procedure: one for disinfectant, one 
for rinse, and one for air. 

Caution! Be sure to check the percentage NaClO of   the bleach you are using; this 
information is printed on the side of the   bottle. Commercial bleach is typically 10% 
NaClO; in this case,   prepare a 1:20 dilution. Household bleach is typically 5% NaClO; in 
this case, prepare a 1:10 dilution.             

 1. Turn   the instrument off and disconnect the power cord.              

 2. Unload   the Peri-pump cassette and the prime trough inserts, if applicable. 
Clean and store them   separately.             

 3. Empty   the waste bottle.             

 4. Prepare   an aqueous solution of 0.5% sodium hypochlorite (NaClO, or bleach).             

 5. Fill   one supply bottle with at least 400 mL of bleach solution (disinfectant).             

 6. Fill   another supply bottle with at least 800 mL of deionized water (rinse).             

 7. Keep   the third supply bottle empty (air).             

When using    Buffer Switching , modify the protocol to correspond   and connect 
the supply bottles this way:

 o Valve A: Disinfectant bottle                 

 o Valve B: Rinse solution bottle                 

 o Valve C: Empty bottle                 
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Without Buffer Switching, connect   the bottle containing disinfectant to the Fluid
   In port, and obey the prompts to change bottles.

 8. Turn   on the instrument and run W-LONG_SHUTDOWN.             

 n While this   program is running, you will need to periodically check the display 
panel   and follow the instructions.             

 9. When   the washer has been cleaned and purged, repeat the process to clean and
   purge the Syringe dispensers, if applicable:              
 o Prepare the supply bottles   with disinfectant, rinse and air;             

 o Run S-LONG_SHUTDOWN

Storing the Instrument

After performing the Long Shutdown (Prep for Storage or Shipment) on previous page   
protocols:
 l Turn off the instrument   and disconnect the power cord.             

 l Store it on a flat surface   that is relatively free of vibration, in a dust-free and particle-
free   environment.             

 l Protect the instrument from   temperature extremes that can cause condensation within 
the unit and from   corrosive fumes and vapors.             

 l Store the instrument under   the following environmental conditions:              

Temperature: 20° to 50°C (-4° to 122°F)

Relative   humidity:                    10% to 85% (non-condensing)

 n Important:  Allow the instrument to reach room temperature before use after 
storage.             

 

Replace Components

Some components of the EL406 must be replaced   periodically to maintain specified 
performance levels. 

Washer Components:

 l Replace the Vacuum Pump Fuse on next page

 l Replace Washer Manifold O-rings and Seals on next page
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 l Clean the Fluid Inlet Filter on page 186

 l Vacuum Filtration Carrier: Replace the Gasket on page 210

Peri-pump Components

 l Replace Peri-pump Dispense Cassette Tubing on page 210

 l Recalibrate the Peri-pump Dispense Cassette on page 211

Syringe Dispenser Components

 l Clean or Replace the Check Valves on page 196

 l Calibrate the Backlash for Syringe Dispenser on page 212

Replace the Vacuum Pump Fuse

Spare fuses (PN 46055) are shipped with   the instrument in case the pump blows a 
fuse.

Tools: Screwdriver

To change the fuse:

 1. Locate   the Accessory Fuse   port on the rear panel below 
the Accessory   Outlet for the vacuum pump.         

 2. Use a screwdriver to open the port and release the fuse. 
It has a spring action.         

 3. Replace the fuse and reinstall.         

 

Replace Washer Manifold O-rings and Seals

 n This is not   applicable to the 128-tube aspirate manifold. The plugs in its 
manifold are the same as those used in the Syringe dispenser manifolds: PN 
45090.            

For optimal performance and to extend the life of the washer,   replace the manifold 
O-rings  once a year and the channel-end seals  (rubber plugs) when they show signs 
of cracking or drying out. 

Order the replacement O-rings and seals from   BioTek:
 l O-rings:   PN 49941             

 l Channel-end   seals: PN 49486             
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You must remove the washer manifold to change the O-rings   and seals, so these 
tasks work best in conjunction with the regular monthly maintenance routines.   

Replacing the O-Rings

After cleaning and rinsing the manifold:

 1. Using   your fingers or an appropriate tool, such as a very small, flat screwdriver,
   remove the two O-rings that are exposed when the manifold is removed.             

 2. Replace   the used O-rings with new ones by fitting them into the grooved slots.             

 3. If   you are NOT replacing   the channel end-seals at this time, reinstall the 
manifold. Do not over-tighten the manifold screws.

Caution: When   reinstalling the manifold, only tighten the screw-washer-spring 
assembly   that holds it in place until you feel the mechanical stop. Tightening   past this 
point will damage the instrument and void   your warranty.

Replacing/Cleaning the Channel-End Seals

If the channel-end seals do not need to be replaced,   they should be washed with 
mild detergent or alcohol.

 1. Remove   the manifold end plates to access the channel-end seals.              

The manifold end plate sits in front of the manifold   and holds the screws, 
washers, and springs that hold the manifold in place.   The channel-end seals sit 
in bored holes in the backside of the end plate,   facing the manifold’s channels. 
The manifold end plate has markings   to indicate its position relative to the 
manifold, e.g., Top or Bottom, on dual manifolds.

 2. Using   an appropriate tool, such as a very small, flat screwdriver or a paper   clip, 
remove the seals from the manifold end plate.             
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Caution: Do not grease any parts of this mechanism. Lubricate   the seals and the bored 
holes with alcohol to assist with reinsertion.             

 3. Clean   the seals if you are not replacing them with new ones.             

 4. Lubricate   both the seals and the bored holes with 70% isopropyl alcohol to 
facilitate   insertion of the seals. Make sure the seals sit firmly in the bored holes   
in the manifold end plate.             

 n The 9/64” (3.57 mm) hex wrench   shipped with the washer is useful for 
reinserting the seals into the bored   holes.            

 5. When   all of the seals are in place, reinstall the manifold end plates and the   
manifold. Do not over-tighten the manifold   screws.             

Vacuum Filtration Carrier: Replace the Gasket

If you observe damage to the vacuum filtration carrier’s gasket, you must order a 
replacement part from BioTek, and follow these instructions to replace it.

Tools: Philips head screwdriver

 1. Remove the carrier from the instrument and put on a level work surface.

 2. With a Philips screwdriver, remove the six screws around the perimeter of the 
top of the carrier. 

 3. Lift off and set aside the top plate, and remove the gasket.
 o If the grate (located under the gasket) needs to be cleaned, rinse it under tap 

water. Allow the grate to dry before placing it and the gasket in the carrier. 

 4. Place the new gasket in the carrier, correctly positioning the notch with the 
corresponding indentation on the carrier’s right side.

 n Note: The gasket fits only one way on the carrier. When replacing it, align the 
notch in the gasket with the small “bump” on the carrier.

 5. Restore the top plate and its six screws. Do not overtighten.

 6. Verify vacuum filtration performance by performing the Qualification 
procedure: Vacuum Filtration Evacuation Efficiency Test on page 237.

Replace Peri-pump Dispense Cassette Tubing

BioTek provides replacement tubing kits as an alternative   to buying a new cassette. 
Purchase the replacement tubing kits from BioTek   and follow the instructions 
shipped with the kit or on the EL406 Operator’s   Manual CD in the "Cassette 
Calibration" folder, titled:   7171017_(current Rev)_Replacing the tubing_
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8x14.PDF.   For the best experience with these instructions print them on legal size   
paper (8½” x 14”).

Recalibrate the Peri-pump Dispense Cassette

Calibration Kit

BioTek offers an accessory for recalibrating dispense cassettes.   The Calibration Kit 
(PN 7170017) speeds up the recalibrating process and is useful   for verifying 
performance.

Follow the instructions shipped with the kit or find them   on the EL406 Operator’s 
Manual CD in the "Cassette Calibration" folder, titled: 7171009_(current Rev)_
Calibration Kit   Instructions.PDF. 

Gravimetric Method                                       

The alternative and most precise method for calibrating   a cassette is the gravimetric 
method. Find the instructions on the EL406 Operator’s   Manual CD in the "Cassette 
Calibration" folder: it is titled:   7171024_(current Rev)_Calibrating 
Gravimetrically.PDF.

Replace Syringe Dispenser Check Valve

You can order replacement check valves from BioTek Customer   Care if your check 
valves become clogged and cleaning them does not solve   the problem:
 l PN   68083 — Autoclavable valves for use with non-organic substances.               

 l PN   68073 — Check valves recommended for use with organic substances.              

 n If you observe   a decline in performance after changing the check valves, 
Calibrate the Backlash for Syringe Dispenser on next page.             
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Calibrate the Backlash for Syringe Dispenser

If you have replaced a check valve or installed the Buffer Switching module and 
subsequently noticed   a decline in performance, recalibrating the backlash is 
recommended to   restore accuracy in dispense volumes.  

Equipment Required

 l Microplates: 384-well plates for testing the 16-tube dispensers (which can be 
replaced with 96-well plates if more applicable for your lab); 1536-well plates 
for testing the 32-tube dispensers; and 96-well plates for testing the 8-tube 
dispensers. 

 l Precision   balance with minimum capacity of 100 g and readability of 0.001 g 
resolution               

 l Supply bottle   with deionized water             

Setup

While calibrating and testing, try to maintain a steady   liquid level in the supply 
bottle, keeping it half full. Start with more   fluid to allow for priming. Connect the 
supply bottle to the Syringe under   test. Make sure the   supply bottle is at the same 
level as the dispenser.

Create a Dispense Protocol

Create a protocol that dispenses the correct volume for the manifold under test:    
 l 16-tube manifold: 20 µL per well   to a 384-well   plate at Flow Rate 2.

 l 32-tube manifold: 6 µL per well   to a 1536-well   plate at Flow Rate 2.

 l 8-tube manifold: 20 µL per well   to a 96-well   plate at Flow Rate 2.

Prime and Dispense

 1. Run   a Prime protocol, for example, S-DAY_RINSE   or S-DAY_RINSE_A&B   when 
both Syringe pumps need calibration, to remove air bubbles from the   tubing.            

 2. Place   the  plate on the balance, and tare the balance.             

 3. Place   the plate onto the carrier and run the dispense protocol created above.             

 4. Upon   completion, carefully remove and reweigh the plate to determine the 
Actual Weight.               

 5. The   Expected Weight is:
 o 16 tube = 7.680 grams

 o 32 tube = 9.216 grams
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 o 8 tube = 1.920 grams

 6. Calculate   the volume (weight) error and the backlash adjustment that needs to 
be   made:              
 o 16 tube: (7.680 - Actual Weight ÷ 24 ÷ [.0033 or .0031*]) = backlash   setting

 o 32 tube: (9.216 - Actual Weight ÷ 48 ÷ [.0033 or .0031*]) = backlash   setting

 o 8 tube: (1.920 - Actual Weight ÷ 12 ÷ [.0033 or .0031*]) = backlash   setting
* use .0033 for autoclavable units; use .0031 for non-autoclavable units.

 l Subtract the Actual Weight   from the Expected Weight and divide by 
the number of columns dispensed   to.              

 l Divide the result by 0.0033   and round to the nearest whole number.              

Example: 7.680 - 7.550 = 0.130, 0.130/24 = 0.00542,   0.00542/0.0033 = 1.64 
rounded to 2. The backlash setting needs to be adjusted   by 2.

 7. Adjust   the backlash as necessary: select Tools>Instrument   Utilities> Syringe 
Dispenser and enter the number of steps in   the applicable Backlash fields in 
the Calibration   Data group box.             

 8. Repeat   steps 1 through 4 until the volume dispensed is within one backlash 
unit   of being exact: ±   0.119 mL.             
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Qualification        

This chapter provides instructions for periodically testing the 
instrument to verify that it meets performance specifications. 
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 Qualification Overview

Instrument verification for the EL406 involves three   activities:  qualification of 
installation and setup, qualification   of routine capability, and qualification of long-
term stability.  These activities are called Installation Qualification   (IQ),   
Operational Qualification (OQ),   and Performance Qualification (PQ),   respectively. 

Review the Qualification Schedule on page 218.

Verification testing includes: 
 l The System   Self Test verifies system components, such as the vacuum, manifold,   and 

carrier positioning. The Checksum   Test verifies the basecode software against internal 
checksum   values to ensure that no corruption has occurred.              

Washer
 l Evacuation Efficiency: This test measures the residual volume per well after 

aspiration.   The lower the residuals per well, the better the evacuation efficiency   of the 
washer.               

 l Dispense Precision:   This test measures the variability of volumes dispensed from tube 
to tube   across the manifold.               

 l Buffer Switching   Module: This test measures the variability of volumes dispensed   
from tube to tube across the manifold when using buffer switching. 

 l Vacuum Filtration Evacuation Efficiency: When applicable, this test measures the 
total residual volume of the plate after evacuation to verify it is performing to 
specifications.

Washer Qualification   Tests:
 l Dispense Precision (96) on page 230

 l Dispense Precision Test (192) on page 234

 l Evacuation Efficiency Test (96) on page 228

 l Evacuation Efficiency Test (192) on page 232

 l Evacuation Efficiency Test 128 on page 235

 l Buffer Switching Dispense Test on page 231

 l Vacuum Filtration Evacuation Efficiency Test on page 237

Peri-pump and Syringe Dispensers
 l Dispense Precision is a measure of the   variability of volumes dispensed from tube to 

tube across the manifold   or tip holder. The optical density of the solution in a well is 
proportional   to the total volume of the solution in the well. When the % Coefficient   of 
Variation (%CV) is calculated, the result is a measure of the uniformity   of the 
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distribution of dispensed volumes across the manifold. It is the   ratio, expressed in 
percent, of the standard deviation of the distribution   of fluid volumes in the wells to the 
mean value of volume per well. The   uniformity of distribution across the manifold 
improves as the %CV is   lowered.              

 l Dispense Accuracy is a measure of the average volume dispensed per well. It is   
independent of precision. The volume per well may vary greatly over a   plate, yet the 
accuracy may be exact because it is an average of the volumes.             

Peri-pump   Qualification Tests:
 l Performing the Peri-Pump Precision and Accuracy Tests on page 251

Syringe   Dispenser Qualification Tests:
 l Perform the Syringe Dispense Precision & Accuracy Test on page 262
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Qualification Schedule

The following schedule defines the factory-recommended intervals for   verification 
tests for an instrument used two to five days a week. The schedule assumes that 
the EL406 is properly maintained as outlined   in the Recommended Maintenance 
Schedule on page 167.

 n Note: An instrument qualification package (PN 7180527)  is available for 
purchase. The package contains thorough procedures for   performing 
Installation Qualification, Operational Qualification and Performance   
Qualification (IQ-OQ-PQ) and preventative maintenance (PM). Extensive   
Checklists and Logbooks are included for recording results. Contact your   local 
dealer for more information.

Tests   
IQ OQ PQ

Initially Annually Monthly

Unpacking, Installation,   and Setup ü    

Enable/Test   System Sensors ü ü  

System Self Test and   
Checksum Test 

ü ü ü

Shake   Test  ü  

Ultrasonic   Cleaner Test  ü  

Washer Evacuation Efficiency   Test  ü ü

Washer Dispense Precision   Test  ü ü

Vacuum Filtration Evacuation Test  ü ü

Buffer Switching Dispense   Test  ü  

Peri-pump Dispense   Precision and Accuracy 
Test

 ü ü

Syringe Dispense Precision   and Accuracy Test  ü ü

Run Assay    ü

 n Important! The   risk factors associated with your assays may require that the 
Operational   and Performance Qualification procedures be performed more or 
less frequently   than shown above. 
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 n Note for Syringe Dispensers with Buffer Switching: Do not use the Buffer 
Switching module to perform qualification tests. Connect the fluid supply 
directly to each pump to test dispense precision and accuracy.

Liquid Testing the EL406™ Microplate Washer Dispenser

Which Tests to Perform?

We recommend that you perform these routine tests before first use (after the 
IQ) and then monthly:

Washer
 l Dispense Precision and Accuracy Test. Precision tests measure the variability of 

volumes dispensed from tube to tube across the manifold and Accuracy tests measure 
the average volume dispensed per well.

 l Evacuation Efficiency Test. Measures the residual volume per well after the 
aspiration aspect of plate washing. The lower the residuals per well, the better the 
evacuation efficiency of the washer. 

If your washer is equipped with Buffer Switching (“B” models), we recommend 
performing this additional test annually (starting one year after installation):
 l Annual Buffer Switching Test. Measures the variability of volumes dispensed from 

tube to tube across the manifold, for each valve, when the washer is equipped with 
buffer switching.

Perform the tests applicable to the installed manifold type. And, for instruments 
with buffer switching and vacuum filtration, perform the applicable tests:

If you have: Run Liquid Test(s):

96-Tube Manifold
 

Dispense Precision and Accuracy Test (96)

Evacuation Efficiency Test (96)

192-Tube Manifold
 

Dispense Precision and Accuracy Test (192)

Evacuation Efficiency Test (192)

Buffer Switching Buffer Switching Dispense Test
(Annual OQ only)

128-Tube Manifold Evacuation Efficiency Test (128)

Vacuum Filtration Module Vacuum Filtration Evacuation Efficiency (for either 
96- or 384-well plates)
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Peri-pump Dispenser
 l Dispense Precision and Accuracy Test. Perform two tests, one at the volume that 

matches the cassette type and another that best represents the cassette type and 
dispense volume most common to your applications.

Syringe Dispenser
 l Dispense Precision and Accuracy Test. Perform two tests for each syringe using the 

tests that best represent the plate type and dispense volume most common to your 
applications.

If you have: Run Liquid 
Test(s)

8-tube manifolds (1 unit) Test 1 and 
Test 2

16-tube manifolds Test 1 and 
Test 2

32-tube manifolds Test 3 (twice)

Important Recommendations for All Liquid Tests

Test Solutions

 l Using pure deionized water in place of the test solutions is not 
recommended and will likely result in the failure to meet specifications.             

 l Prepare the solutions the day before you plan to run the tests. This will 
allow any foam caused by the agitation of solutions containing Tween® 20 to 
settle.             

 l BioTek determined the pass/fail specifications for the instrument tests using 
the recommended test solutions. You may use your own buffer solution 
instead, but if any tests fail using your own buffer, retry the tests using the 
recommended solutions.             

Plate Reading

 l If you are using one of BioTek’s keypad-based readers, such as the ELx800 or
 ELx808, ensure that the reader is not running in Rapid mode. To check the 
setting, select UTIL à READ and cycle through the options until READ IN  

RAPID MODE? appears. Set it to NO.             

 l The absorbance of blue dye solutions should be measured at 630/450 (or 
405) nm. The BioTek blue dye solution part number is 7773001.             
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 l The final absorbance for all dye solution concentrations should be in a range 
between 0.700 and 1.600 OD.             

Recording Test Results

 l Use the Liquid Test Worksheets at the end of this section for recording data 
reduction results. If your tests are failing, this information will be useful for 
BioTek TAC to help diagnose any problems.             

System Self-Test, Verify Information

Perform these steps to verify software information and run a system self-check:

Prerequisite: When controlling the instrument with the LHC, ensure that it is 
attached to the host computer and turned on, and then launch the LHC software. 

To run   the System Self-Test:

LHC Keypad

Select   Tools>Instrument
Utilities>General Settings. 
Under Instrument Functions, click 
Perform Self-check.

 1. Select             UTILS at the main menu.

 2. Select TESTS.

 3. Select SLFCHK.

Test Results:

 l If the test passes, a “passing” message appears.

 l If the test fails, an error code displays. If this happens, find the error code in 
the EL406 Operator’s Manual to determine its cause. If the problem is 
something you can fix, turn off the instrument, fix the problem, and then turn 
the instrument back on and re-run the test. If the problem is not something 
you can fix, contact BioTek’s Technical Assistance Center.

Record Basecode

Record the software part number and version installed on the EL406.
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LHC Keypad

 1. Select Tools>Instrument 
Utilities

 2. Select the             Software tab and from 
the Basecode Software 
Information section record the

 l Software Version and part 
number

 l Data Version

 l Checksum values UI and MC

 1. Select UTILS

 2. Select TESTS

 3. Select CHKSUM

 4.  Reveal and record the checksum 
values one at a time for UI and MC. 
Also record the Software part 
number and version.

Checksum Test

The Checksum Test compares the on-board software with an   internally recorded 
checksum value to ensure the program has not become   corrupted. 
To run   the Checksum Test:

LHC Keypad

 1. At the LHC main view, 
select   Tools>Instrument
Utilities>Software.

 2. Click the Retrieve All 
onboard settings link at the   
top of the window.

 1. Select           UTILS at the main menu.

 2. Select TESTS.

 3. Select CHKSUM.

 4. One at time, display the UI and MC 
checksums.

Fluid and Waste Sensor Test

These tests simulate an error condition for the fluid and waste alert sensors.

1. Test the Fluid Supply Sensor

 1. Remove the lid on the fluid supply bottle (Buffer valve A, when applicable) 
and lift the internal tube up and out of the fluid.

 2. Run W-DAY_RINSE to bleed the fluid lines.

 3. Put a plate on the carrier and run a dispense protocol, e.g. W-96_DISP_TEST.

 4. Look for air moving through the tubing to the washer and wait for the alarm.

The instrument should display a fluid error, like 1500 or 1501.
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2. Test the Waste Level Sensor

 1. Turn the waste bottle upside down.

 2. Run an aspirate protocol, e.g. W-96_EVAC_TEST.

The instrument should beep and display the expected error code, 1401.

Ultrasonic Cleaner Test

Perform this test to verify that the cleaner is operating properly.

 1. Fill a supply bottle with one liter of deionized water. Buffer Switching 
models need two bottles connected to valves A and B.

 2. Create a protocol with an AutoClean step. Set the Duration to 00:02 (2 
minutes). 

 3. Run the protocol.

 4. While the AutoClean program is running, the ultrasonic cleaner should 
pulse on and off approximately every ten seconds (a 50% duty cycle). While 
the program is running, listen for the periodic “hissing” sound that indicates 
the ultrasonic energy is present. Detecting the sound is all that is required to 
verify that the ultrasonic cleaner is operating properly. After two minutes, 
the washer will aspirate the fluid and the program will be complete. (Non-
Buffer Switching models can press STOP when prompted for a rinse bottle 
and quit the program.)

Special Procedures for 1536-well Hardware:

The 128-tube aspirate manifold cannot completely evacuate the priming trough.

 1. Connect a bottle of cleanser or water to the Dispense Fluid In port on the rear 
of the instrument to use the single priming tube in the 128-tube aspirate 
manifold to fill the priming trough (ultrasonic bath);

 2. When AutoClean is finished, manually remove the residual liquid using a 
pipette, paper towel or other method.

If the ultrasonic cleaner does not operate as described above, contact BioTek for 
assistance.
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Washer Dispense Precision and Accuracy Test

The dispense precision test measures the variability   of the volumes dispensed   
from tube to tube across the wash manifold. In this test, a blue dye   solution is 
dispensed into a microplate. The optical density of each well   is measured at 630 
nm and the background at 450 nm is subtracted to account   for scratches on the 
plate or particulates in the well. 

The average error   percentage is calculated and the amount dispensed to each well 
is calculated.   Acceptance is based on the %CV   (%Coefficient of Variation), or the 
ratio of the standard deviation of   the distribution of fluid volumes in the wells to 
the mean value of volume   per well. The lower the %CV, the better the uniformity 
across the manifold.

Dispense accuracy is a measure of the average volume dispensed per well. In this 
test, an empty microplate is tared on a balance. A known volume is dispensed to 
the plate and it is weighed again. The Total Dispense Weight is determined and 
compared to the expected weight.     

Annual Buffer Switching Test: The Dispense Accuracy test   is also conducted on 
instruments with the external buffer switching module to ensure that each valve   (A, 
B, C, D) is calibrated to deliver the same volume of fluid. 

See: Which Tests to Perform on page 219

Predefined Test Protocols

Several EL406 protocols are shipped onboard the instrument and with   the LHC 
and installed on your computer during LHC   installation. 

They include the protocols required to perform the Liquid   Tests:

Predefined Protocols

W-DAY_RINSE                         

W-                             96_EVAC_TEST                         

W-                             192_EVAC_TEST                         

W-1536_EVAC_TEST

W-                             96_DISP_TEST                         

W-                         192_DISP_TEST
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Predefined Protocols

W-96_VAC30_TEST

W-384_VAC10_TEST

Prime_All_Buffers

The files are stored in the LHC's default file location.   Unless you have changed the 
file location:

 1.  Click the Open   button and locate the EL406 folder.

 2. Open the Maintenance or QC Protocols folder.             

 3. Select the required protocol.             

BioTek recommends customizing   these predefined protocols, as described in the  topic, 
Customize the Predefined Protocols on page 67.    

 n 192-Tube manifold users must customize the maintenance   protocols. If you 
use both types of manifolds, make a copy of the W-DAY_RINSE   protocol and 
change its Instrument Settings to correspond to the   192-tube manifold. 
Preserve the original protocol for use with the 96-tube manifold.

Default Parameters for the Liquid Test Protocols

 W-96_EVAC_TEST W-192_EVAC_
TEST

W-1536_
EVAC_TEST

Aspirate 
Height (Z)

28 (3.556 mm) 16 (2.03 mm) 40 (5.08 mm)

X Position -50 (-2.29 mm) 00 (0 mm) 00 (0 mm)

Y Position 2 (0.15 mm) 00 (0 mm) 00 (0 mm)

Travel 
Rate

2 (3.4 mm/sec) 3 (4.0 mm/sec) 3 (4.0 mm/sec)

Delay   0   0 0

Secondary 
Aspirate 

  No   No No

Evacuation Efficiency Test Protocols
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 W-96_DISP_TEST W-192_DISP_TEST S-1536_DIS_TEST

Buffer Valve A A See Syringe dispenser 
tests

Dispense Volume 300 µL/well 80 µL/well

Flow Rate 6 7

Dispense Height (Z) 120 120

X Position 00 00

Y Position 00 00

Pre-dispense No No

Dispense Precision  and Accuracy Test Protocols

 W-96_VAC30 W-384_VAC10

Plate Type 96 384

Volume 300 µL/well 80 µL/well

Filtration Time 30 seconds 10 seconds

Vacuum Filtration Test Protocols

Washer Qualification Test Materials

 l One new microplate per test to be performed:             

Microplate Type Liquid Tests

Flat-bottom 96-well plates, Corning® 
Costar  #3590 or equivalent

Evacuation Efficiency Test (96)

Dispense Precision and Accuracy Test 
(96)

Annual Buffer Switching Test

Flat-bottom 384-well plates, Corning 
Costar or  equivalent

Evacuation Efficiency Test (192)

Dispense Precision  and Accuracy Test 
(192)

Annual Buffer Switching Test

Standard 1536-well plates, Nunc® 
#264710 or equivalent

Evacuation Efficiency Test (128)
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Microplate Type Liquid Tests

 l 96-well 0.45 µm filter plate, 
Millipore MSHVN4550 96 or 
equivalent 

 l 384-well 1.2µm filter plate, 
Millipore MZFCN0W10 or 
equivalent

Vacuum Filtration Evacuation Efficiency 
Test (Use the plate size most 
commonly used in your lab)

 l Precision balance with minimum capacity of 100 g and readability of 0.001 g 
resolution            

 l Pipettes and graduated beakers             

 l Microplate absorbance reader capable of dual wavelength reading at 630/450 
nm              

 l Liquid Test Worksheets at the end of this chapter for recordingdata and 
results              

 l Deionized water             
 l Test solutions:

For this manifold: Sol. 1 Sol. 2 Sol. 3 Sol. 4

96-Tube 1000 mL 100 mL 1200 mL n/a

192-Tube 2000 mL 100 mL n/a 1440 mL

128-Tube 100 mL    

 n These volumes are sufficient for performing the dispense tests and standard 
and diagnostic Evacuation Efficiency tests. In most cases, enough fluid will be 
left over to re-run a test, if necessary. 

 n If you will be performing the annual OQ for the external Buffer Switching 
module, you will need several additional liters of deionized or distilled water.                 

Test Solutions

Solution #1:  Buffer Solution

Pipette 1 mL Tween 20 into   1 liter (1000 
mL) of deionized or distilled water and 
mix well.

or Pipette 10 mL of BioTek Wetting Agent* into 
1 liter of  deionized or distilled water and 
mix well.

* BioTek Solution #1 100X Concentrate Wetting Agent 125 mL (PN 7773002) 
contains 10% Tween 20 in deionized or distilled water and 0.01% Sodium Azide 
as a preservative.         
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SOLUTION #2:  Residual Test Solution

Mix 100 mL of Solution #1 with 0.050 
grams of FD&C #1 blue dye.

or Mix 90 mL of Solution #1 with 10 mL 
of BioTek Blue Test Dye*.

* BioTek Solution #2 10X Concentrate Blue Test Dye 125 mL (PN 7773001) 
contains 5 g per liter FD&C Blue #1, 0.1% Tween 20 in deionized or distilled 
water and 0.01% Sodium Azide as a preservative.         

SOLUTION #3:  Dispense Precision and Accuracy Solution for  96-Tube manifolds                    

Mix 1180 mL of deionized or distilled water with 20 mL of Solution #2.

SOLUTION #4:  Dispense Precision  and Accuracy Solution for  192-Tube manifolds                    

Mix 1420 mL of Solution #1 with 20 mL of Solution #2.

Evacuation Efficiency Test (96) 

 n This test is designed for 96-Tube manifolds. Find the Evacuation Efficiency 
Test (192) on page 232

 n If you tared the balance at the start of the Dispense Precision and Accuracy 
Test, use the plate from that test here; skip steps 1-3. 

 1. Fill a supply bottle   with 2 liters of deionized or distilled water. Run the 
Maintenance program W-DAY_RINSE   two or three times to prime the tubing 
and manifold.             

 2. Place a new 96-well microplate   on the balance and zero the balance.             

 3. Pipette or dispense 150   µL of Solution   #1 into each well of the microplate.             

 4. Place the plate on the carrier   and run the W-96_EVAC_TEST   protocol.  This 
protocol evacuates   the wells, leaving a small amount of residual fluid.             

 5. When the program is completed,   remove the plate and weigh it immediately 
because evaporation will affect   the results. This is the Total   Residual Weight in 
grams.             

 6. Visually inspect the plate   and note if any wells appear to have considerably 
more liquid than others.             

 7. Use the Evacuation   Efficiency Test Worksheet to  perform data reduction:
 l Divide the Total Residual   Weight by 96   to find the Mean   Residual Weight.                 

 l The Mean Residual Weight   should be <= 0.002 g.                 

EL406™ Microplate Washer Dispenser



Washer Dispense Precision and Accuracy Test |  229

If the Mean Residual Weight is   greater than 0.002 g, or if one or more wells 
appear to have much   more liquid than the others, the washer failed the test. 

Troubleshoot   as follows:         

If the test fails once: 
 o If the problem appears to be related to particular wells, clean those aspiration 

tubes: run AutoClean and/or remove the manifold and thoroughly clean the tubes 
with the stylus (See Remove and clean the washer manifold on page 185). 
When finished, retry the test.

 o Failure of this test is commonly caused by improper aspiration tube placement   
within the wells, usually because a microplate other than the recommended   
Corning Costar® 96 was used. If you must use a plate other than the Corning 
Costar   96, modify the Aspirate   Height, i.e., Z   position, or horizontal   X or Y position 
parameters in a copy of the W-96_EVAC_TEST   protocol to correct this error.  
After making this change, retry   the test using a new microplate.             

If   the test fails a second time: Perform the Evacuation Diagnostic Test.             

Evacuation Diagnostic Test

 n Conduct this test if the standard Evacuation   Efficiency Test fails twice. This 
test will confirm which aspirate tube(s)   may be clogged, or if the plate’s 
alignment or position is the problem.         

 1. If you have not already done so, repeat steps 2 through   7 of the standard 
Evacuation Efficiency test, using Solution   #2 for the dispense fluid. Be sure to 
recalculate the Mean Residual Weight.             

 2. Pipette up to 300 µL   of Solution   #1 into each well, on top of the residual 
solution.             

 3. Shake the plate to achieve   uniform distribution of the remaining dye   in each 
well.             

 4. Read the plate in an optical   reader (blank on air), using the dual-wavelength 
method (630 nm - 450   nm), then print or export the results.             

 5. Use the Evacuation   Efficiency Test Worksheet to perform data reduction:

 l Calculate the sum of   the OD values for all wells, then divide by 96   to 
determine the Mean   OD for the plate.                 

 l Divide the Mean OD by   the Mean Residual   Weight (from step 1), to find the 
Residual   Factor.                 

 l For each well, divide   its OD value by the Residual Factor to find its Residual
   Weight.                 

Each well’s Residual Weight   should be <=   0.002   g.
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If one or more wells have a Residual   Weight greater than 0.002 g, review the data to 
determine which   well, or wells, is causing the problem. 

 o If the problem appears to   be related to particular wells, clean the associated 
aspiration tubes:   run AutoClean   and/or remove the manifold and thoroughly 
clean the tubes with the stylus.    (See Remove and clean the washer manifold 
on page 185.) When finished,   retry the test.              

 o If the problem appears to   be related to a particular region, edge, or corner of the 
plate, review   the alignment and flatness of the plate on the carrier.              

Please   do not adjust the carrier adjustment screws! Contact BioTek   if you suspect an 
alignment problem, contact   BioTek TAC.               

 o For additional suggestions,  See Troubleshooting on page 272 .              

 o If the test continues to   fail, contact BioTek Instruments.             

Dispense Precision and Accuracy Test (96)

 n This test is designed for 96-Tube   manifolds. Find the Dispense Precision Test 
(192) on page 234.

 n Find a list of the supplies you will need at Materials on page 226. 

 n Save the plate! When this test is complete, used the filled plate to perform 
the Evacuation Efficiency Test. 

 1. Fill a supply bottle   with 2 liters of deionized or distilled water; Buffer Switching 
units use buffer   valve A. Run the W-DAY_RINSE protocol two or three times to 
prime the fluid lines and manifold.             

 2. Fill a supply bottle with   1200 mL of Solution   #3; Buffer Switching units use 
buffer   valve A.             

 3. Run W-DAY_RINSE   again to prime the washer with the solution.             

 4. Place a new 96-well microplate   on the balance and zero the balance.

 5. Place the plate on the carrier and run the W-96_DISP_TEST.    This protocol 
dispenses 300 µL   of solution to each well of the plate.  It does not evacuate the   
solution.             

 6. When the protocol is completed,   carefully remove the plate.             Place the plate on 
the balance and record the Total Dispense Weight.

 7. Read the plate in an optical   reader (blank on air), using the dual-wavelength 
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method (630 nm - 450   nm), then print or export the results.             

 8. Use the Dispense   Precision Test Worksheet to perform data reduction:             

Tip: If you have a spreadsheet software       program, enter/export all 96 values into a 
spreadsheet and apply your      program’s Standard Deviation function (e.g., Microsoft® 
Excel’s STDEV).

 a. Calculate the Standard Deviation.                   

 b. Calculate the sum of   the OD values for all 96 wells, then divide by 96   to 
determine the Mean   OD for the plate.                  

 c. Calculate the %CV: (Standard   Deviation / Mean OD) * 100.                 

The %CV should be <= 3.0.

If the %CV is greater   than 3.0, one or more dispense tubes may need to be cleaned. 
Run AutoClean,   if available, and/or remove the manifold and use the stylus to 
clean the dispense tube(s)   giving lower-than-average absorbance readings. When 
finished, re-prime   the washer and retry the test.

 9. When finished, prime with   deionized water to flush out the dye solution.             

Buffer Switching Dispense Test

This procedure tests all the buffer valves.

 n The Dispense Precision test must   pass before the  test for Valves A-D can be 
performed.             

 1. Empty the waste bottle now,   and then as needed throughout this procedure.             

 2. Fill each of the supply   bottles connected to Buffer valves A, B, C, and D with 
three   liters (3000 mL) of deionized water. Place the bottles on a surface level   
with the EL406, i.e., the adjacent (lab bench) area.             

 3. Run the Maintenance protocol   W-PRIME_ALL_BFRS   two or three times to prime 
the fluid lines, manifold, and the valves.             

Repeat the following steps for   each valve:

 1. Edit the applicable dispense   protocol, for example, 96_DISP_TEST, to use the 
buffer valve currently being tested.             

 2. Place a new 96- or 384-well   microplate on the balance and zero the balance.             

 3. Place the microplate on   the carrier and run the dispense protocol.              
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 4. When the program is finished,   carefully remove the plate and weigh it. This is 
the Total   Dispense Weight in grams.             

The Total Dispense Weight   should be:                 
 l 28.8   grams ± 10% (between 25.92 g and 31.68 g) for the 96-Tube test.                 
 l 30.72   grams ± 10% (between 27.65 g and 33.79 g) for 192-Tube test.                 
 l If the weight falls   above this range, the valve may be defective. Contact BioTek.             
 l If the weight falls   below this range, the valve may be contaminated with fungi or 

proteins   and must be cleaned using an appropriate enzyme, alcohol, or a diluted   
bleach solution, depending on the contaminant. See Removing Protein Residuals 
and Fungi Growth on page 175 in the Maintenance section   for suggestions. After 
cleaning the valve and tubing, retry the test.   If the test continues to fail, contact 
BioTek.             

 5. Record the results in the   applicable worksheet.             

Evacuation Efficiency Test (192)

 n This test is designed for the 192-Tube   manifold. Find the Evacuation 
Efficiency Test (96) on page 228.             

 n If you tared the balance at the start of the Dispense Precision  and Accuracy 
Test, use the plate from that test  here; skip steps 1-3. 

 n Important: You must edit the   W-DAY_RINSE protocol to function with the 
192-Tube manifold or   create your own priming protocol.

 1. Fill a supply bottle   with 2 liters of deionized or distilled water. Run the W-
DAY_RINSE   protocol two or three times to prime the fluid lines and manifold.             

 2. Place a new 384-well microplate   on the balance and zero the balance.              

 3. Pipette or dispense 80 μL   of Solution   #1 into each well of the microplate.             

 4. Place the plate on the carrier   and run the W-192_EVAC_TEST.  This protocol 
evacuates all of   the wells, leaving a small amount of residual fluid.             

 5. When the program is completed,   remove the plate and weigh it immediately 
because evaporation will affect   the results.  This is the Total   Residual Weight in 
grams.             

 6. Visually inspect the plate   and note if any wells appear to have considerably 
more liquid in them   than others.             
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 7. Use the Evacuation   Efficiency Test Worksheet to perform initial data 
reduction:

 1. Divide the Total Residual   Weight by 384   to find the Mean   Residual 
Weight.                 

 2. The Mean Residual Weight   should be <=   0.002   g.

If the Mean Residual Weight is   greater than 0.002 g, or if one or more wells 
appear to have much   more liquid than the others, the washer failed the test. 

Troubleshoot   as follows:

If the test fails once: 
 o If the problem appears to be related to particular wells, clean those aspiration 

tubes: run AutoClean and/or remove the manifold and thoroughly clean the tubes 
with the stylus (See Remove and clean the washer manifold on page 185). 
When finished, retry the test.

 o Failure of this test is commonly caused by improper aspiration tube placement   
within the wells, usually because a microplate other than the recommended   
Corning Costar® 384 was used. If you must use a plate other than the Corning 
Costar   384, modify the Aspirate   Height, i.e., Z   position, or horizontal   X or Y 
position parameters in a copy of the W-192_EVAC_TEST   protocol to correct this 
error.  After making this change, retry   the test using a new microplate.             

If   the test fails a second time: Perform the Evacuation Diagnostic Test (192). 

Evacuation Diagnostic Test (192)

 n Conduct this test if the standard Evacuation   Efficiency Test fails twice. This 
test will confirm which aspirate tube(s)   may be clogged, or if the plate’s 
alignment or position is the problem.         

 1. If you have not already done so, repeat steps 2 through   7 of the standard 
Evacuation Efficiency test, using Solution   #2 for the dispense fluid. Be sure to 
recalculate the Mean Residual Weight.             

 2. Pipette up to 80 µL   of Solution   #1 into each well, on top of the residual 
solution.             

 3. Shake the plate to achieve   uniform distribution of the remaining dye   in each 
well.             

 4. Read the plate in an optical   reader (blank on air), using the dual-wavelength 
method (630 nm - 450   nm), then print or export the results.             

 5. Using the Evacuation   Efficiency Test Worksheet, perform data reduction:

BioTek Instruments, Inc.



234 | Chapter 5: Qualification

 l Calculate the sum of   the OD values for all wells, then divide by 384   to 
determine the Mean   OD for the plate.                 

 l Divide the Mean OD by   the Mean Residual   Weight (from step 1), to find the 
Residual   Factor.                 

 l For each well, divide   its OD value by the Residual Factor to find its Residual
   Weight.                 

Each well’s Residual Weight   should be <=   0.002   g.

If one or more wells have a Residual   Weight greater than 0.002 g, review the data to 
determine which   well, or wells, is causing the problem. 

 o If the problem appears to   be related to particular wells, clean the associated 
aspiration tubes:   run AutoClean   and/or remove the manifold and thoroughly 
clean the tubes with the stylus.    (See Remove and clean the washer manifold 
on page 185.) When finished,   retry the test.              

 o If the problem appears to   be related to a particular region, edge, or corner of the 
plate, review   the alignment and flatness of the plate on the carrier.              

Please   do not adjust the carrier adjustment screws! Contact BioTek   if you suspect an 
alignment problem, contact   BioTek TAC.               

 o For additional suggestions, See Troubleshooting on page 272 .              

 o If the test continues to   fail, contact BioTek Instruments.             

Dispense Precision and Accuracy Test (192)

 n This test is designed for the 192-Tube   manifold. Find the Dispense Precision 
(96) on page 230.

 n Find a list of the supplies you will need at Materials on page 226.

 n Save the plate! When this test is complete, used the filled plate to perform 
the Evacuation Efficiency Test. 

 1. Fill a supply bottle with   2 liters of deionized or distilled water; Buffer Switching 
units use buffer   valve A. Run W-DAY_RINSE   two or three times to flush the 
fluid lines and manifold.             

 2. Fill a supply bottle with   1440 mL of Solution   #4; Buffer Switching units use 
buffer   valve A.             

 3. Run W-DAY_RINSE again to prime the washer with the solution. 

 4. Place a new 384-well microplate   on the balance and zero the balance.
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 5. Place the plate   on the carrier and run the W-192_DISP_TEST   protocol. This 
protocol dispenses 80 µL   of solution to each well of the plate. It does not 
evacuate the   solution.             

 6. When the program is finished,   carefully remove the plate. Place the place on the 
balance and record the Total Dispense Weight.            

 7. Read the plate in an optical   reader (blank on air), using the dual-wavelength 
method (630 nm - 450   nm), then print or export the results.             

 8. Use the Dispense   Precision Test Worksheet, perform data reduction:

Tip: If you have a spreadsheet software   program, enter/export all 384 values into a 
spreadsheet and apply your   program’s Standard Deviation function (e.g., Microsoft 
Excel’s   STDEV).                 

 a. Calculate the Standard Deviation.                   

 b. Calculate the sum of   the OD values for all 384 wells, then divide by 
384 to determine the Mean OD for   the plate.                  

 c. Calculate the %CV: (Standard   Deviation / Mean OD) * 100.                 

The %CV should be <= 4.0.

If the %CV is greater   than 4.0, one or more dispense tubes may need to be 
cleaned. Run AutoClean   and/or remove the manifold and use the stylus to 
clean the dispense tube(s)   giving lower-than-average absorbance readings. 
When finished, re-prime   and retry the test.

 9. When finished, prime with   deionized water to flush out the dye solution.             

Evacuation Efficiency Test (128)

Begin this test by dispensing the test solution with Syringe A or B to a 1536-well 
plate using one of the predefined QC protocols provided:

SA-1536_DISP_TST Dispense precision test protocol for 32-tube Syringe 
A manifold.

SB-1536_DISP_TST Dispense precision test protocol for 32-tube Syringe 
B manifold.

 1. Fill the Syringe dispenser’s supply bottle with 100 mL of Solution 1 (see page page 
261) and PRIME the tubing and manifold.

 2. Place a new 1536-well microplate on the balance and zero the balance.

 3. RUN the appropriate predefined protocol (listed above) to dispense 6 µL to 512 
wells of the plate.
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 4. After performing SA-1536_DIS_TST or SB-1536_DISP_TST, run the W-1536_EVAC_
TEST.  This protocol evacuates all of the wells, leaving a small amount of residual 
fluid.

 5. When the program is completed, remove the plate and weigh it immediately 
because evaporation will affect the results.  This is the Total Residual Weight, in 
grams.

 6. Visually inspect the plate and note if any wells appear to have considerably more 
liquid in them than others.

 7. Using the Evacuation Efficiency Test Worksheet, perform initial data reduction: 

 a. Divide the Total Residual Weight by 512 to find the Mean Residual Weight.

 b. The Mean Residual Weight should be <= 0.0001 g.

If the Mean Residual Weight is greater than 0.0001 g, or if one or more wells 
appear to have much more liquid than the others, the washer failed the test. 

If the test fails, Troubleshoot as follows:

 l If the problem appears to be related to particular wells, clean those aspiration tubes: run 
AutoClean, and/or remove the manifold and thoroughly clean the tubes with the stylus 
(See Remove and clean the washer manifold on page 185.) When finished, retry 
the test.

 l Failure of this test is commonly caused by improper aspiration tube positioning, usually 
because a microplate other than the recommended Nunc® #264710 was used. If you 
prefer to use a different plate, modify the Aspirate Position, i.e., Z-axis to fix the height, 
or X- or Y-axes parameters in a copy of the W-1536_EVAC_TEST protocol.  After making 
needed changes, retry the test using a new microplate.

 l For additional suggestions,  See Troubleshooting on page 272 .              

 l If the test continues to   fail, contact BioTek Instruments.             
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Vacuum Filtration Evacuation Efficiency Test

This test is designed for the EL406 with the Vacuum Filtration accessory. Install the vacuum 
filtration plate carrier to perform the test. Make sure the instrument setting for Plate Carrier is 
set correctly. Use the plate size most commonly used in your lab.

 n Perform this test during the initial and annual OQ and the monthly PQ. 

 1. Fill a supply bottle with 2 L (two liters) of deionized water. Run                 W-DAY_
RINSE to prime the fluid lines and manifold.

 2. Place a new microplate on the balance and zero the balance:
 o 96-well 0.45 µm filter plate: Millipore MSHVN4550 96 is recommended.

 o 384-well 1.2µm filter plate: Millipore MZFCN0W10 is recommended.

 3. Run the predefined protocol to first dispense deionized or distilled water into 
each well of the microplate and then evacuates the wells:

Plate Predefined Protocol Volume Vacuum Time

96-well W-96_VAC30_TEST 300 µL/well 30 seconds

384-well W-384_VAC10_TEST 80 μL/well 10 seconds

 4. When the protocol is finished, remove the plate, and blot the bottom of the 
plate on a paper towel to remove any droplets.

 5. Weigh the plate immediately. This is the Total Residual Weight, in grams.

 6. Visually inspect the plate and note if any wells appear to have considerably 
more liquid in them than others.

 7. Use the “Vacuum Filtration Evacuation Efficiency Test” worksheet at the end 
of this chapter to record the results:

Residual Weight should be:
 o <= 1.2 grams for a 96-well plate;

 o <= 4.0 grams for a 384-well plate.

 n While BioTek recommends using the Millipore filter-bottom plate listed above 
in this test, you may substitute other manufacturers’ filter-bottom plates that 
you are familiar with. However, using a substitute plate may vary your test 
results.

If the Residual Weight is greater than specified, the washer failed the test. Make 
sure a tight seal was maintained between the filter plate and plate carrier:
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 l A new, defect-free filter plate was used. 

 l The vacuum filtration plate carrier’s gasket is clean and has not been 
damaged by previous use or mishandling.

Correct these conditions and rerun the test or contact BioTek TAC for assistance.
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Dispense Precision Test Worksheet

  96-Tube Manifold

 

Serial Number:  

 

Calculations

Standard Deviation: 
(calculate using spreadsheet program)

 

Mean OD: 
(sum of all wells ÷ number of wells)

 

% Coefficient of Variation: 
((Standard Deviation ÷ Mean OD) x 100)

 

% CV <= 3.0?  q Pass     q Fail

 

Date:  

Test Performed By:  

EL406 Qualification Procedures
© 2012, BioTek® Instruments, Inc.



Evacuation Efficiency Test Worksheet

96-Tube Manifold

 

Serial Number:   

 

Standard Test

Total Residual Weight: g

Verification that wells are consistent in appearance: q Pass     q Fail

Mean Residual Weight (Total Residual Weight ÷ 96): g

Mean Residual Weight <= 0.002 g? q Pass     q Fail

 

Evacuation Diagnostics Test (check here q if not performed)

Mean OD for the plate (Sum of all wells ÷ 96):  

Residual Factor (Mean OD ÷ Mean Residual Weight):  

Calculate the Residual Weight for each well: well OD ÷ Residual Factor

Every Residual Weight per well <= 0.002 g? q Yes   q No

 

Date:  

Test Performed By:  

EL406 Qualification Procedures
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Dispense Precision Test Worksheet

     96-Tube Manifold

    Annual Buffer Switching Test

 

Serial Number:  

 

Calculations for Valve A

Standard Deviation:  

Mean OD (Sum of all wells ÷ Number of wells):  

% CV (Standard Deviation ÷ Mean OD x 100):  

% CV <= 3.0? q Pass     q Fail

 

Calculations for Valves A-D  
(Annual OQ only, check here q if not performed)

 Total Dispense Weight 28.8 g ±10%?
(25.92 g - 31.68 g)

Valve A                            grams q Pass     q Fail

Valve B                            grams q Pass     q Fail

Valve C                            grams q Pass     q Fail

Valve D                            grams q Pass     q Fail

 

Date:  

Test Performed By:  
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Dispense Precision Test Worksheet

  192-Tube Manifold

 

Serial Number:  

 

Calculations

Standard Deviation: 
(calculate using spreadsheet program)

 

Mean OD: 
(sum of all wells ÷ number of wells)

 

% Coefficient of Variation: 
((Standard Deviation ÷ Mean OD) x 100)

 

% CV <= 4.0? q Pass     q Fail

 

Date:  

Test Performed By:  
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Evacuation Efficiency Test Worksheet

    192-Tube Manifold

 

Serial Number:  

 

Standard Test

Total Residual Weight: g

Verification that wells are consistent in appearance: q Pass     q Fail

Mean Residual Weight (Total Residual Weight ÷ 384): g

Mean Residual Weight <= 0.002 g? q Pass     q Fail

 

Evacuation Diagnostics Test (check here q if not performed)

Mean OD for the plate (sum of all wells ÷ 384):  

Residual Factor (Mean OD ÷ Mean Residual Weight):  

Calculate the Residual Weight for each well: well OD ÷ Residual Factor

Every Residual Weight per well <= 0.002 g? q Yes     q No

 

Date:  

Test Performed By:  
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Dispense Precision Test Worksheet

    192-Tube Manifold

   Annual Buffer Switching Test

 

Serial Number:  

 

Calculations for Valve A

Standard Deviation:  

Mean OD (Sum of all wells ÷ Number of wells):  

% CV (Standard Deviation ÷ Mean OD x 100):  

% CV <= 4.0? q Pass     q Fail

 

Calculations for Valves A-D  
(Annual OQ only, check here q if not performed)

 Total Dispense Weight 30.72 g ± 10%?
(27.65 g – 33.79 g)

Valve A                            grams q Pass     q Fail

Valve B                            grams q Pass     q Fail

Valve C                            grams q Pass     q Fail

Valve D                            grams q Pass     q Fail

 

Date:  

Test Performed By:  
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Evacuation Efficiency Test Worksheet

    128-Tube Aspirate Manifold

 

Serial Number:  

 

Standard Test

Total Residual Weight: g

Verification that wells are consistent in appearance: q Pass     q Fail

Mean Residual Weight (Total Residual Weight ÷ 512): g

Mean Residual Weight <= 0.0001 g? q Pass     q Fail

 
 

Date:  

Test Performed By:  

EL406 Qualification Procedures
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Vacuum Filtration Evacuation Efficiency Test

96-Well Filter Plates 

 

Serial Number:

 

Test Results

Verification that wells are consistent in appearance: c Pass
c Fail

Residual Weight: g

Residual Weight: <= 1.2 g   c Pass
c Fail

 
 

Date:

Performed By:

If required,
Reviewed/Approved By:

 

EL406 Qualification Procedures
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Vacuum Filtration Evacuation Efficiency Test

384-Well Filter Plates 

 

Serial Number:

 

Test Results

Verification that wells are consistent in appearance:  c Pass
 c Fail

Residual Weight: grams

Residual Weight: <= 4.0 g 
                         

c Pass
c  Fail

 

Date:

Performed By:

If required, 
Reviewed/Approved By:

 

EL406 Qualification Procedures
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Peri-pump Dispense Precision and Accuracy Tests

Dispense Precision and Accuracy Specifications

Cassette Precision Accuracy

1 µL
 

10%CV  @ 1 µL per well ± 10% @ 1 µL per well 

5%CV  @ 2 µL per well* ± 5% @ 2 µL per well*                     

10%CV  @ 0.5 µL per well n/a

5 µL
 

5%CV  @ 5 µL per well                     ± 4% @ 5 µL per well                    

2.5%CV  @ 10 µL per well*                     ± 2% @ 10 µL per well*                     

10 µL                    
 

4%CV  @ 10 µL per well                    ± 4% @ 10 µL per well                     

2%CV  @ 20 µL per well*                     ± 2% @ 20 µL per well*                     

* These specifications   are for these dispense volumes and higher.                     

 n Note:   For IQ/PQ/OQ purposes you can   add 1.0% additional tolerance to the 
Precision %CV to accommodate various   test solutions, off-peak wavelengths, 
reader errors, and pipette errors.             

Peri-pump Precision and Accuracy   Testing Methodology 

Tare an empty plate on a balance. Use the Peri-pump   to dispense a quantity of 
fluid with a known dye concentration to the   wells. Weigh the plate to obtain the 
weight of the fluid dispensed.   Pipette deionized water on top of the dye to bring 
the wells up to a more   optically measurable volume. Read the wells in a 
microplate reader and   determine the percentage Coefficient of Variance (%CV) 
among all wells,   and the accuracy of the volume dispensed in each well (% 
Accuracy Error).

BioTek recommends performing two tests, one at the volume   that matches the 
cassette type and another that best represents the cassette   type and dispense 
volume most common to your applications:

Tests – Solutions
Cassette Types

1 µL 1 µL 1536 5 µL 10 µL

1 µL √ √   

5 µL   √  
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Tests – Solutions
Cassette Types

1 µL 1 µL 1536 5 µL 10 µL

10 µL √    √

50 µL   √  

100 µL    √

1536  √   

 l 1   µL Test: Confirms the performance of the 1 µL   cassettes when dispensing a single 
aliquot (1/4 turn of pump) into each   well of the plate. It dispenses 1 µL   into each well 
using the 1 µL   Solution, and requires an additional 150 µL of deionized or distilled water 
to raise the   fluid level for optimal reading.              

 n A single aliquot for a cassette type   is the smallest volume unit recommended 
for it. 1 µL for the 1 µL cassette,   5 µL for the 5 µL cassette, and 10 µL for the 
10 µL cassette (except that later model instruments can dispense 0.5 µL/well 
using a 1 µL cassette).             

 l 5   µL Test: Confirms   the performance of the 5 µL   cassettes when dispensing a single 
aliquot (1/4 turn of pump) into each   well of the plate. It dispenses 5 µL   into each well 
using the 5 µL   Solution, and requires an additional 150 µL of deionized or distilled water 
to raise the   fluid level for optimal reading.              

 l 10   µL Test: Confirms   the performance of the 1 µL   cassettes when dispensing 10 aliquots 
(2 1/2 turns of pump) and the 10   µL cassettes when dispensing   a single aliquot (1/4 turn 
of the pump) into each well of the plate. It   dispenses 10 µL into each well   using the 10 µL 
Solution,   and requires an additional 100 µL of deionized or distilled water to raise the 
fluid level   for optimal reading.              

 l 50   µL Test: Confirms the   performance of the 5 µL cassettes   when dispensing 10 aliquots 
(2 1/2 turns of pump) into each well of the   plate. It dispenses 50 µL into   each well using 
the 50 µL   solution, and requires an additional 100 µL of deionized or distilled water to 
raise the   fluid level for optimal reading.              

 l 100   µL Test:  Confirms   the performance of the 10 µL   cassettes when dispensing 10 
aliquots (2 1/2 turns of pump) into each   well of the plate. It dispenses 100 µL   into each 
well using the solution called 100 µL   solution, and requires an additional 50 µL of 
deionized or distilled water to raise the   fluid level for optimal reading. 

 l 1536 Test: Confirms the alignment of the tips; that the cassette is firing straight into 
the wells. Dispenses 6 µL into columns 2, 4, 19-30, 45, 47 of a 1536-well plate using the 
"1536 solution." Also requires performing the 1 µL Test described above.           

Peri-pump Dispenser Test Materials

 l 96-well plates: Corning® Costar   #3590 or equivalent 

 l 1536-well plates: Nunc #264710             
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 l Precision balance with readability   of 0.0001 g resolution is preferable, 0.001 g resolution 
is acceptable,   and capacity of 100 g minimum             

 l Pipettes and graduated beakers             

 l Microplate absorbance reader   capable of dual wavelength reading at 630 and 
 450 (or 405) nm              

 l BioTek   blue dye solution, PN 7773001, or equivalent to create the Peri-pump Dispense 
Precision and Accuracy Test Solutions below. 

 n See Important Recommendations for All Liquid Tests on page 220.             

Peri-pump Dispenser Precision and Accuracy Test Solutions

Unique concentrations of the test fluid are described here,   each one corresponds to 
a specific dispense volume. Prepare the solutions   you will need to validate the 
cassette types and dispense volumes used   most commonly in your applications.

 n The 5 µL Solution is used to make the   higher volume test solutions.             

1 µL Solution

Using BioTek’s 10X concentrated blue dye solution   (PN 7773001), mix 5 mL of 
deionized or distilled water with 8 mL of the blue dye solution.

5 µL Solution

Using BioTek’s 10X concentrated blue dye solution   (PN 7773001), mix 100 mL of 
deionized or distilled water with 10 mL of the blue dye solution.

10 µL Solution

Mix 25 mL of DI or dH2O water with 20 mL of the 5 µL Solution (described above).

50 µL Solution

Mix 45 mL of DI or dH2O water with 5 mL of the 5 µL Solution.

100 µL Solution

Mix 40 mL of DI or dH2O water with 2 mL of the 5 µL Solution.

1536 Solution

Mix 5 mL of 70% isopropyl alcohol with 3 mL of the 5 µL Solution and 35 mL of DI 
H2O.
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Perform the Peri-Pump Precision and Accuracy Tests

Prerequisite:
 l Gather the required   materials.             

 l Prepare the test solutions.             

 l Make a copy of the applicable   worksheets. You will find them on the operator's manual 
CD in the Qualification   chapter PDF.

Procedure:

 1. Install the cassette to   be tested.              

 2. Turn on the EL406 and make sure the cassette (CASS) type setting is correct.             

 3. Turn on the balance.             

 4. Fill a beaker or other vessel   with the test solution.             

 5. Define a Protocol   and save it for reuse. Set the parameters based on the desired 
test volume: 

 n A predefined protocol for the 1536 Test is shipped with the instrument and 
installed on your PC when you install the LHC: P-1536_DISP_TEST. 

 l  Add a  dispense step to the protocol: PERIP>DISP.                 

 l Set the Dispense Volume to match the   Test:                 

Test Volume

1   µL 1   µL

5   µL 5   µL

10   µL 10   µL

50   µL 50   µL

100   µL 100   µL

1536 6 µL

 l Set the Flow Rate to:                 
 l 1 µL cassette =   Medium                     
 l 5 µL cassette =    High                     
 l 10 µL cassette =   High                     

 l Optionally, choose to   Require   the specific cassette type under test.                 

 l LHC users: click the Advanced options link; retain   the default Positioning   
settings.                 
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 l Define a Pre-dispense: set the volume   to 10 µL and the Number   of Pre-dispenses 
(cycles) to 2.                 

 6. Place a clean/new microplate   on the balance and tare the balance.              

 7. Put the Tube Organizer into   the test fluid vessel and Prime   the tubing until any 
large air bubbles are removed.             

 8. Run the dispense protocol.             

 9. Place the plate on the balance   and record the Total   Dispense Weight in the 
worksheet.             

 10. Using a calibrated hand   pipette or the Peri-pump, add the specified amount of 
deionized water to each well to raise   the fluid level to approximately 150 µL.

Test Volume

1   µL 150   µL

5   µL 150   µL

10   µL 100   µL

50   µL 100   µL

100   µL 50   µL

1536 0 µL

 11. Read the plate in an absorbance   reader using the dual-wavelength method: read 
the plate at 630 nm and   450 nm.              

 12. Calculate the Delta OD: (630 nm - 450   nm), Mean Absorbance,   Standard 
Deviation,   and the %CV   for the wells under test. %CV   = (Standard Deviation ÷ 
Mean)   * 100.             

 13. Print the report, obtain   required signatures, and store it according to regulatory 
guidelines. 

If one or more of your tests are failing, make sure the   dispense tubes are not 
clogged, (follow instructions to                                   Unclog the Dispense Tips on page 190). If that doesn’t 
work, recalibrate   the cassette and repeat the test(s). If your tests continue to fail, 
contact   BioTek’s Technical Assistance Center (TAC).

Documenting Test Results

Dispense Precision & Accuracy Test Worksheets are provided   on the Operator's 
Manual CD in the Qualification chapter PDF. We recommend   you make copies of 
the appropriate pages and use them to record your calculations   and test results. 
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Alternatively, you can purchase the instrument qualification package, which   
contains additional tools for conducting test procedures and recording   the results, 
including logbooks and Excel®   spreadsheets. 
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Peri-pump Dispense Precision & Accuracy Test Worksheet
1 µL Test for 1 µL Cassette

 

1 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 11.0%      c Pass    c Fail      

 

1 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 10.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved By:
Date:
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Peri-pump Dispense Precision & Accuracy Test Worksheet
10 µL Test for 1 µL Cassette

 

10 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 6.0%      c Pass    c Fail      

 

 

10 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 5.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Peri-pump Dispense Precision & Accuracy Test Worksheet
1536 Test

 

1536 Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 384)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 6.0%      c Pass    c Fail      

 

1536 Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 5.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Peri-pump Dispense Precision & Accuracy Test Worksheet
5 µL Test

 

5 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 6.0%      c Pass    c Fail      

 

5 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 4.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Peri-pump Dispense Precision & Accuracy Test Worksheet
50 µL Test for 5 µL Cassette

 

50 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 3.50%      c Pass    c Fail      

 

50 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 2.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Peri-pump Dispense Precision & Accuracy Test Worksheet
10 µL Test for 10 µL Cassette

 

10 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 5.0%      c Pass    c Fail      

 

10 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 4.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved By:
Date:
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Peri-pump Dispense Precision & Accuracy Test Worksheet
100 µL Test

 

100 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 3.0%      c Pass    c Fail      

 

100 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 2.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Cassette Serial 
Number:

 

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Syringe Dispenser Liquid Tests

Dispense Precision and Accuracy Specifications

 n  Important: For IQ/PQ/OQ testing purposes 1.0% tolerance has been added 
to some of the published specifications for  Precision %CV to accommodate 
variations in test solutions,   off-peak wavelengths, reader errors, and pipette 
errors. % Accuracy Error is calculated for the dispense volume specified in the 
respective test procedure in adherence to the published specifications.

Test # Plate Type-Manifold Precision Accuracy

2 384-well plate < 3% CV @ 80 µL/well < 1.25% @ 80 µL/well

1 16-tube manifold < 6% CV @ 20 µL/well < 5% @ 20 µL/well

2 96-well plate < 3% CV @ 160 µL/well < 1.25% @ 160 µL/well

1 8- & 16-tube manifold < 6% CV @ 40 µL/well < 5% @ 40 µL/well

3 1536-well plate < 12% CV @ 6 µL/ well < 5% @ 6 µL/well

 32-tube manifold   

Syringe Dispenser Test Materials

 l Microplates: 384-well plates for testing the 16-tube dispensers (which can be replaced 
with 96-well plates if more applicable for your lab); 1536-well plates for testing the 32-
tube dispensers; and 96-well plates for testing the 8-tube dispensers. 

 l Precision balance with readability   of 0.0001 g resolution is preferable, 0.001 g resolution 
is acceptable,   and capacity of 100 g minimum             

 l Pipettes and graduated beakers             

 l Microplate absorbance reader   capable of dual wavelength reading at 630 and 405 (or 
450) nm              

 l The test   solutions: Syringe Dispenser Test Solutions on next page. 

 n See also Important Recommendations for All Liquid Tests on page 
220.
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Syringe Dispenser Test Solutions

20 µL Solution

 o Mix 10 mL of BioTek’s   blue dye solution with 100 mL of deionized or distilled water 
to create a dilution of the   concentrate. Mix 160 mL of deionized or distilled water 
with 20 mL of the diluted concentrate.             

80 µL Solution

 o Mix 120 mL of deionized or distilled water   with 40 mL of the 20 µL Solution.             

1536 µL Solution

 o Mix 21 mL of 70% Isopropyl Alcohol with 13 mL of the 20 µL Solution and 150 mL 
of DI H2O.    

Perform the Syringe Dispense Precision & Accuracy Test

Prerequisites:
 l Gather the required   materials: Syringe Dispenser Materials on previous page.             

 l Prepare the test solutions: Syringe Dispenser Test Solutions above.             

 l Make a copy of the applicable   worksheets. You will find them on the Operator's Manual 
CD in the Qualification   chapter PDF. 

 n Do not perform qualification tests while using the Buffer Switching module. 
Disconnect the valve box, replacing it with a direct fluid supply to the pump, if 
applicable.

Test Protocols

Two predefined QC protocols are provided for qualifying the 32-tube dispensers. 
Skip the protocol development steps in the procedure when testing these 
dispensers:

Onboard Name Description

SA-1536_DISP_TEST Dispense precision test protocol for 32-tube Syringe A 
manifold.

SB-1536_DISP_TEST Dispense precision test protocol for 32-tube Syringe B 
manifold.

These predefined protocols dispense 6µL/well into 512 wells of a 1536-well 
plate (columns 2, 4, 19-30, 45, 47). For speed, efficiency and to reduce the 

EL406™ Microplate Washer Dispenser



Perform the Syringe Dispense Precision & Accuracy Test |  263

amount of alcohol needed, the test is designed for visual inspection of the two 
columns at each end of the plate, while the block of columns at the center of the 
plate is used for evaluating dispense precision.  

Procedure: 

Perform two tests for each syringe: use two plates of the applicable type, 384-well 
for the 16-tube manifolds (unless only 96-well plates are used in your lab), 1536-
well for the 32-tube manifolds, and 96-well for the dual 8-tube manifold, and two 
dye solutions.   

 1. Prepare the syringe dispenser   to be tested:             
 l Test 1: Use the 20 µL solution

 l Test 2: Use the 80 µL solution

 l Test 3: Use the 1536 solution

 2. Prime the Syringe using your preferred method: run S-DAY_RINSE_A (or B) or 
use the Quick Dispense menu to remove any air bubbles from the system.

 3. Create and save protocols for the tests,   two for each Syringe, A and B,  as 
follows:              

Skip these protocol development steps for the 32-tube dispensers. And, 
because you will save the protocols, you only need to create them one 
time for the other manifolds.

 1. Define a Dispense step for   each test for each manifold, A and B: 

 Manifold Type Plate Type Volume (µL/well)

Test 1:                             16-Tube 384                             20                             

 8-Tube 96                             40                             

Test 2: 16-Tube 384 80

 8-Tube 96 160

 2. Set Flow Rate to 2   for all tests.

 3. Save the protocol.

 4. Place a clean, empty microplate on the balance and tare the balance.             

 5. Place the microplate on   the carrier and run the protocol (created in step 3 or 
predefined).            

 6. Place the plate on the balance   and record the Total   Dispense Weight.  This value 
will be used to calculate the % Accuracy Error. 
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 6. For Test 1 Only: Use a calibrated   hand pipette or the Peri-pump to dispense 
deionized water on top of the dye solution in   the wells.              

 l 384-well: Pipette 60 µL/well   (resulting in 80 µL/well)                 

 l 96-well: Pipette 120 µL/well   (resulting in 160 µL/well)                 

 7. Shake the plate using the EL406, an orbital   shaker or in a microplate reader for 
15 seconds, or lightly tap the side   of the plate with your finger to agitate the 
contents of the wells.              

 8. Read the plate in an absorbance   reader using the dual-wavelength method, to 
reduce the influence of scratches   and foreign particles that could be in the well.  
See   the recommended wavelengths.  Print or export the results.               

 9. Calculate and report the   Mean absorbance, Standard Deviation, and the %CV for 
the wells under test.   %CV = (Standard Deviation ÷ Mean) * 100.             

 10. The %   Accuracy Error calculation is: (Actual   Weight - Expected Weight) ÷ 
Expected Weight x 100

Subtract the expected dispense weight (see below) from   the Actual (Total) 
Dispense Weight (from step 5), and divide the result   by the expected weight. 
Multiply the result by 100.

The Expected   Dispense Weight is the volume dispensed per well in mL 
multiplied   by the number of wells dispensed. For example, if 40 μL is 
dispensed to   96 wells, the expected weight is 0.040 x 96 = 3.84 grams. We 
have calculated   some expected dispense weights for you:

Test # of wells Volume
μL/well

Expected 
Weight

Test 1: 384 wells 20 7.68 grams

 96 wells 40 3.84 grams

Test 2: 384 wells 80 30.72 grams

 96 wells 160 15.36 grams

Test 3: 512 wells (of a 1536-well 
plate)

6 3.012 grams

 11. Analyze your test results.   The following is the Pass criteria for each test:                 

 %CV % Accuracy Error

Test 1: < 6.0% ± 5.0%
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 %CV % Accuracy Error

Test 2: < 3.0% ± 1.25%

Test 3: < 12.0% ± 5.0%

 

If one or more of your tests are failing, clean the dispense   tubes with the stylus, re-
prime the manifold, and repeat the test(s).   If your tests continue to fail, contact 
BioTek’s Technical Assistance   Center.

Documenting Test Results 

Dispense Precision & Accuracy Test Worksheets are provided   on the Operator's 
Manual CD in the Qualification chapter PDF. We recommend   you make copies of 
the appropriate pages and use them to record your calculations   and test results.

Each Worksheet records calculations and pass/fail test results   for an individual 
test. 
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 1 / 96-Well Microplate/40 µL Dispense 

 

40 µL Dispense Precision Test

Standard Deviation (SD):                      

Mean Absorbance (sum of all wells ÷ 96)                      

% CV (SD ÷ Mean x 100)                     %

% CV must be < 6.0%      c Pass    c Fail      

 

40 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 5.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:

 

 

 

 

EL406 Qualification Procedures
© 2012, BioTek® Instruments, Inc.



Syringe Dispenser Precision & Accuracy Test Worksheet

Test 2 / 96-Well Microplate/160 µL Dispense         

 

160 µL Dispense Precision Test

Standard Deviation (SD):  

Mean Absorbance (sum of all wells ÷ 96)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 3.0%      c Pass    c Fail      

 

160 µL Dispense Accuracy Test

Total Dispense (Actual) Weight:                     grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 1.25% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved By:
Date:
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 1 / 384-Well Microplate / 20 µL Dispense

 

20 µL Dispense Precision Test

Standard Deviation (SD):                      

Mean Absorbance (sum of all wells ÷ 384)                      

% CV (SD ÷ Mean x 100)                     %                 

% CV must be < 6.0%                  c Pass    c Fail                     

 

20 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)                     

grams

% Accuracy Error: 
(Actual Weight – Expected Weight)÷ Expected Weight x 100                     

%

% Accuracy Error must be < 5.0% c Pass    c Fail                      

Visual verification that no well varies 
considerably from the others                     

c Pass    c Fail                       

 

Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved 
By:
Date:
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 2 / 384-Well Microplate / 80 µL Dispense         

 

80 µL Dispense Precision Test

Standard Deviation (SD):                      

Mean Absorbance (sum of all wells ÷ 384)                      

% CV (SD ÷ Mean x 100)                     %

% CV must be < 3.0%                     c Pass    c Fail      

 

80 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)                     

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
                     

%

% Accuracy Error must be < 1.25% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved By:
Date:
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 3 / 1536-Well Microplate / 6 µL Dispense

 

6 µL Dispense Precision Test

Standard Deviation (SD):       

Mean Absorbance (sum of all wells ÷ 384)       

% CV (SD ÷ Mean x 100)      %

% CV must be < 12.0%      c Pass    c Fail      

 

6 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)      

grams

% Accuracy Error: 
(Actual Weight – Expected Weight) ÷  Expected Weight x 100
      

%

% Accuracy Error must be < 5.0% c Pass    c Fail      

Visual verification that no well varies 
considerably from the others      

c Pass    c Fail      

 

Serial Number:  

Tests Performed By:
Date:

 

 

Reviewed/Approved By:
Date:
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Chapter 6

Troubleshooting        

This chapter provides guidelines for error recovery and 
troubleshooting performance problems. 

Troubleshooting 272
General Operation Troubleshooting 274
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Troubleshooting

Error recovery:

First Response:   Run a System   Test (restart the instrument) to give the instrument 
an opportunity to restore its   initial settings and communication capability. 

LHC Users: Reboot your Computer and   Instrument: When you cannot run a 
system test, e.g. LHC is not   responding, or when running a system test doesn't 
resolve the issue, turn   off your computer and EL406, check all the cabling, i.e. make 
sure your   serial or USB cable is in good condition and is properly connected to   the 
PC and instrument, and then, power them on. This should refresh the   devices and 
reset communication parameters.

Error Codes

To find a specific error code:
 l Software Error Codes on page 297 (6000-6100) - protocol errors             

 l System Error Codes on page 288 (0000-A500) - hardware errors             

Most error conditions generate an error message that is   displayed on the computer 
screen or keypad.

The most common error for new EL406 users is easily fixed:

306 Peri-pump Pump Cover is open. Close the pump   cover and re-run protocol.

To run the   Peri-pump, its pump cover must be closed, protecting both the pump 
and   the operator.

401 Carrier Y motor failed   positional verify

If the plate carrier is not installed   correctly, this instrument error will be displayed. 
Make sure the back   right corner of the carrier is correctly seated in the little black 
knob   attached to the transport rail. A slit on the bottom of the carrier allows   it to fit 
into place.  

6045 Serial write error

LHC Users: A potentially   common error, especially when using the Predefined 
Protocols, a "serial   write" error, is easily fixed by correcting the COM   port setting 
defined in the protocol. 

810D To communicate, instrument must be at main   menu/Home screen.
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LHC Users: Similarly,   the 810D message appears when the instrument is busy, for 
example when   AutoPrime is running. The LHC can only talk to the instrument 
when its main menu is displayed. Press the Stop   button, if desired, to end the 
current process and reestablish communication with the LHC. 

Technical Note: Only one of the two communication ports (COM port) on the  
instrument can be used at a time. They cannot be used simultaneously. You 

can use USB  to connect the EL406 to the computer or the RS232 serial port to 
connect to a BioStack or similar robotic device. But you cannot use both ports 
simultaneously, i.e. make sure only one cable is plugged in at a time.

Keypad Control: When the BioStack is connected to your  EL406, you are 
controlling both instruments using the keypad. Before connecting the EL406 to 
your computer to download basecode or for other reasons, you must first 
disconnect the BioStack from the EL406 and change the Instrument Setting for the 
BioStack:  Press Setup Menu> g> BIOSTK> CONF>MANUAL.
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General Operation Troubleshooting

This is a list of potential performance problems and their solutions.

Startup

Problem Possible Cause What To Do

Display (LCD) 
not on.

Power cord not 
plugged in.

Check power connection.

Carrier/manifold 
position error.

Manifold or 
carrier is being 
obstructed.

Remove obstruction.

Motor, sensor, or 
electrical 
problem.

Turn instrument off, wait at least 15 seconds, and 
turn it back on. If the self-test does not pass, contact 
BioTek TAC.

Misaligned 
carrier or 
manifold.

Contact BioTek TAC.

Incorrect 
manifold setting. 
 

Make sure the manifold setting matches the installed 
manifold.
LHC: Tools>Instrument Utilities>Washer/Syringe
Keypad: Setup Menu>WASH/SYRG>MAN

 

Microplate Scratches

Problem Possible Cause What To Do

Scratches 
on 
microplate 
bottom.

Microplate dispense or 
aspiration height 
adjustment too low.

Change the Dispense or Aspirate height, the Z-axis 
position.

Microplate not properly 
seated or strips not 
level.

Reseat microplate in carrier or strips in holder.
Make sure the carrier is clean.
Try a different microplate or strip holder. If the 
problem is unresolved, the carrier may have to be 
realigned. Contact BioTek TAC.
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Washer Problems

Vacuum Pump

Problem Possible Cause What To Do

Vacuum pump 
does not start, 
or shakes when 
turned on.

Vacuum pump is not 
turned on.

Flip the switch on the side of the vacuum pump to 
turn it on. 

Vacuum pump 
accessory cable not 
installed correctly.

Plug the vacuum pump accessory cable into the 
back of the instrument, Accessory Outlet. 

Too much residual 
vacuum force for 
pump.

Release the vacuum by loosening the waste bottle 
stopper. Reconnect and start again.

Blown fuse in 
accessory outlet.

Plug the vacuum pump accessory cable into the 
back of the instrument, Accessory Outlet, not into a 
wall outlet. 

Increase vacuum dissipation delay.
LHC: Tools>Instrument Utilities>Vacuum 
Dissipation Delay.
Keypad: Setup Menu>ààVACDIS 

Replace fuse (PN 46055), Replace the Vacuum 
Pump Fuse on page 208

Repeated 
blown fuses.

Vacuum Dissipate 
Delay is set too low 
for the volume of 
the waste bottle.

See above. If not enough time is allowed for the 
vacuum to dissipate, the pump will try to start 
while it is under a vacuum. The pump draws 
excessive current and blows the fuse.

Pump has been 
flooded.

Remove the head from the pump and inspect it for 
corrosion, crystalline buildup or liquid. Contact 
BioTek TAC for information on pump rebuilding kits.

Fluid Aspiration

Problem Possible Cause What To Do

Poor or 
uneven 
aspiration.

Insufficient or no 
vacuum.

Firmly seat the waste bottle covers.  Ensure tubing is 
connected properly. Check all external tubing and in-
line filter for kinks or clogs. If you are using an in-line 
vacuum filter, it may need to be replaced.

With the vacuum pump on, remove the vacuum pump 
tubing from the back of the instrument. Put your finger 
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Problem Possible Cause What To Do

over the port; if there is no vacuum, contact BioTek 
TAC.

Clogged aspiration 
tubes on the 
washer manifold.

Remove and clean the washer manifold on page 185

Make sure the microplate carrier is level and the waste 
valve is not touching the bench. 

Aspirate height 
adjustment too 
high or too low.

Change the aspiration height (Z-axis position) in the 
protocol.

Vacuum pump 
failure.

Contact BioTek TAC.

Uneven 
aspiration of 
water buffer. 
Some wells 
left full.

No surfactant in 
the buffer, such as 
Tween® 20.

Add surfactant to the buffer. If this is not possible, 
continue below.

Insufficient 
vacuum.

BioTek offers a high-flow pump for assays using only 
water for the wash fluid. Contact BioTek for more 
information.

Protocol settings 
not optimized.

Optimize protocols to improve evacuation on page 66

Aspiration tubes 
not properly 
positioned 
horizontally in 
wells.

If none of the tubes are bent, try adjusting the 
horizontal aspirate position (X-/Y-axis) in the protocol.

Microplate not 
level in carrier, or 
strips not level in 
holder.

Reseat microplate in carrier or strips in holder.
Make sure the carrier is clean.
Try a different microplate or strip holder. 
If the problem is unresolved, the carrier may have to 
be realigned. Contact BioTek TAC.

Too much 
residual left 
in wells after 
aspiration.

Clogged vacuum 
filter.

If you are using an in-line vacuum filter (PN 49943), 
the filter may need to be cleaned or replaced.

Waste bottle cover 
not properly 
sealed or fittings 
not properly 
connected.

Firmly seat the waste bottle stopper.  Make sure tubing 
is connected properly.

Manifold out of Check for obstructions. If none are found, contact 
BioTek TAC.
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Problem Possible Cause What To Do

alignment or not 
moving freely. 

Protocol requires 
optimization.

Optimize protocols to improve evacuation on page 66. 

Aspirate tubes are 
bent.

Contact BioTek TAC.

Fluid Delivery

Problem Possible Cause What To Do

Unable to 
dispense fluid — 
models without 
the Buffer 
Switching module.

Clogged fluid inlet filter. Clean the fluid inlet filter.

 Inlet tube not 
connected.

Make sure all tubing is connected properly. 
Check all external tubing for kinks or clogs.

  Clogged valve Create a protocol with several small primes, 
e.g. 10 mL, to try to unclog valve.

  Clogged dispense tubes 
on the washer manifold.

Remove and clean the washer manifold on 
page 185

 No wash or rinse fluid. Fill bottles with appropriate fluid. Ensure 
bottles are clean and do not contain particles 
or organic material.

Unable to 
dispense fluid — 
models without 
the Buffer 
Switching module.

System not primed. 
Large air pockets in 
tubing.

Run W-DAY_RINSE multiple times. 

 Insufficient suction, 
clogged tubing, or faulty 
valve.

Perform Washer Maintenance on page 181;  
If the problem persists, contact BioTek TAC.

Unable to 
dispense fluid — 
models with the 
Buffer Switching 
module.

System not primed.  
Large air pockets in 
tubing.

Run W-DAY_RINSE multiple times. 

External valve module 
not connected to 
washer, or supply 

Check valve module cable and tubing.
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Problem Possible Cause What To Do

tubing set up 
incorrectly.

Solenoid valve not 
opening.

Ensure module cable is plugged into the 
Valve Control port on the instrument’s back 
panel. If plugged in, contact BioTek TAC.

Plate overfills 
(floods).

Dispense height too 
high. The aspirate tubes 
are too far above the 
wells to prevent 
overflow.

Lower the dispense height (Z-axis position) 
in the protocol.

Dispense flow rate too 
low. 

Define a higher dispense Flow Rate in the 
protocol.

Cell wash flow rate 1 or 
2 is used with 384-well 
plates.

Specify a non-CW dispense Flow Rate when 
using 384-well plates.

Aspiration tubes hit 
bottom of trough during 
Prime or Maintenance.

Manifold may not be properly seated or 
mounted. Contact BioTek TAC.

In-line vacuum filter 
plugged.

Replace or remove the in-line vacuum filter.

Loose covers on waste 
bottles.

Firmly tighten waste bottle covers.

Dispense rate too fast 
for volume selected.

Specify slower dispense Flow Rate or lower 
volume.

Faulty vacuum pump. Contact BioTek TAC.

Insufficient or no 
vacuum.

Firmly seat the waste bottle covers.
Check all external tubing for kinks or clogs.
When the program begins, you should be 
able to hear the vacuum pump turn on. If it 
is not turning on, contact BioTek TAC.
If the vacuum pump turns on, remove the 
vacuum tubing from the back of the 
instrument and put your finger over the port. 
If there is no vacuum, contact BioTek TAC.

Uneven 
dispensing of 
fluid; wells not 

Clogged dispense tubes 
on the washer manifold.

Remove and clean the washer manifold on 
page 185
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Problem Possible Cause What To Do

filled.
Manifold or tubing not 
adequately primed.

Run W-DAY_RINSE once or twice. 

Dispense flow rate too 
low. Flow rate 1 or 2 
CW is used with 384-
well plates.

Define a higher dispense Flow Rate. 

Microplate aspiration 
height adjustment too 
high or too low.

Change the aspirate height (Z-axis position) 
in the protocol.

Fluid Leakage

Problem Possible Cause What To Do

Fluid leaking from 
manifold.

Defective seals. Replace Washer Manifold O-rings and Seals 
on page 208 

Aspiration tubes 
only: vacuum too 
low.

Check waste connector tubes; make sure they 
are properly connected.
If you are using an in-line vacuum filter, 
check the filter for clogging, and replace if 
necessary.
Check seal of waste bottle covers.
Check for air leaks in the waste tubing and 
bottles.
Use a slower Aspiration Travel Rate.

Uneven (not level) 
surface.

Make sure the surface the washer sits on is 
perfectly level. 

Fluid leaking from 
underneath the 
instrument.

Defective tubing 
connector or inlet 
tubing.

Contact BioTek TAC.

Leaking valve. Contact BioTek TAC.

Fluid leaking from 
external tubing 
connector.

Defective 
connector.

Replace connector.

Worn tubing. Replace tubing or cut back tubing one inch (to 
remove worn section).

Worn seal (inlet or 
vacuum fitting).

Replace filter or seal.
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Microplate Carrier Movement

Problem Possible Cause What To Do

Aspiration tubes 
not entering 
wells correctly.

Microplate not 
properly seated or 
strips not level.

Reseat microplate in carrier or strips in holder.
Make sure the carrier is clean.
Try a different microplate or strip holder. If the 
problem is unresolved, the carrier may have to be 
realigned. Contact BioTek TAC.

Aspirate tubes 
position is too wide 
for a movement.

Change the horizontal, X- or Y-axis aspirate 
position in the protocol.

Aspirate tubes 
bent.

Contact BioTek TAC.

Loud, annoying 
noise during 
operation.

Plate carrier is 
rubbing against 
glide strip.

Thoroughly clean the microplate carrier and 
exterior surface as recommended in the 
maintenance procedure.

Washer Manifold Movement

Problem Possible 
Cause What To Do

Manifold 
position 
error.

Manifold 
movement is 
blocked.

Check orientation of microplate; A1 should be in the left rear 
corner of the plate carrier as you face the instrument.
Check for and remove any obstructions.
Ensure the manifold is installed properly. 

Incorrect 
manifold 
selected.
 

Make sure the washer manifold setting matches the installed 
manifold (96-, 192- or 128-tube).
LHC: Tools>Instrument Utilities>Washer>Manifold 
Selection.
Keypad: Setup Menu>WASH>MAN

Syringe Dispenser Troubleshooting

Startup

Problem Possible Cause What To Do

Syringe or 
manifold 
position 
error.  

Syringe or manifold is 
being obstructed.

Remove obstruction.

Motor, sensor, or Turn instrument off, wait at least 15 seconds, turn 
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Problem Possible Cause What To Do

electrical problem. it back on and run a Quick Dispense routine, e.g. 
Prime. If the problem persists, contact BioTek 
TAC.

Syringe piston not seated 
all the way to the bottom 
before fastening set 
screw.

Reinstall the syringe head.

Syringe Movement

Problem Possible Cause What To Do

Syringe 
position 
error.

Syringe movement is blocked. Ensure the 26-pin high-density cable 
shipped with the Syringe is connected to the 
EL406’s rear panel.

Contact BioTek TAC.

Syringe piston not seated all the 
way to the bottom before 
fastening set screw.

Reinstall the syringe piston and syringe 
head.

Fluid Delivery

Problem Possible Cause What To Do

Unable to dispense 
fluid.

Inlet tube not connected 
at manifold or at bottle.

Check all tubing.

  Supply tube inside the 
supply bottle is kinked or 
disconnected.

Straighten or connect supply tube. 
Optimize Performance on page 65

  Clogged dispense tubes on 
the manifold.

Remove and clean the manifold.

  Inlet tube is not connected 
to the bottom port of the 
syringe.

Connect the inlet tube to the lower 
port of the syringe pump.

  Outlet tube is not 
connected to the top port 
of the syringe.

Connect the outlet tube to the top 
port of the syringe pump.

  Check valve flow direction 
is incorrect.

Compare the flow direction of the 
check valves, See Syringe 
Dispenser Check Valves on page 

BioTek Instruments, Inc.



282 | Chapter 6: Troubleshooting

Problem Possible Cause What To Do

46.

  Check valves are stuck 
closed.

Clean or Replace the Check Valves 
on page 196

  No fluid. Fill bottles with appropriate fluid.

  System not primed. Run S-DAY_RINSE for once or twice 
for one or both syringes.

  Faulty syringe pump. Contact BioTek TAC.

  Set screw not tightened 
on the syringe pump 
piston.

Reinstall the syringe head.

Plate overfills 
(floods).

Dispense height too high. Change the Dispense Z-axis position 
(height).

  Volume too large for the 
vessel. 

Define a smaller volume.

  Dispense rate too fast for 
volume selected.

Define a slower dispense rate or 
lower volume.

Uneven dispensing of 
fluid; 
wells not filled.
 

Clogged dispense tubes on 
the dispenser manifold.

Clean the Syringe Dispenser 
Manifold on page 193

  Manifold or tubing not 
adequately primed (air in 
fluid lines).

Run a Prime using 20 mL. Follow 
with a Dispense: 20 µL per well for 
24 strips. 

  Dispense flow rate too 
low.

Define a higher flow rate.

  Setscrew not tightened on 
the syringe pump piston.

Reinstall the syringe head as 
described in Autoclave the Syringe 
Head on page 196

  32-tube dispense 
manifolds are not 
dispensing accurately.

Calibrate the Backlash for Syringe 
Dispenser on page 212 

Dripping dispense 
tubes.

Dispense tubing routed 
incorrectly.

The supply bottle tube must connect 
to the Syringe’s bottom port.

Fluid jet is off-center 
or skewed from 32-

Minute particles of debris 
on the end of the tubes.

Brush away any particles from the 
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Problem Possible Cause What To Do

tube SB manifold. end of the tube using a piece of 
silicon tubing. Silicon will not flake 
off and leave particles behind like 
other materials.

Fluid Leakage

Problem Possible Cause What To Do

Fluid leaking from manifold.                                           Defective seals.                     Maintaining the Syringe Dispenser 

Check valves are 
leaking.                     

Clean or Replace the Check 
Valves on page 196

Fittings to manifold are 
leaking.                     

Reconnect/reseat the fittings.                     

Fluid leaking from underneath 
the unit.                     

Defective syringe cup.                     Contact BioTek TAC.                     

Leaking syringe seal.                     

Defective syringe 
piston.                     

Fluid leaking from external 
tubing connector.                     

Worn tubing.                     Replace tubing.                     

Defective connector.                     Contact BioTek TAC.                     

Microplate Carrier Movement

Problem Possible Cause What To Do

Dispense tubes not 
entering well correctly.

Microplate not properly seated or 
strips not level.

Reseat microplate 
carrier, or the plate or 
strips in holder. 

Make sure the carrier 
is clean.

Horizontal dispense position does not 
align the tubes in the wells.

Change the X-axis 
(horizontal) Position 
in the protocol.

Dispense tube(s) bent. Push the supplied 
stylus into the tube 
and then gently 
attempt to straighten 
the tube using your 
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Problem Possible Cause What To Do

fingers. If it remains 
bent, contact BioTek 
TAC.

Manifold tilted. Check tubing for 
twists.

Carrier position error. Carrier movement is blocked. Check for/remove any 
obstruction.

Dirty carrier or carrier rail. Clean carrier and/or 
carrier rail.

Dispense Manifold Movement

Problem Possible Cause What To Do

Manifold position 
error.

Manifold movement is 
blocked.

Check the dispense height or Z-axis 
positioning. Allow at least 1 mm clearance 
above plate.

Check for/remove any obstructions.

Contact BioTek TAC.

Peri-pump Troubleshooting

Problem What To Do

Fluid stream 
missing wells

Check Tip Holder, make sure it is properly seated in the Dispense 
Arm.
Select the correct Plate Type. 

Fluid splashing out 
of the wells

Select the correct Plate Type.
Reduce the Flow Rate.
Lower the Dispense Height.

Uneven dispensing Make sure all cassette components are properly seated in their 
respective positions.  
Tips are clogged. (See the Preventive Maintenance chapter.)
Recalibrate the cassette.
Replace the tubing. 
(On the Operator’s Manual CD, in the PDF folder, find instructions for 
recalibrating the cassette and replacing the tubing.)

Dispenser skipping Check/define the Plate Map.
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Problem What To Do

columns

Tips clogging Filter the dispense fluid to 50 microns before dispensing.
Replace the tubing.

Viscous fluids 
sticking to tips

Vary the Flow Rate: experiment with different flow rates to determine 
which setting best forces fluid to break from the tip.

Cannot 
communicate with 
computer

Check the cabling. (See previous section.)
Select the correct COM Port.
Turn on dispenser; display Main Menu.

Foaming in the 
wells

Reduce the dispense step’s Flow Rate.

Communication Errors

Here are some guidelines for troubleshooting communication   errors between the 
EL406 and the computer.

6045: A potentially   common error, 
especially when using the Predefined 
Protocols, a "serial   write" error, is easily 
fixed by correcting the COM   port setting.

810D:   Similarly, the 810D message appears when the instrument is busy, for 
example   when AutoPrime is running. The   LHC can only talk to the instrument 
when its main menu is displayed. Press   the Stop button on the keypad,   if desired, 
to end the current process and return to the main menu. 

Safety first

 n To   prevent damage to the instrument, always turn OFF the EL406 or the 
computer   before removing or inserting a communications (serial or USB) 
cable.             

When the computer (PC) won't communicate with the instrument:

 1. Run the system   self-test. All BioTek instruments perform a self-test when 
turned   on. The EL406 will not communicate if it fails an internal system test.   An 
error message will be displayed when a test fails.             
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 2. Make sure the serial or USB cable is in perfect   condition and properly 
attached to the port defined in the Instrument   Settings dialog (e.g. COM 1). 
Review the LHC   Help Topic Select Help&gt;Help Topics and search for "About 
COM Ports." "About COM Ports" to learn about virtual COM   ports when using 
a USB cable. Correct and reboot both PC and instrument.   Test communication.             

 3. Confirm that the serial/USB cable was obtained   from BioTek. Serial/USB 
cables are not universal. Contact BioTek   customer service to purchase a factory 
tested cable. After installing   a known, good cable, reboot both PC and 
instrument.              

EL406™ Microplate Washer Dispenser



Appendix A   

Error Codes    

A listing of potential error codes and possible solutions for 
resolving them. 

System Error Codes 288
EL406 Software Error Codes 297
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System Error Codes

Most of these error conditions require technical expertise   to correct. Error code 306 
and few other exceptions to this rule are listed   with remedies in the 
Troubleshooting section. A few other errors may be   caused by an obvious 
obstruction to a device's movement or insufficient   fluid in a supply vessel. Fix 
these kinds of errors and restart your instrument   to give it an opportunity to clear 
the error code.

Contact BioTek Technical   Assistance Center (TAC) for assistance.  

Code                    Message                       What   to do                     

100 Task was aborted Restart instrument if this   message is 
unexpected.

210, 220 Carrier X motor didn’t   find 
home opto sensor transition
Carrier X motor didn’t   find 
autocal jig opto sensor 
transition

Clean the plate carrier,   rails, and glide 
strips, using mild detergent and hot water, 
70% isopropyl   alcohol or ethanol. Restart 
the instrument. If the error occurs again,   
contact BioTek TAC.

211, 221 Carrier Y motor didn’t   find home 
opto sensor transition
Carrier Y motor didn’t   find 
autocal jig opto sensor 
transition

Run self test. If error reoccurs, contact 
BioTek   TAC.

212, 222 Dispense head motor didn’t   find 
home opto sensor transition,
Dispense head motor didn’t   find 
autocal jig opto sensor 
transition

Run self test. If error reoccurs, contact 
BioTek   TAC.

213, 223 Wash head motor didn’t   find 
home opto sensor transition,
Wash head motor didn’t   find 
autocal jig opto sensor 
transition

Run self test. If error reoccurs, contact 
BioTek   TAC.

214 Syringe A motor didn’t   find 
home opto sensor transition

Run self test. If error reoccurs, contact 
BioTek   TAC.

215 Syringe B motor didn’t   find 
home opto sensor transition

Run self test. If error reoccurs, contact 
BioTek   TAC.
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Code                    Message                       What   to do                     

216 Peri-pump motor didn’t   find 
home opto sensor transition

Run self test. If error reoccurs, contact 
BioTek   TAC.

220 Carrier X motor didn’t find 
autocal jig optical   sensor 
transition.

Service Only.
Contact BioTek TAC. 

221 Carrier Y motor didn’t find 
autocal jig optical   sensor 
transition.

Service Only.
Contact BioTek TAC. 

223 Wash head motor didn’t find 
autocal jig optical   sensor 
transition.

Service Only.
Contact BioTek TAC. 

300 Carrier X motor interlock   safety 
switch open

Service Only.
Contact BioTek TAC. 

301 Carrier Y motor interlock   safety 
switch open

Service Only.
Contact BioTek TAC. 

302 Dispense head motor interlock   
safety switch open

Service Only.
Contact BioTek TAC. 

303 Wash head motor interlock   
safety switch open

Service Only.
Contact BioTek TAC. 

304 Syringe A motor interlock   
safety switch open

Service Only.
Contact BioTek TAC. 

305 Syringe B motor interlock   
safety switch open

Service Only.
Contact BioTek TAC. 

306 Peri-pump Pump Cover is   open Close the pump cover door   and rerun the 
protocol.

400 Carrier X motor failed positional
   verify

Run self test. If error reoccurs, contact 
BioTek   TAC. 

401 Carrier Y motor failed positional
   verify

Run self test. If error reoccurs, contact 
BioTek   TAC. 

402 Dispense head motor failed   
positional verify

Run self test. If error reoccurs, contact 
BioTek   TAC. 

403 Wash head motor failed 
positional   verify

Service Only.
Contact BioTek TAC. 

404 Syringe A motor failed 
positional   verify

Service Only.
Contact BioTek TAC. 
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Code                    Message                       What   to do                     

405 Syringe B motor failed 
positional   verify

Service Only.
Contact BioTek TAC. 

406 Peri-pump motor failed 
positional   verify

Service Only.
Contact BioTek TAC. 

600-606 Specified motor currently   in use Service Only.
Contact BioTek TAC. 

700   -
70F

Invalid motor number specified Service Only.
Contact BioTek TAC. 

900 Calibrationon failed.   The 
measured or calculated autocal 
value is out of tolerance 

Service Only.
Contact BioTek TAC. 

A00 Invalid plate type selected The currently selected plate type is not 
supported with the currently installed or 
requested hardware. If this is not the case, 
contact BioTek TAC. 

C01   Configuration or autocal   data 
missing

Service Only.
Contact BioTek TAC. 

C02   Checksum mismatch -calculated 
checksum didn’t   match saved 
checksum

Service Only.
Contact BioTek TAC. 

C03 Configuration   parameter out of 
range

Service Only.
Contact BioTek TAC. 

1001 Bootcode powerup checksum   
test failed

Contact BioTek TAC. 

1002 Unknown error in bootcode Contact BioTek TAC. 

1003 Bootcode page program error Contact BioTek TAC. 

1004 Bootcode block size error   (not 
256)

Contact BioTek TAC. 

1005 Invalid processor signature   (not 
1280,1281,2560,2561)

Contact BioTek TAC. 

1006 Bootcode memory exceeded Contact BioTek TAC. 

1007 Invalid slave port Contact BioTek TAC. 

1008 Invalid response from slave Contact BioTek TAC. 

EL406™ Microplate Washer Dispenser



System Error Codes |  291

Code                    Message                       What   to do                     

1009 Invalid processor detected Contact BioTek TAC. 

1010 Checksum error downloading   
basecode

Contact BioTek TAC. 

1250 Internal RAM test error   on the 
UI processor

Contact BioTek TAC. 

1251 Internal RAM test error   on the 
MC processor

Contact BioTek TAC. 

1260 Stack test error on the   UI Contact BioTek TAC. 

1261 Stack test error on the   MC Contact BioTek TAC. 

1300 Invalid syringe selection Contact BioTek TAC. 

1301 Syringe module not connected Make sure the Syringe module   is correctly 
connected using the new BioTek-provided 
serial cable. 1302 Syringe initialization error

1303 Syringe sensor not cleared   
error

1304 Invalid syringe dispense   volume See error 1308 below.

1305 Invalid syringe operation Contact BioTek TAC. 

1306 FMEA error on syringe A Contact BioTek TAC. 

1307 FMEA error on syringe B Contact BioTek TAC. 

1308 Invalid Syringe pre-dispense   
volume

Protocol may have been written for a 
different type   of dispense manifold. Make 
sure the Instrument Settings represent the  
installed hardware. Modify the protocol to 
match. 

1309 Invalid Syringe prime volume

1310 Invalid Syringe manifold

1350 Peri-pump (PP) invalid dispense
   volume

Contact BioTek TAC.

1351 PP invalid cassette type Change the cassette type to match the 
protocol requirement   and rerun the protocol.

1352 PP invalid pre-dispense   volume Contact BioTek TAC.

1353 Multiple required cassettes Make sure every Peri-pump step in the 
protocol calls   for the same cassette type. A 
conflict was found. 

BioTek Instruments, Inc.



292 | Chapter A: Error Codes

Code                    Message                       What   to do                     

1354 PP pump cover (safety door)   
open

Close the pump cover door   and rerun the 
protocol.

1355 PP not installed If you are trying to run a Secondary Peri-
pump, check the cabling in the back of the 
instrument. Otherwise Contact BioTek TAC.

1356 PP Invalid dispense position Contact BioTek TAC. 

1357 PP two dispensers are expected Contact BioTek TAC. 

1400 No vacuum pressure detected   
after turning on the vacuum 
pump

Make sure the vacuum pump   is turned on, 
and not leaking; the waste bottle has not 
overflowed and   its caps are seated 
correctly.  If the pump is not running,   the 
fuse may be blown. But, before replacing the 
fuse, first try to determine   and remedy the 
cause of the failure. If the pump sounds 
strained or runs   slowly, it may be damaged. 
Review other related Troubleshooting 
suggestions. 

1401 The waste bottles should   be 
emptied before continuing

Empty the waste bottles   and rerun the 
protocol.

1402 The requested valve is invalid Contact BioTek TAC. 

1403 Invalid Z-axis offset value The Magnet Adapter offset (MAGHT) is too 
high, the "in use" value is missing, or a more 
serious software problem exists. Make sure 
the setting is valid, and if so, contact BioTek 
TAC.

1404 Plate type restricted This instrument model or the requested 
device does not support the selected plate 
type. Edit the protocol to change the plate 
type.

1405 Z-axis out of range The requested travel/dispense height cannot 
be reached. The conflict may be caused by a 
combination of variables, plate type, Plate 
Clear or other height settings. Review the 
protocol parameters and instrument settings 
to identify a correction.       
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Code                    Message                       What   to do                     

1407 Invalid step type The protocol may have been created for a 
different instrument, it is not compatible 
with this instrument.

1408 Invalid plate geometry Contact BioTek TAC. 

1409 Invalid plate carrier type Contact BioTek TAC. 

1410 Incompatible hardware Vacuum filtration requested but either the 
instrument is in BioStack mode, or this 
instrument is not configured to support it. 
Change the BioStack configuration, it is not 
compatible with the vacuum carrier, or 
contact BioTek TAC.

1411 Invalid plate carrier The vacuum filtration carrier must be 
installed to run this kind of protocol, and the 
plate carrier setting must represent the 
currently installed carrier. 

1412 Tip clearance error Contact BioTek TAC. 

1413 AutoPrime in progress Contact BioTek TAC. 

1414 AutoPrime aborted Contact BioTek TAC. 

1415 AutoPrime value out of range Contact BioTek TAC. 

1500 No buffer fluid detected   at the 
start of a wash protocol

Fluid detection errors.   Make sure the supply 
bottle is full and properly connected, the 
tubing   is not kinked, blocked, etc., and the 
correct port/valve is selected.    1501 No buffer fluid detected   before 

the washer dispense step

Note: Running very low density fluids, like alcohol, may generate some of   these fluid 
detection errors because the fluid prohibits the float detector   from operating 
properly. Disable the Fluid sensor (Washer   Settings) while using such low 
density fluids, but be vigilant about   monitoring fluid levels.

1502 The buffer valve selection   is 
invalid

Contact BioTek TAC. 

1503 Dispense volume error Contact BioTek TAC. 

1504 No buffer detected flowing   
through the manifold during an 
operation

Flow detection errors. Make   sure the supply 
bottle is full and properly connected, the 
tubing is not   kinked, blocked, etc., and the 
correct port/valve is selected. 

1505 No buffer detected at the   end of 
a wash protocol
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Code                    Message                       What   to do                     

1506 The requested carrier Y-axis   
position is out of range

Contact BioTek TAC. 

1507 Internal valve transition   error Contact BioTek TAC. 

1508 Pre-dispense volume error The specified Pre-dispense   volume is invalid 
for this plate type. Edit the protocol.

1509 Low flow 192-tube manifold   
error

The 192-tube manifold does   not support cell 
wash or low-flow protocols. A wash step 
mismatch has   occurred. Edit the protocol.

1510 Low flow 96-tube manifold   error Contact BioTek TAC. 

1511 External Buffer Switching   valve 
module is required

The current protocol is   defined to use 
different valves of the Buffer Switching 
module, which   is not installed. Edit the 
protocol. 

1512 Invalid plate type The specified plate type is not supported 
with the current hardware. 

1513 Plate type - manifold   conflict Change the Plate Type to one supported by 
the manifold.   Or, click the Instrument 
Settings link and   make sure they match the 
physical hardware: Get settings from 
instrument. 

1514 Ultrasound module not 
connected

The protocol may have been created for a 
different instrument, according to the 
instrument's basecode it is not compatible 
with this instrument. Contact BioTek TAC.1515 Cell Wash hardware not 

installed

1516 Vacuum filtration start or end 
error

Vacuum pressure is detected in the 
intermediate waste bottle before or after the 
run. Conatct BioTek TAC.

1517 Vacuum filtration sensor error Unable to read vac. filtration sensor. This is 
expected if you are running with very low 
pressure, in this case disable the sensor. 
Otherwise, check for leaks, e.g. bottle cap. 

1600-
160C

The onboard storage space   
allocated for this function has 
been used up.

Use the LHC ”Manage   Memory” control to 
reallocate space.

160D Not a valid step Contact BioTek TAC.
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Code                    Message                       What   to do                     

2400 Parameter limit exceeded Contact BioTek TAC. 

4000 Program locked so operation   
denied

Contact BioTek TAC. 

4010 Program cannot be erased so   
delete denied

Contact BioTek TAC. 

4020 Bad checksum when reading   
program from EEPROM

Contact BioTek TAC. 

4030 Program not found Contact BioTek TAC. 

4040 Can’t save program   because no 
space available

Contact BioTek TAC. 

4050 Program run canceled by   user Restart instrument if this   message is 
unexpected.

8100 Communications NAK Contact BioTek TAC. 

8101 Timeout while waiting for   serial 
message data

Contact BioTek TAC. 

8102 Instrument busy and unable   to 
process message

Contact BioTek TAC. 

8103 Receive buffer overflow   error Contact BioTek TAC. 

8104 Checksum error Contact BioTek TAC. 

8105 Invalid structure type in   
byMsgStructure header field

Contact BioTek TAC. 

8106 Invalid destination in 
byMsgDestination   header field

Contact BioTek TAC. 

8107 Request object received   not 
supported by instrument

Contact BioTek TAC. 

8108 Message Body size exceeds   
max limit

Contact BioTek TAC. 

8109 Max number of requests 
currently   running and cannot 
run the latest request

Contact BioTek TAC. 

810A No request running when   
response request issued

Contact BioTek TAC. 
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Code                    Message                       What   to do                     

810C Response for outstanding   
request not ready yet

Contact BioTek TAC. 

810D To communicate with the   LHC, 
the instrument must be at its 
main menu

The LHC can only talk to   the instrument 
when its main menu is displayed. When the 
instrument is   busy, for example when 
AutoPrime is running, press the Stop button 
on   the keypad, if desired, to end the current 
process and return to the main   menu.

810E One or more request 
parameters   are not valid

Contact BioTek TAC. 

810F The command was received   
while the software was not 
ready to accept that command

Contact BioTek TAC. 

A00 Invalid plate type requested Service Only.
Contact BioTek TAC. 

A100 -
A10F

Software device not available   Service Only.
Contact BioTek TAC. 

A200 Version strings for multiple   
microprocessors do not match

Service Only.
Contact BioTek TAC. 

A301 +5v logic power supply level   
error

Service Only.
Contact BioTek TAC. 

A302 +24v system/motor power   
supply level error

Service Only.
Contact BioTek TAC. 

A303 +42v   Peri-pump motor power 
supply level error

Service Only.
Contact BioTek TAC. 

A305 +42v Secondary  Peri-pump 
motor power supply level error

Service Only.
Contact BioTek TAC. 

A400 Malloc failed Service Only.
Contact BioTek TAC. 

A500 Multiple tasks attempted   to use 
display simultaneously

Service Only.
Contact BioTek TAC. 

A600 Serial EEPROM access error Service Only.
Contact BioTek TAC. 

A700 Motor truncation error Service Only.
Contact BioTek TAC. 
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EL406 Software Error Codes

Generally,   these errors are caused by protocol parameters that conflict with the   
instrument's onboard settings. The protocol may have been originally created   for a 
different hardware configuration, the 192-tube wash manifold instead   of the 96-
tube, for example. 

Quick Fix: Make sure your Instrument Settings   accurately reflect your 
instrument’s hardware configuration and   then, modify the protocol to fix any 
invalid parameters. With the EL406   connected to and communicating with your 
computer and its main menu displayed   on the keypad:

 1. Click   the Settings link in the main view.             

 2. In   the Instrument Settings dialog, click the instrument link to get the settings   
from the instrument.             

 3. Modify   the protocol step that generated the error message.             

Error 
Code                    Description                    Help                     

6000 General   communication error during 
download.

See   Communication Errors on page 285 

6001 COM   port created by USB converter 
no longer active

See Communication Port

6002 Invalid   basecode part number; 
instrument is not an EL406

Service   Only.
Contact   BioTek TAC.

6003 Invalid   Basecode Data Version; 
basecode needs to be updated

Contact   BioTek to obtain latest basecode. 

6004 No rows are selected for the specified 
plate type

Modify the protocol to select a row.

6005 Invalid row selection value (must be 
0 or 1)

Contact BioTek TAC.

6006 This instrument can only process 96-
well plates

The protocol may have been created for 
another instrument, change the plate type 
or select another protocol.
 6007 This instrument can only process 

1536-well plates

6008 The 8-tube Syringe Manifold can only 
be used with 96-well plates

Mismatch between installed hardware and 
protocol parameters: change the plate 
type or correct the instrument settings to 
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Error 
Code                    Description                    Help                     

match the currently installed hardware.
 6009 The 96-tube singe wash manifold can 

only be used with 96-well plates

6010 The   data is invalid or out-of-range. Service   Only.
Contact BioTek TAC.

6011 This   step type cannot be 
downloaded.

Review   the limitations to transferring 
protocols to the instrument, See the LHC   
Help Topic: Transferring Protocols.  

6012 Illegal   characters in protocol name See   the LHC Help topic: Define a 
Protocol.

6013 The   protocol name length must be 
16 characters or less. 

6014 A   1536 well plate is not supported 
by this instrument.

Service   Only.
Contact BioTek TAC. 

6015 The   specified volume exceeds the 
cassette maximum limit.

Modify   the volume or change the 
cassette type.

6016 The   volume is out-of-range. Modify   the volume or change the 
cassette type.

6017 Invalid   flow rate. Learn   about the Syringe Dispense Step  

6018 Invalid   number of 
pre-dispenses.

 
Service   Only.
Contact BioTek TAC.
These   codes indicate an unexpected 
software error that cannot be fixed 
without   BioTek support.
 
 
 
 

6019 Invalid   horizontal dispense position.

6020 Invalid   dispense height.

6021 Invalid   plate clear height.

6022 Invalid   column selection value 
(must be 0 or 1).

6023 Invalid   protocol step type.

6024 The   Definition String contains 
invalid data.

6025 Manifold   conflict between protocol 
requirements and instrument 
configuration.

Change   the Washer Manifold or change 
the Instrument Setting. See Appendix   B 
in the operator's manual.

6026 Valve   module conflict between 
protocol requirements and 

Make   sure the Buffer Switching setting 
matches your instrument; see 
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Error 
Code                    Description                    Help                     

instrument configuration. Instrument   Settings.  

6027 Syringe   module conflict between 
protocol requirements and 
instrument configuration.

Make   sure the Syringe dispenser setting 
matches your instrument: see 
Instrument   Settings.  

6028 Filter   washer conflict between 
protocol requirements and 
instrument configuration.

Service   Only.
Contact BioTek TAC.

6029 Required   cassette does not match 
installed cassette.

Change   the cassette type to match the 
protocol requirement and rerun the 
protocol.

6030 Invalid   cassette type was specified. Service   Only.
Contact BioTek TAC.

6031 Cannot   use a 96-well plate with a 
192-tube manifold.

Modify   the Plate Type or Change the 
Washer Manifold.

6032 Downloading   Protocols is not 
supported.

Service   Only.
Contact BioTek TAC.

6033 This step is not supported for 1536-
well plates.

Fix the plate type or the Instrument 
Settings. A   conflict between the plate type 
and installed hardware devices has been   
detected. 
Change the Plate Type to one supported by 
the washer/dispenser.   Or, click the 
Instrument Settings link and   make sure 
they match the physical hardware: Get 
settings from instrument.

6034 The 32-tube Syringe Manifold is 
required for 1536-well   plates.

6035 The 16-tube Syringe Manifold is 
required for 96-   and 384-well plates.

6036 The 128-tube Washer Manifold is 
required for 1536-well   plates.

6037 The 128-tube Washer Manifold can 
only be used for   1536-well plates.

6038 This step only applies to 1536-well 
plates.

6039 Conflicting column selection Fix the plate map (selected columns to 
dispense   to). A protocol parameter may 
have been changed after a partial plate   
dispense was defined.
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Error 
Code                    Description                    Help                     

6040 Invalid baud rate Service   Only.
Contact BioTek TAC.
These   codes indicate an unexpected 
software error that cannot be fixed 
without   BioTek support.

 

6041 Invalid data bits selection

6042 Invalid stop bits selection

6043 Invalid parity selection

6044 Serial port error Fix the COM port setting. Check the 
cabling. Click   the Port link and use the 
drop-down menu   to see all active ports. 
Customize the Predefined Protocols to 
avoid   this error in future.
When controlling the BioStack with the 
LHC, make sure the instrument's BioStack 
setting is Manual.

6045 Serial write error

6046 Serial read error

6047 Checksum error Contact BioTek TAC.

6048 Serial NAK error Make sure the COM port setting is correct 
and the   cable is properly connected. 
Restart the instrument. If error reoccurs,   
contact BioTek TAC.

6049 Excess data, or not enough data, 
received.

To correct these errors:

 l Reset the instrument. 

 l Check cables, plug in only one 
communication cable  at a time: 
USB or serial.

 l Try running a different protocol. 
If error reoccurs, contact BioTek TAC. 

6050 Invalid message header

6051 Invalid message object

6052 Invalid message body size

6053 Serial message timeout

6054 Port handle error

6055 Read timeout value is invalid.
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Error 
Code                    Description                    Help                     

6056 Unauthorized to open the COM port Make sure the COM port setting is correct 
and the   cable is properly connected. 
Restart the instrument. If error reoccurs,   
contact BioTek TAC.

6057 Out-of-range parameter for the open 
port function.

6058 Unable to open the COM port.

6059 Unable to clear the transmission 
buffer.

6060 Unable to close the port.

6061 Port is no longer available.

6062 Unhandled exception while 
transmitting message

Contact BioTek TAC

6063 The selected plate type is not allowed 
with this protocol step

Modify the protocol to change the plate 
type.

6064 The protocol specifies more Peri-
pumps than are available

The protocol may have been created for a 
different instrument. Make sure the 
instrument settings match the current 
instrument and modify the protocol. 

6065 Too few data bytes received from the 
instrument

Contact BioTek TAC.

6066 Ultrasonic cleaning assembly is not 
installed

The protocol may have been created for a 
different instrument. Make sure the 
instrument settings match the current 
instrument and modify the protocol.

6067 The type of Syringe pump is not 
compatible with the syringe manifold

Contact BioTek TAC.

6070 Invalid Syringe specified. Service   Only.
Contact BioTek TAC.
 
These   codes indicate an unexpected 
software error that cannot be fixed 
without   BioTek support.

 

6071 Invalid number of syringe prime 
cycles

6072 Invalid syringe Aspirate Delay value

6073 Invalid X-axis offset value

BioTek Instruments, Inc.



302 | Chapter A: Error Codes

Error 
Code                    Description                    Help                     

6074 Invalid Y-axis offset value Service   Only.
Contact BioTek TAC.
These   codes indicate an unexpected 
software error that cannot be fixed 
without   BioTek support.

 

6075 Invalid Z-axis offset value

6076 Vacuum filtration not allowed with 
1536-well plates.

Modify the protocol to change the plate 
type.

6080 Invalid Peri-pump prime duration Service       Only.
Contact BioTek TAC.
 
These        codes indicate an unexpected 
software error that cannot be fixed 
without       BioTek support.

6085 Invalid minutes:seconds value

6086 Invalid hours:minutes value

6087 'Move carrier home' is required when 
duration exceeds 1 minute.

Contact BioTek TAC

6088 Invalid Shake/Soak options selected Service       Only.
Contact BioTek TAC.
 
These        codes indicate an unexpected 
software error that cannot be fixed 
without       BioTek support.

6089 Invalid Shake Intensity selected

6090 Invalid Washer buffer selected

6091 Invalid Washer Aspirate Delay value

6092 Invalid Washer Aspirate Travel Rate 
value

6093 Invalid Wash Cycles value

6094 Invalid Wash format selected

6095 Invalid Wash Sectors selected

6096 
   

Wash Aspirate Delay value is 
required.

6097 Syringe Dispense Volume must be an 
integer.

6098 Peri-pump cannot run with the pump 
cover open.

Close the pump cover door   and rerun the 
protocol.

6099 Peri-pump assembly not installed. Physically install the Peri-pump and/or 
make sure the instrument settings reflect 
the current state.
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Error 
Code                    Description                    Help                     

6100 This functionality requires the 
software to be registered.

You must register the   software with 
BioTek. Select Help>Register 
Software.
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Appendix B     

Changing the Washer 
Manifold    

Instructions for changing the washer manifold: accessory 
manifolds, 192-tube for processing 384-well plates and 128-
tube aspirate manifold for processing 1536-well plates, 
replace the standard 96-tube manifold. 

Changing the Wash Manifold 306
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Changing the Wash Manifold

The EL406 supports multiple types of wash manifolds. All  manifolds fit onto the 
instrument and are removed from it in a similar manner. Accessory manifolds are 
shipped in special packaging. Use the shipping case to store whichever manifold is 
not being used. 

Prerequisite:

Before removing the installed manifold, run a Maintenance protocol (such as 
W-DAY_RINSE) or the “Long_Shutdown” procedure described in the Maintenance 
chapter to flush any remaining residue from the manifold tubes, if the washer has 
been in operation.  

 Tip: It is easier to clean the manifold before removing and storing it than afterwards 
when residuals in the tubing and fluid paths have been allowed to dry or crystallize during 
storage. 

First, clean and dry the manifold:

 n Alternatively, use the Ultrasonic Advantage™: Run AutoClean to clean the 
manifold.

 1. Run W-DAY_RINSE one or two times with deionized water in the supply bottle. 

 2. Run the system “dry”: Connect an empty supply bottle and run W-DAY_RINSE.
 3. Turn off the instrument and disconnect the power cable.

Standard dual manifold Quick release dual manifold

Dual 96-tube manifold Deep-well manifold (ELx405™)
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Replace the manifold:

 1. Remove the mist shield. 

 2. Standard dual manifold: Using the 9/64” (3.57 mm) Allen wrench supplied 
with the instrument, remove the screws, washers, and springs that hold the 
manifold in place, and set them aside.
Quick-release manifold: Release the thumbscrews that secure the manifolds in 
place.

 3. Carefully remove the manifold and end plates, if applicable, holding the upper 
and lower manifolds together as a single unit; the 128-tube manifold is a single 
unit and does not have end plates. 

 4. Place the manifold into the shipping case for safe storage. If you ran W-DAY_
RINSE or an AutoClean protocol as instructed, ensure that the manifold is 
thoroughly dry before storing it.

 5. Install the alternate manifold and end plates, if applicable, carefully holding the 
upper and lower manifolds together as a single unit, and making sure that the 
two O-rings do not fall out of their grooves during installation. Do not over-
tighten the manifold mounting screws.

 n Important! When reinstalling the manifold, only tighten the screw-washer-
spring assembly that holds it in place until you feel the mechanical stop. 
Tightening past this point will damage the instrument and will void your 
warranty.

Reinstall the mist shield:

 1. Align the mist shield with the washer so it rests on top of the two posts and the 
two thumbscrew holes in the shield are lined up with the two holes in the base 
of the washer.

 2. Insert the two thumbscrews and finger-tighten only. 

Reconfigure the instrument:

Update the washer manifold setting: 

 1. Using the LHC: select Tools> Instrument Utilities> Washer
Using the Keypad: press Setup Menu>WASH>MAN

 2. Choose the option that represents the installed manifold.

 3. LHC users: click Send to send this setting to the EL406.

 n Important!  The correct manifold must be chosen as the Manifold Selection 
before operating the washer. Failure to set the manifold type before operation 
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may damage the manifold and void your warranty.

Storing the Unused Manifolds

96- and 192-Tube and Deep-well (ELx405 only) Boxes
 l Separate the dual manifolds to store them. Put the bottom manifold in the left recess and 

the top manifold in the right recess.

128-Tube Box
 l Hold the dual manifolds together and gently lower them into the single recess of the 128-

tube manifold box. Then place the end plates, one at a time, into the same recess, on the 
left side of the manifolds. All components will fit snugly into place.
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128-tube wash pattern 107
1536-well plates 66,92,112,114,139,144
1536F 110
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ting
Changing the manifolds 306
Chemiluminescence 3
Cleaning 172,177,181,185,202

Removing proteins 175
Columns

Dispensing to 91
COM Port 51,68,95,99
CommonAppDataFolder 98
Communication Errors 285
CW+ Control 117-118,120

D

Dead Volume 6,14,49,141
Peri-pump 135

Decontaminate 199
Autoclave 180
Manifold and tubing 202
Vacuum filtration carrier 204

Deionized water x,166,177
Delay after Dispense 121,158
Delay Aspiration 121
Dispense

To specific columns 91
Dispense Accuracy 16
Dispense Cassette 6,39,41

diagram 38
Ordering new (PN) 11

Dispense Parameters 73
Dispense Pattern 105,108
Dispense Precision 16
Dispense Precision and Accuracy Test

For 96-tube 230
Dispense Precision Test

About 224
For 192-tube 234
For Peri-pump 251
For Syringe dispenser 262

Dispense to certain wells
Keypad control 91

Dispenser comparison 6
Dispensing 16

Distilled water x,166,177
DNA Probes 3
Download Basecode 158
Download protocols 159
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EL406.bin 158
ELISA 3
Empty priming trough 85,89
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Error codes 272,288,297
Evacuation Efficiency 15
Evacuation Efficiency Test

For 192-tube 235
For 96-tube 228
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Final Aspirate 66,115
Flow Detection 293
Fluid Detection 293
Fluid Supply

washer 30,48,148

G

General Settings 51

H

H2O x,166,177
Hardware 13
High Flow vacuum pump 149

Caution xv
Horizontal aspirate position 280
How it works 134
How To

Change cassette setting 41
Change the plate carrier set-

ting
124-125

Change the plate clearance setting 113
Change the Syringe settings 146
Change the washer buffer switch-
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160
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enter a negative value 94
Name a protocol 90
Shake the plate 94

Humidity limits 13

I

Incubate a plate at room temperature 94
Inline Filter

How to install 43
Instrument Settings 98-100

Defining 51
Instrument Utilities 41,148,153,158

Adjust Utility 149
AutoPrime 153

Interface Software 98
IQ-OQ-PQ 10

schedule 218
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Keypad 84,94
How to name a protocol 90

L

Labware 13
LCD 84
LHC 98

For EL406 96
Protocols explained 99

Liquid test solutions 10
Liquid testing

Evacuation Efficiency Test 235
Low Flow 114,117
Low vacuum 275
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Magnet Height Offset 112,130,148,160
Magnetic bead assays 126
Maintenance 167,177
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Syringe dispenser tubes 172,195
Wash manifolds 172,185

Manifold Selection
Syringe 144

Manifold Type 14,101
Syringe dispenser 146

Microplates
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Multiple instruments 99
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Partial plate 106-107
Parts listing 9-10
Performance Specifications 15
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Change the cassette 41
Fixing problems 284
Recommended prime volumes 135
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Peri-pump Dispense Step 137
Peri-pump Pump Cover 272
Physical Specifications 13
Plate Carrier setting 124-125,148
Plate Clearance setting 112-113,148
Plate geometry diagram 103
Plate Map 91,143
Plate Type 103
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supported 13

Plates
special handling 110

Port link 68,95,99
Power Supply 13
Power users 98
Pre-Dispense 138
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RIA 3
Robotics integrators 83

S

Self-test 148,221
Sensors 149
Sensors Enabled 149
serial port 50,83,273
Shake the plate 94
Shipping

Prepare for 207
Size and weight 13
Skip columns/rows 108
Soak 94,171-172

manifold tubes 172-173
Soak, steep the plate contents 94
Solutions

Syringe qualification 262
Sonicator 181
Special plate types 103,110
Specifications 13,15
Sterilize

autoclave 180
Storage 207
Suspend the beads during the wash 94
Syringe Dispense Step 142
Syringe Dispenser 100

Autoclavable vs. non-autoclavable147
Buffer switching 47
CAL data 146
Fixing problems 280
How to set up 44
Recommended prime volumes 141

Syringe Dispenser Settings 146
Syringe Manifold

Change 144
Syringe Settings 144
System Error Codes 288

EL406™ Microplate Washer Dispenser



Terg-A-Zyme|  313

T

Terg-A-Zyme 181
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